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Capítulo 1. Visão geral

Introdução
O GnuCash é o programa de gestão de finanças pessoais feito para si. É suficientemente versátil para seguir
toda a sua informação financeira, desde a mais simples à mais complexa. É um dos poucos programas de
gestão de finanças a suportar moedas globais e é o único programa de código aberto deste tipo. E, o melhor
de tudo, o GnuCash é fácil de aprender e de usar!

Então, o que é que o GnuCash pode fazer por si? Pode acompanhar as suas finanças pessoais com tanto
detalhe quanto preferir. Se está só a começar, use o GnuCash para controlar o seu livro de cheques. Poderá
então decidir controlar também o dinheiro, assim como compras com cartão de crédito, para melhor de-
terminar onde está a gastar o seu dinheiro. Quando começar a investir, pode usar o GnuCash para o ajudar
a controlar o seu portfólio. Vai comprar carro ou casa? O GnuCash ajuda-o a planear o investimento e a
seguir os pagamentos do empréstimo. Se os seus registos financeiros abragem todo o globo, o GnuCash
oferece todo o suporte a múltiplas moedas de que precisa.

Esta imagem mostra uma árvore de contas com múltiplas moedas e investimentos.

Embora o GnuCash seja bastante adequado para finanças pessoais, também é suficientemente poderoso
para pequenos negócios. Há muitas funcionalidades disponíveis, desde sistemas integrados de contas a
receber e a pagar até à construção de tabelas de impostos. Vai achar estas e outras funcionalidades para
negócios surpreendentemente poderosas e fáceis de usar.
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Funcionalidades

Fácil de usar

Dentro de alguns minutos estará capaz de inserir as informações sobre as suas finanças pessoais e gerar
gráficos coloridos que representam o seu estado financeiro. Se consegue usar o papel do seu livro de che-
ques, consegue usar o GnuCash! Digite diretamente nos diários, salte entre campos e aproveite o preen-
chimento rápido para completar automaticamente as transações. O ambiente é personalizável de dentro
da aplicação.

• Menus fáceis de usar: o GnuCash dispõe de menus conformes com as GNOME Human Interface Gui-
delines. Isto significa que são simples e semelhantes a muitas outras aplicações GNOME.

• Documentação: o GnuCash dispõe de Ajuda interna e documentação extensa neste Guia de conceitos.

• Métodos de importação: o GnuCash suporta muitas formas de introduzir transações, além da manual. Se
pode aceder ao seu banco online, isto é especialmente útil, dado que a maioria dos bancos e companhias
de cartões de crédito suportam um dos seguintes métodos de importação. Perderá menos tempo a inserir
dados e terá mais tempo para analizar resultados.

• Quicken Import File (QIF): importe ficheiros tipo Quicken QIF, um formato de ficheiro popular em
pacotes de gestão de finanças pessoais.

• Open Financial Exchange (OFX): o GnuCash é o primeiro programa gratuito a suportar o protocolo
Open Financial Exchange. Muitas instituições financeiras estão a migrar para este formato.

• Home Banking Computer Interface (HBCI): o GnuCash é o primeiro programa gratuito a suportar o
protocolo German Home Banking Computer Interface. Este protocolo inclui transferência de extratos
e torna os débitos diretos possíveis.

• Relatórios: o GnuCash vem com mais de 30 relatórios pré- configurados, incluindo Sumário de contas,
Receitas, Despesas, Relatório de transações, Folha de saldo, Lucro & Prejuízo, Avaliação de portfólio
e muitos outros. Os relatórios suportam a apresentação gráfica dos dados, incluindo gráficos circulares,
de barras e de dispersão. Podem ser exportados para ficheiros HTML e são facilmente personalizáveis.

• Transações agendadas: o GnuCash tem agora a possibilidade de criar e inserir automaticamente tran-
sações, ou lembrar quando elas são devidas, dando-lhe a escolha de as inserir, adiar ou remover da lista.

• Assistente de amortização de empréstimos e hipotecas: use-o para configurar uma transação agendada
de pagamento variável de um empréstimo.

• Reconciliação fácil de contas: a reconciliação integrada faz com que seja muito simples e eficaz recon-
ciliar as suas contas do GnuCash com os extratos bancários.

• Compatibilidade multi-plataforma: o GnuCash é suportado numa variedade de plataformas e sistemas
operativos. A lista de sistemas operativos (e plataformas) para o GnuCash 2.6.20 é: GNU/Linux (x86,
x86_64, Sparc, PPC), FreeBSD (x86, x86_64), OpenBSD (x86, x86_64), Solaris (Sparc), e MacOS
(Intel, PPC). Sabe-se que versões prévias do GnuCash trabalharam com SGI IRIX (MIPS), IBM AIX
4.1.5, (RS/6000), Unixware 7 (Intel), e SCO OpenServer 5.0.4 (Intel), mas atualmente desconhece-se
o seu estado. E claro que inclui o Windows.
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Controla os seus investimentos
O GnuCash inclui várias funcionalidades que lhe permitem controlar todos os seus investimentos. Com
o GnuCash pode seguir ações individualmente (uma por conta) ou num portfólio de contas (um grupo de
contas pode ser mostrado em conjunto).

O GnuCash suporta cotações online de ações e fundos de investimento. Isto significa que já não terá de
procurar uma cotação de cada vez. Pode automatizar o processo e ver sempre a última cotação das suas
ações.

Suporte international
O GnuCash é realmente uma aplicação que trabalha com e compreende utilizadores de todo o mundo. Há
muitas funcionalidades internas que facilitam a interação com o mundo globalizado em que vivemos hoje.

• Idiomas nativos: o GnuCash está completamente traduzido em 12 idiomas: Alemão, Brasileiro, Chinês,
Checo, Eslovaco, Espanhol, Francês, Holandês, Inglês, Italiano, Português, Russo e Sueco. São ainda
parcialmente suportados mais 25 idiomas.

• Gestão de formatos internacionais: o GnuCash compreende que diferentes países mostram data e nú-
meros diferentemente. Pode trabalhar com os formatos de data e números a que está habituado.

• Múltiplas moedas e mercado monetário: são suportadas múltiplas moedas e podem ser compradas e
vendidas (negociadas). Movimentos de moeda entre contas mantém-se saldados se ativar "Contas de
bolsa".

• Taxas de câmbio online: com o GnuCash, já não precisa de procurar taxas de câmbio uma por uma.
Pode automatizar o processo e ver sempre os valores das contas convertidos para a sua moeda favorita
usando as últimas taxas de câmbio.

Suporte a pequenos negócios
O GnuCash tem muitas funcionalidades para suportar as necessidades da comunidade de contabilistas.

• Contas cobráveis/pagáveis: o GnuCash tem um sistema integrado de contas cobráveis e pagáveis. Po-
de controlar Clientes, Fornecedores, Faturação, Pagamentos e usar diferentes impostos e condições de
pagamento num pequeno negócio.

• Desvalorização: o GnuCash pode calcular a desvalorização de ativos de capital.

• Relatórios: o GnuCash oferece uma grande variedade de relatórios de negócios prontos a usar.

Funcionalidades contabilísticas
Para os entendidos em contabilidade, eis uma lista das funcionalidades do GnuCash:

• Dupla entrada: cada transação tem de debitar uma conta e creditar outra em montantes iguais. Isto
garante o “balanço dos livros” - a diferença entre receitas e despesas é exatamente igual à soma de todos
os ativos, banco, dinheiro, ações, etc..

• Transações com parcelas: uma única transação pode ser dividida em várias partes, para registar impos-
tos, taxas e outras entradas compostas.

• Àrvore de contas: uma conta-mãe pode ter uma hierarquia de contas de detalhe. Isto permite que con-
tas de tipo similar, tais como Banco, Dinheiro ou Ação, sejam agrupadas numa conta-mãe, tal como
“Ativos”.
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• Diário geral: uma janela de diário pode mostrar múltiplas contas ao mesmo tempo. Isto facilita o tra-
balho de procurar erros de ortografia/introdução. Também oferece uma forma conveniente de ver um
portfólio de várias ações, mostrando todas as transações nesse portfólio.

• Contas de tipo Receita/Despesa (categorias): estas categorizam o seu fluxo de caixa, e, quando usadas
adequadamente com a dupla entrada, fornecem um extrato preciso de Lucro & Prejuízo.

Acerca deste livro
O objetivo deste guia é poupar-lhe tempo. Põe o GnuCash a funcionar tão rapidamente quanto possível.

Cada capítulo segue um formato simples. Começa com uma discussão sobre “Conceitos”, que introduz
temas e terminologia gerais, abordados e usados no capítulo. Seguem-se secções “Como fazer”, que abor-
dam procedimentos específicos. Finalmente, uma secção “Juntar as peças” termina o capítulo com exem-
plos concretos e detalhados.

Os "contabilistas" principiantes acharão as secções “Conceitos” muito úteis. Elas oferecem uma referência
para boas maneiras de controlar as suas finanças e servem como introdução geral a terminologia e bases
financeiras. Utilizadores experientes podem saltar para as secções “Como fazer” para verem rapidamente
os procedimentos. Estas secções fornecem passos detalhados para realizar tarefas específicas. As secções
“Juntar as peças” apresentam exemplos reais na forma de um tutorial. Começando com a criação de um
novo ficheiro em Capítulo 2, O básico, cada capítulo sucessivo dá sequência ao tutorial anterior.

Este manual está organizado em 3 partes principais:

• Primeiros passos

• Gerir finanças pessoais

• Gerir finanças empresariais

Os Primeiros passos dão-lhe a mais básica informação necessária para começar a usar o GnuCash. Os
capítulos nesta secção explicam os conceitos fundamentais para usar o GnuCash. Os novos utilizadores
do GnuCash devem familiarizar-se com a informação neles contida para começar a trabalhar:

• Capítulo 1, Visão geral - (este capítulo) dá uma visão geral do GnuCash

• Capítulo 2, O básico - faz uma breve introdução aos princípios contabilísticos e oferece informação
sobre como o GnuCash estrutura os dados. Também há informação sobre elementos base do ambiente
de trabalho do GnuCash. Finalmente, explica como o GnuCash armazena e gere os seus dados.

• Capítulo 3, Contas - contém mais informação sobre contas e como organizá-las.

• Capítulo 4, Transações - informação básica sobre transações e como inseri-las.

Gerir finanças pessoais  aborda aplicações e funcionalidades comuns do GnuCash em maior detalhe. Verá
casos mais específicos, baseados em questões frequentes sobre a aplicação do GnuCash a situações do dia
a dia. Aqui estão as aplicações e funcionalidades cobertas nesta parte:

• Capítulo 5, Livro de cheques

• Capítulo 6, Cartões de crédito

• Capítulo 7, Empréstimos

• Capítulo 8, Investimentos
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• Capítulo 9, Ganhos de capital

• Capítulo 10, Múltiplas moedas

Gerir finanças empresariais discute a utilização do GnuCash em contabilidade de pequenos negócios:

• Capítulo 11, Business Introduction

• Capítulo 12, Business Setup

• Capítulo 13, Accounts Receivable

• Capítulo 14, Accounts Payable

• Capítulo 15, Payroll

• Capítulo 16, Budgets

• Capítulo 17, Other Assets

• Capítulo 18, Depreciation

• Capítulo 19, Python Bindings

• Capítulo 20, Importing Business Data

Este manual também inclui vários apêndices, que contêm informação extra de que poderá necessitar:

• Apêndice A, Guia de migração - guia para antigos utilizadores de Quicken®, MS Money ou outros
utilizadores QIF

• Apêndice B, Questões frequentes

• Apêndice C, Planos de contas contribuídos

• Apêndice D, Formatos de ficheiros auxiliares

• Apêndice E, GNU Free Documentation License (Licença da documentação livre GNU)

Por último, um glossário e índice que ajudam a localizar rapidamente os tópicos.

Instalação
A instalação do GnuCash é simples.

A página de transferência do GnuCash [http://www.gnucash.org/download.phtml] contém instruções de-
talhadas sobre a instalação do GnuCash em cada sistema operativo suportado.
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Capítulo 2. O básico
Este capítulo introduz algumas bases para usar o GnuCash. Recomenda-se que o leia antes de começar a
fazer algum trabalho real com o GnuCash. Nos capítulos seguintes verá exemplos onde pode "pôr as mãos".

Conceitos contabilísticos
Embora o GnuCash seja suficientemente fácil de usar para que não haja a obrigação de ter uma compre-
ensão completa de princípios contabilísticos, verá que algum conhecimento básico sobre contabilidade
provará ser inestimável, uma vez que o GnuCash foi desenhado usando estes princípios como modelo. É
altamente recomendável que compreenda esta secção do guia antes de continuar.

As 5 contas básicas

Regras contabilísticas básicas agrupam todas as coisas relacionadas com finanças em 5 tipos fundamentais
de “contas”. Ou seja, tudo aquilo com que as contas lidam pode ser colocado numa destas 5 contas:

Tipos de contas

Ativo Aquilo que possui

Passivo Aquilo que deve

Capital próprio Valor líquido global

Receita Aumentam o valor das suas contas

Despesa Diminuem o valor das suas contas

Está claro que se pode categorizar o seu mundo financeiro nestes 5 grupos. Por exemplo, o dinheiro na sua
conta bancária é um ativo, o seu crédito à habitação é um passivo, o seu salário é uma receita e o jantar
fora da noite passada é uma despesa.

A equação contabilística

Com 5 contas básicas definidas, qual é a relação entre elas? Como é que um tipo de conta afeta as outras?
Primeiro, o capital próprio é definido pelo ativo e pelo passivo. Ou seja, o seu valor líquido é calculado
subtraindo o seu passivo do seu ativo:

Ativo - Passivo = Capital próprio

Para além disto, pode aumentar o seu capital próprio com receitas e diminui-lo com despesas. Isto faz
sentido, claro. Quando recebe o seu salário fica mais “rico” e quando paga o jantar fica mais “pobre”. Isto
é expresso matematicamente por aquilo que é conhecido como a equação contabilística:

Ativo - Passivo = Capital próprio + (Receita - Despesa)

Esta equação tem de estar sempre equilibrada, uma condição que só pode ser satisfeita se inserir valores
em múltiplas contas. Por exemplo, se receber dinheiro na forma de receita, tem de ver um aumento igual
no seu ativo. Outro exemplo, pode ter um aumento no ativo se tiver um aumento paralelo no passivo.
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Figura 2.1. As relações básicas entre contas

Receita Des pes a

Capital próprio
(Ativo - Pass ivo)

Ativo
Valor Pos itivo

Pas s ivo
Valor Negativo

Uma imagem das relações entre as cinco contas básicas. O valor líquido (capital próprio) aumenta através da receita
e diminui através da despesa. As setas representam o movimento do valor.

Dupla entrada
A equação contabilística é o próprio coração de um sistema contabilístico de dupla entrada. Para cada
alteração de valor numa conta da equação contabilística, tem de haver uma alteração equilibrada noutra.
Este conceito é conhecido como Princípio do equilíbrio, e é de importância fundamental para compreender
o GnuCash e outros sistemas contabilísticos de dupla entrada. Quando trabalha como o GnuCash, estará
sempre preocupado com pelo menos duas contas, para manter a equação contabilística equilibrada.

Equilibrar alterações (ou transferir dinheiro) entre contas é feito debitando uma conta e, simultaneamente,
creditando outra. Débitos e Créditos contabilísticos não significam “decréscimo” e “acréscimo”. Tanto os
débitos como os créditos aumentam certas contas e diminuem outras. Em contas de ativos e despesas, os
débitos aumentam o saldo e os créditos diminuem-no. Nas contas de passivo, capital próprio e receita, os
créditos aumentam o saldo e os débitos diminuem-no.

Na contabilidade tradicional de dupla entrada, a coluna esquerda do diário é usada para débitos, enquanto
a coluna direita é usada para créditos. Os contabilistas registam aumentos do ativo e despesas na coluna
dos débitos (esquerda) e aumentos do passivo e capital próprio e receitas nos créditos (direita). O GnuCash
segue esta convenção nos diários.

Nota

Esta terminologia contabilística pode ser confusa para novos utilizadores, que é o motivo por-
que o GnuCash lhe permite usar termos como Depósito e Levantamento. Se preferir os termos
contabilísticos formais, pode forçar os cabeçalhos de coluna a usá-los no separador Contas nas
Preferências (consulte o manual de ajuda do GnuCash para obter mais informação sobre como
definir preferências).

Atenção

A utilização comum das palavras débito e crédito não corresponde à forma como os contabilistas
usam estes termos. Em termos comuns, crédito tem uma associação positiva. Em contabilidade,
crédito significa afetar a coluna direita de um diário de conta. Isto é associado a um decréscimo
no ativo e nas despesas, mas a um acréscimo de receita, passivo e capital próprio.

Para mais detalhes, veja Débitos e créditos [https://pt.wikipedia.org/wiki/D%C3%A9bi-
to_e_cr%C3%A9dito].

Conceitos de introdução de dados
Ao introduzir dados no GnuCash, deve estar sempre atento a 3 níveis de organização em que o GnuCash
divide os seus dados: ficheiros,contas e transações. Estes níveis são apresentados pela sua ordem de com-
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plexidade, um ficheiro contém muitas contas e uma conta contém muitas transações. Esta divisão é fun-
damental para saber como usar o GnuCash.

Ficheiros
O GnuCash armazena informação ao mais alto nível em ficheiros. Um ficheiro pode ser armazenado no
seu computador com um único ficheiro XML (em todas as versões do GnuCash), ou numa base de dados
SQL (no GnuCash verso 2.4 e posteriores).

Com o formato XML, o GnuCash armazena os seus dados num ficheiro de dados XML, normalmente
comprimido (embora isto possa ser alterado no separador Geral das Preferências do GnuCash).

Com o armazenamento em SQL, o GnuCash grava os seus dados numa base de dados SQL sob a aplicação
que selecionar (SQLite3, MySQL ou PostgreSQL).

Precisará de um ficheiro ou base de dados principal para cada conjunto de contas que mantenha. Para
aprender a criar e gerir ficheiros do GnuCash, veja “Armazenar os seus dados financeiros”.

Nota

Se pensa que precisará de mais de um conjunto de contas, talvez deva consultar um contabilista
profissional antes de continuar. A maioria dos utilizadores muito provavelmente só precisa de
um ficheiro.

Cópias de segurança e ficheiros de registo são gerados automaticamente pelo GnuCash quando necessário.
Este ficheiros são descritos em “Fazer e restaurar cópias de segurança”.

Contas
Uma conta controla aquilo que possui, deve, gasta ou recebe. Cada ficheiro do GnuCash pode conter
qualquer número de contas e cada conta pode conter muitas subcontas até um número arbitrário de níveis.
Esta simples funcionalidade dá ao GnuCash muito do seu poder de gestão das suas finanças, como verá
mais adiante.

Exemplos de contas incluem: contas à ordem, contas poupança, contas de cartões de crédito, hipotecas e
empréstimos. Cada conta GnuCash controla a atividade da conta “real” e pode informá-lo do seu estado.

Além disto, as contas também são usadas para categorizar o dinheiro que recebe ou gasta. Por exemplo,
pode criar contas de despesa para dinheiro que gasta em serviços e mercearias. Embora estas contas não
recebam extratos, permitem-lhe determinar quanto dinheiro gasta em cada área.

As contas são explicadas em mais detalhe em Capítulo 3, Contas.

Transações
Uma transação representa o movimento de dinheiro entre contas. Sempre que gasta ou recebe dinheiro,
ou transfere dinheiro entre contas, faz uma transação.

Mais exemplos de transações são: pagar uma conta telefónica, transferir dinheiro da conta à ordem para a
conta de poupanças, comprar uma pizza, levantar dinheiro ou depositar um cheque. Capítulo 4, Transações
aprofunda a forma de inserir transações.

Em contabilidade de dupla entrada, as transações envolvem sempre pelo menos duas contas – uma conta
origem e uma conta destino. O GnuCash gere esta situação inserindo uma linha na transação para cada
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conta afetada e registando os montantes envolvidos em cada linha. Uma linha destas é chamada parcela.
Uma transação pode conter qualquer número de parcelas.

Nota

As parcelas das transações serão estudadas em “Exemplo de transação com parcelas”

Ambiente de trabalho
A primeira vez que abre o GnuCash, verá o ecrã Boas vindas ao GnuCash!. A partir daí, o GnuCash oferece
outras ferramentas para ajudar a encontrar facilmente aquilo que procura. Vamos espreitar alguns do ecrãs
e diálogos mais comuns.

Dica do dia

O GnuCash dá-lhe dicas do dia com sugestões úteis na utilização do programa:

Esta imagem mostra a Dica do dia.

Estas dicas dão informação útil a utilizadores principiantes. Para ver mais dicas, clique em Avançar. Se
não quiser ver este ecrã no arranque, desmarque a caixa Mostrar sugestões no arranque. Quando terminar,
clique em Fechar para sair do ecrã Dica do dia.

Janela da árvore de contas

Deve agora ver a janela Contas, que se parece com a que é mostrada abaixo. A disposição exata da árvore
de contas depende das contas predefinidas que selecionou durante a configuração da nova hierarquia de
contas. Neste exemplo, são mostradas as contas comuns.
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Esta imagem mostra a janela Contas.

A janela Árvore de contas (também conhecida como Plano de contas) oferece uma visão geral dos dados
contidos no ficheiro atual. Pode ver uma lista de nomes de conta e os seus saldos atuais.

A partir desta janela, pode abrir o diário de qualquer conta, seja com um duplo clique no seu nome, seja
com um clique direito e selecionando Abrir conta no menu contextual, seja usando o botão Abrir na barra
de ferramentas. O GnuCash permite abrir tantos diários de conta quantos desejar. Para mais informação
sobre a utilização de diários de conta, veja “Janela de diário de conta”.

Dica

Clicar no pequeno triângulo à esquerda do nome de uma conta que tenha contas filho expande
a árvore, mostrando essas contas.

Ao cimo desta janela está a barra de título, que mostra o nome de ficheiro deste conjunto de contas (uma
vez que grave o ficheiro). Logo abaixo está a barra de menus. Pode aceder às opções dos menus clicando
nos títulos ou usando atalhos de teclado (veja “Atalhos de menu”). A seguir está a barra de ferramentas,
que contém botões para as funções mais comuns da janela em foco.

A árvore de contas aparece abaixo da barra de ferramentas. Uma vez que comece a criar contas, os seus
nomes aparecem na árvore. Pode personalizar os títulos que vê usando a seta para baixo, no lado direito
e acima da árvore de contas.

Ao fundo está a barra de estado, contendo informação acerca do que possui (ativos líquidos) e quanto
dinheiro é que já fez (lucro).

Janela de diário de conta

As janelas de diários de conta são usadas para inserir e editar os seus dados contabilísticos. São semelhantes
ao talão de controlo do seu livro de cheques.
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Esta imagem mostra o diário da conta à ordem com várias transações.

Em Capítulo 4, Transações encontra mais explicações sobre diários de conta e como inserir dados. Por
agora, note que as secções da janela de diário são semelhantes às da janela da árvore de contas, descri-
ta antes. A barra de título no topo contém o nome da conta. Abaixo, a barra de menu contém opções
relacionadas com o diário da conta. Os botões da barra de ferramentas simplificam funções comuns de
introdução de dados. A barra de estado em baixo mostra alguns saldos de conta, cobertos no capítulo
Capítulo 4, Transações. Ao fundo da janela aparece informação sobre os campos onde o cursor está atu-
almente localizado.

Nota

Nas janelas de diários, pode dimensionar as várias colunas que o GnuCash mostra, mas lembre-se
que a coluna de descrição expande-se automaticamente para preencher todo o espaço livre. As-
sim, deve primeiro expandir todas as outras colunas e só depois diminuir o tamanho da coluna
Descrição.

Botões da barra de ferramentas
Tanto a janela da árvore de contas como a janela de diário de conta contêm botões na barra de ferramentas.
Estes botões oferecem acesso rápido a várias funções comuns, tais como Gravar e Abrir, na árvore de
contas e Registar e Eliminar no diário de conta. Se não estiver certo do que um botão faz, paire com o rato
em cima dele durante algum tempo e verá uma descrição da sua função.

Eis um resumo dos botões da janela de diário:

Botões da janela de diário

Gravar Grava o ficheiro atual em disco

Fechar Fecha o separador em foco

Abrir, Editar, Novo e Eliminar Estas são funções relacionadas com contas.
São discutidas em Capítulo 3, Contas.

Botões específicos dos diários são discutidos em Capítulo 4, Transações.

Barra de separadores
O GnuCash usa um modelo em separadores que lhe permite abrir múltiplos diários de conta e relatórios
simultaneamente. A cada janela aberta (que pode incluir separadores de diários de conta, relatórios ou
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transações agendadas) é dado um separador nesta barra, que pode clicar para ver. Os separadores podem
ser configurados nas Preferências para serem vistos em qualquer dos lados da janela do GnuCash.

Para ver o nome completo de um separador, paire com o rato sobre esse separador durante algum tempo.

Se tiver mais separadores abertos do que aqueles que cabem no ecrã, alguns desaparecem. No entanto,
surgem, em ambos os lados da barra de separadores, umas pequenas setas que pode usar para se deslocar
entre separadores. Pode ainda ver uma lista dos separadores abertos se clicar com o botao direito do rato
num dos separadores, podendo em seguida clicar naquele que quiser.

Itens de menu

Os separadores da árvore de contas e dos diários de conta contêm títulos de menu na barra de menus.
Clicar num deles mostra os itens de menu desse título.

Pode clicar nos títulos de menu e depois mover o ponteiro do rato sobre os itens para ver o que eles fazem.
À medida que o ponteiro se move sobre um item, surge uma descrição no canto inferior esquerdo da janela
(dentro da barra de estado). Para selecionar um item de menu, clique-o.

Também pode aceder aos itens de menu mais comuns num separador clicando com o botão direito do rato
em qualquer sítio desse separador. Na árvore de contas, abre uma lista de itens de conta. Num diário de
conta abre uma lista de itens de transações..

Outra forma de aceder aos itens de menu é através de atalhos de teclado, descritos a seguir.

Atalhos de menu

Todos os itens de menu têm teclas de acesso, que estão marcadas por caracteres sublinhados nos nomes
dos menus. Premir a tecla Alt e o carácter sublinhado no título do menu mostra os itens desse menu. Em
seguida, digite o carácter sublinhado do item que quer usar para o ativar. Por exemplo, digitar Alt+F na
janela principal abre o menu Ficheiro, se digitar em seguida Ctrl+S grava o ficheiro. As teclas de acesso
são fixas e não podem ser alteradas pelos utilizadores.

Alguns dos itens de menu mais comummente usados também têm atalhos de teclado que ativam o comando
diretamente sem ter de passar através da estrutura dos menus. Tipicamente estes usam a tecla Ctrl, embora
possam usar qualquer combinação de teclas. Estes atalhos são mostrados a seguir aos itens de menu.

Obter ajuda
O GnuCash oferece várias formas de ajuda. Já falámos da  Dica do dia, que lhe dá sugestões úteis no
arranque da sessão do GnuCash. O GnuCash também oferece um extenso manual de ajuda.

Manual de ajuda

Uma vez aberto o GnuCash, verá na barra de menus o título Ajuda, onde encontra o item Conteúdos F1,
que abre o manual de ajuda. Este manual está organizado por tópicos, que podem ser expandidos para ver
os respetivos subtópicos.

Os tópicos estão listados à esquerda. Para selecionar um tópico ou subtópico, clique-o e deverá ver o texto
correspondente à direita. Use os botões Anterior e Seguinte para navegar entre os tópicos. Pode também
imprimir um tópico através do menu Página.
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Acesso à Internet
A janela de ajuda do GnuCash também atua como um navegador web simples, para que possa abrir uma
página web para obter informação adicional. Pode abrir qualquer página nesta janela clicando em Abrir na
barra de ferramentas e digitando o URL. Use os botões Recuar, Avançar, Recarregar, Parar, e Imprimir
tal como num navegador web padrão.

A página web do GnuCash [http://www.gnucash.org] contém informação útil sobre o programa e suas
atualizações. Também contém ligações às listas de correio do GnuCash para utilizadores e programado-
res e permite a procura nos arquivos das listas de correio do GnuCash [https://lists.gnucash.org/cgi-bin/
namazu.cgi] por discussões sobre um tópico específico. Se não encontrar as respostas que procura, pode
perguntar na  lista de utilizadores do GnuCash [https://lists.gnucash.org/mailman/listinfo/gnucash-user] e
alguém nessa lista tentará responder-lhe.

As FAQ do GnuCash mais atualizadas estão localizadas em  Faq do GnuCash [http://wiki.gnucash.org/wi-
ki/FAQ] e contêm respostas às perguntas mais frequentes.

Procura por tópico
O manual também oferece uma função de procura. Para procurar um tópico em particular, clique no campo
da lupa, Procura no cimo da janela do manual e digite o que quer procurar. Surge uma lista de escolhas
logo abaixo, onde pode clicar para ir para o tópico desejado.

Armazenar os seus dados financeiros
O GnuCash é capaz de armazenar os seus dados financeiros em ficheiros ou bases de dados SQL para
que possam ser abertos e modificados posteriormente. Mas primeiro tem de criar um contentor para os
seus dados.

Criar um ficheiro
Para criar um novo ficheiro do GnuCash faça o seguinte:

1. Na barra de menu do GnuCash, escolha Ficheiro → Novo ficheiro. Inicia-se o assistente Nova hierar-
quia de contas.

Nota

Se está a executar o GnuCash pela primeira vez, verá o diálogo Boas vindas ao GnuCash!.
Este diálogo é descrito em detalhe no manual do GnuCash.

2. Configure as suas preferências no assistente e mova-se entre os ecrãs com os botões Avançar, Cancelar
e Recuar.

Gravar dados
Siga estes passos para gravar o ficheiro com o seu nome preferido:

1. Escolha Ficheiro → Gravar como... na barra de menus ou clique no botão Gravar na barra de ferra-
mentas. O GnuCash abre o diálogo de gravação.
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2. Selecione o formato dos dados do ficheiro que está a gravar na lista pendente. A seleção predefinida é
XML, mas se tiver um motor de base de dados configurado, pode mudar para esse formato.

Dependendo do formato de dados selecionado, a janela pode mudar, como descrito a seguir.

3.
• Se selecionou XML ou sqlite3 verá um ecrã como este:

Figura 2.2. Ecrã de gravação quando seleciona XML ou sqlite3.

Esta imagem mostra o ecrã Gravar como... quando o formato dos dados é XML ou sqlite3.

Digite o nome escolhido no campo Nome. Não é necessário especificar uma extensão.O GnuCash
adiciona a extensão .gnucash automaticamente ao ficheiro.

Nota

A extensão .gnucash foi introduzida na série 2.3 do GnuCash. Para ficheiros já existen-
tes,a extensão nunca será alterada. Assim, se abrir um ficheiro chamado MeuFichAntigo,
esse nome não é alterado quando gravar o ficheiro. Pode usar o comando Gravar como... e
dar um novo nome ao ficheiro para o ter gravado com a extensão .gnucash.

Selecione o caminho onde o ficheiro será gravado navegando na árvore nos três painéis inferiores.

Dica

Clique em Criar pasta para criar uma nova pasta com um nome personalizado no caminho
escolhido.

• Se selecionou mysql ou postgres para formato de dados verá um ecrã como este:
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Figura 2.3. Ecrã de gravação quando seleciona mysql ou postgres.

Esta imagem mostra o ecrã Gravar como... quando o formato dos dados é mysql ou postgres.

Insira nesta janela a informação de ligação à base de dados: Máquina, Base de dados, Utilizador e
Senha.

Atenção

Gravar como mysql ou postgres requer as permissões adequadas para a base de dados, ou
seja, tem de ter permissão para criar uma nova base de dados com o nome indicado, ou tem
de ter permissão de escrita numa base de dados existente com o nome indicado.

4. Clique em Gravar como para gravar o ficheiro.

Se está a controlar as finanças de uma única família, só precisa de um ficheiro. Mas se também controla as
finanças da empresa, ou quer manter dados separados por alguma razão, precisará de mais de um ficheiro.

Antes de terminar uma sessão do GnuCash, certifique-se que grava as alterações, usando Ficheiro →
Gravar ou o botão Gravar na barra de ferramentas.

Nota

Dado que é muito importante gravar frequentemente os seus dados para não os perder por qual-
quer motivo, o GnuCash pode gravar automaticamente o ficheiro aberto em determinados perío-

dos de tempo. Este intervalo pode ser definido no separador Geral indo a Editar → Preferênci-

as (GnuCash → Preferências em MacOS). Lembre-se que esta opção só é relevante se estiver a
gravar em formato XML. Se trabalha com uma base de dados, o botão Gravar e o item de menu
Gravar estarão em cinzento, dado que as alterações são imediatamente gravadas.
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Abrir dados

Para abrir um ficheiro ou base de dados existente, selecione Ficheiro → Abrir na barra de menus. Na
janela que surge, selecione o formato de dados. Se selecionou Ficheiro escolha o ficheiro que quer abrir,
navegando pelas pastas nos painéis inferiores. Senão, insira a necessária informação para ligação à base
de dados.

Dica

O GnuCash mantém uma lista de ficheiros recentemente abertos. Abra o menu Ficheiro e verá
essa lista, em baixo. Clique no nome desejado para o abrir.

Duplicar a hierarquia de contas
Nalguns casos, poderá ser útil duplicar a estrutura de um ficheiro de dados existente. Por exemplo, pode
querer experimentar uma nova técnica de contabilização sem corromper o ficheiro atual, ou pode precisar
de começar o ano com um novo conjunto de livros.

O GnuCash permite criar uma cópia vazia do plano de contas simplesmente selecionando Ficheiro →
Exportar → Exportar contas. Quando seleciona este comando, é-lhe pedido que forneça um nome para o
novo ficheiro vazio e o GnuCash cria um novo ficheiro de dados contendo só a árvore de contas (ou seja,
não há dados de transações). Uma vez gravado, o novo ficheiro pode ser aberto tal como qualquer outro
ficheiro de dados do GnuCash.

Fazer e restaurar cópias de segurança
O GnuCash cria vários tipos de ficheiros para ajudar a garantir que os seus dados não se perdem. Se
procurar na pasta onde grava o seu ficheiro,poderá ver outros ficheiros gerados pelo GnuCash com as
seguintes extensões: .gnucash, .log, .LCK, .LNK, todos na mesma pasta que o seu ficheiro primário
de dados. O que cada um destes ficheiros faz é descrito abaixo.

Nota

As secções seguintes só são relevantes se grava o seu ficheiro de dados em formato XML.

      $ ls 
      meufich.gnucash
      meufich.gnucash.20100414185747.gnucash
      meufich.gnucash.20100414223248.log
      meufich.gnucash.20100415114340.gnucash
      meufich.gnucash.20100415154508.log
      meufich.gnucash.20100415173322.gnucash
      meufich.gnucash.20100415194251.log
      meufich.gnucash.7f0982.12093.LNK
      meufich.gnucash.LCK
    

Cópia de segurança (.gnucash)
Sempre que grava o seu ficheiro de dados, também é gravada uma cópia de segurança com a extensão
.AAAAMMDDHHMMSS.gnucash. Este ficheiro é uma cópia completa do seu ficheiro de dados anterior.
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E o formato do nome de ficheiro refere-se ao ano, mês, dia e hora da cópia de segurança. Por exemplo,
o ficheiro meufich.gnucash.20160122180000.gnucash indica que esta é uma cópia de segu-
rança do ficheiro meufich, gravado a 22 de janeiro de 2016, exatamente às 18:00.

Para restaurar uma cópia de segurança, abra simplesmente o ficheiro AAAAMMDDHHMMSS.gnucash
com a data a que quer voltar. Certifique-se que grava esse ficheiro com um nome diferente.

Nota

.AAAAMMDDHHMMSS.xac em vez da extensão atual .AAAAMMDDHHMMSS.gnucash. Se atu-
alizar da série 2.2 para a 2.4, poderá acabar com as duas, .AAAAMMDDHHMMSS.xac e .AAA-
AMMDDHHMMSS.gnucash cópias de segurança na sua pasta.

Ficheiro de registo (.log)
De cada vez que abre e edita um ficheiro no GnuCash, é criado um ficheiro de registo, que grava as
alterações feitas ao seu ficheiro de dados. Este ficheiro de registo usa um formato de nome semelhante ao
das cópias de segurança: .AAAAMMDDHHMMSS.log. Os ficheiros de registo não são uma cópia completa
do seu ficheiro de dados - simplesmente gravam as alterações feitas ao ficheiro de dados na sessão atual
do GnuCash.

Caso saia do GnuCash inadvertidamente, possivelmente por uma falha elétrica ou um rebentamento do
sistema, pode recuperar a maior parte do seu trabalho desde que gravou o seu ficheiro do GnuCash pela
última vez, usando este ficheiro de registo. Proceda desta forma:

1. Abra o último ficheiro gravado do GnuCash.

2. Vá a Ficheiro → Importar → Reproduzir ficheiro .log do GnuCash... e selecione aquele que tiver a
mesma data que o ficheiro gravado que acabou de abrir. Certifique-se que escolhe o ficheiro correto
ou corre o risco de lançar o caos nas suas contas.

A reprodução do ficheiro recupera qualquer transação que afete o saldo inserida desde a última gravação,
incluindo aquelas criadas a partir de transações agendadas e funcionalidades de negócios (faturas, paga-
mentos, etc.).

Atenção

Alterações às transações agendadas, faturas ou pagamentos em si mesmos NÃO são recuperadas
e as suas transações que o foram podem não estar corretamente associadas a elas. Deve portanto
verificar tudo cuidadosamente. Especialmente transações de negócios, onde poderá ter de elimi-
nar e recriar algumas. Se não o fizer, embora o balanço possa estar correto, alguns relatórios não
estarão.

Ficheiros tranca (.LNK e .LCK)
Ocasionalmente poderá ver ficheiros .LNK e .LCK . Estes não contêm quaisquer dados, mas são criados
para impedir mais de um utilizador de abrir o mesmo ficheiro em simultâneo. São criados automaticamente
quando abre um ficheiro para o trancar de forma a que mais ninguém lhe aceda. Quando fecha a sessão no
GnuCash ou abre outro ficheiro, o GnuCash destranca o primeiro ficheiro eliminando os ficheiros .LCK
e .LNK.

Se o GnuCash rebentar enquanto tiver um ficheiro de dados aberto, os ficheiros .LCK e .LNK não são
eliminados. Quando tentar abrir novamente o GnuCash, será avisado que o ficheiro está trancado. A men-

20



O básico

sagem aparece porque os ficheiros .LNK e .LCK ainda estão na sua pasta. É seguro escolher Sim para
abrir o ficheiro de dados, mas deve eliminar os ficheiros .LNK e .LCK (usando uma janela de terminal ou
o seu gestor de ficheiros).Uma vez eliminados, já não voltará a receber o aviso. A não ser que o GnuCash
volte a rebentar.

Gestão de ficheiros
Então que ficheiros é que deve manter?Mantenha o seu ficheiro de dados, claro. É boa ideia conservar
algumas das mais recentes cópias de segurança .AAAAMMDDHHMMSS.gnucash, mas pode eliminar os
ficheiros .log, dado que não são cópias completas dos seus dados.

Nota

Se atualizou o GnuCash da versão 2.4 ou anterior, poderá também ter cópias de segurança no
antigo formato .xac. Para estes, pode aplicar o mesmo princípio descrito acima para os ficheiros
.AAAAMMDDHHMMSS.gnucash.

Também deve eliminar todos os ficheiros .LCK e .LNK que vir após fechar o GnuCash. Se decidir fazer
uma cópia de segurança manual noutro disco, basta copiar o ficheiro de dados principal - não as cópias
de segurança .AAAAMMDDHHMMSS.gnucash.

Nota

Por predefinição, o GnuCash elimina automaticamente qualquer ficheiro .log e .AAA-
AMMDDHHMMSS.gnucash com mais de 30 dias. Pode alterar este comportamento nas prefe-

rências do GnuCash. Vá a Editar → Preferências, separador Geral (GnuCash → Preferências em
MacOS).

Migrar dados do GnuCash
Por vezes poderá precisar de mover os seus dados financeiros e definições do GnuCash para outra máquina.
Casos típicos serão a compra de um novo computador ou a utilização das mesmas definições em dois
sistemas operativos diferentes.

Migrar dados financeiros
Migrar os seus dados financeiros do GnuCash tão simples como copiar o ficheiro .gnucash com um
gestor de ficheiros, se souber onde eles estão.Se não se lembrar onde os guardou mas os consegue abrir
no GnuCash , grave-os no local desejado com o GnuCash.

Todos os outros ficheiros na pasta são ou cópias de segurança ou ficheiros de registo. Não faz mal se
também os copiar, mas também não tem utilidade.

Migrar as preferências
As preferências são armazenadas em três locais diferentes: um para as preferências do GnuCash, um para
os relatórios e um para as definições dos bancos. As preferências são geridas pelo gsettings, os relatórios
são geridos pelo GnuCash e a banca online é gerida pelo aqbanking. Se não usa a banca online, não terá
esta pasta na sua máquina.

Onde as preferências do GnuCash estão armazenadas varia, dependendo do seu sistema operativo (veja
Tabela 2.1, “Localização das definições da aplicação”, Tabela 2.2, “Localização dos relatórios gravados”,
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e Tabela 2.3, “Localização da definições do Online Banking”). Para fazer uma cópia de segurança da
instalação completa, tem de incluir estas preferências todas.

Tabela 2.1. Localização das definições da aplicação

SO Pasta

Unix As preferências do GnuCash estão armazenadas
no dconf. Pode usar o comando dconf dump /
org/gnucash/ na máquna antiga e dconf
load /org/gnucash/ na máquina nova para
migrar as suas preferências.

Mac OSX ~/Library/Preferences/gnu-
cash.plist

Windows As preferências estão armazenadas no registo
do Windows HKEY_CURRENT_USER/soft-
ware/GSettings

Tabela 2.2. Localização dos relatórios gravados

SO Pasta

Unix ~/.gnucash

Mac OSX ~/Library/Application Support/gnu-
cash

Windows Documents and Settings/Userna-
me/.gnucash or Users/Username/.gnu-
cash

Tabela 2.3. Localização da definições do Online Banking

SO Pasta

Unix ~/.aqbanking

Mac OSX ~/.aqbanking

Windows Documents and Settings/Userna-
me/.aqbanking

Nota

Em Unix e Mac OSX, estas pastas habitualmente não são mostradas nos gestores de ficheiros.
Tem de optar por mostrar ficheiros e pastas ocultos para as poder ver.

Dica

Em Unix e Mac OSX, o símbolo ~ significa a pasta home.

Juntar as peças
Nota

Esta secção começa com um tutorial que continuará ao longo de todo o livro. No final de cada
capítulo, verá uma secção Juntar as peças que o acompanha através de exemplos que ilustram
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os conceitos previamente discutidos. Cada uma das secções Juntar as peças é construída sobre a
anterior, certifique-se que grava o seu ficheiro para mais fácil acesso.

Vamos começar!

1. Primeiro vamos criar um ficheiro para armazenar os seus dados reais.Abra o GnuCash e selecione

Ficheiro → Novo ficheiro na barra de menu. Isto inicia o assistente Nova hierarquia de contas, que lhe
permite criar várias contas de uma só vez.

Nota

Se está a executar o GnuCash pela primeira vez, verá o ecrã Impossível encontrar valores
predefinidos, que é descrito detalhadamente no manual do GnuCash.

Esta imagem mostra o primeiro ecrã do assistente Nova hierarquia de contas.

Este ecrã dá-lhe uma breve descrição daquilo que o assistente faz. Clique em Avançar para passar ao
ecrã seguinte.

2. No segundo ecrã, selecione na lista pendente a moeda a usar em novas contas. Depois, clique em Avan-
çar.

Nota

A moeda que selecionar aqui será associada a todas as contas criadas neste assistente.
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Esta imagem mostra o segundo ecrã do assistente Nova hierarquia de contas, onde seleciona a moeda.

3. No terceiro ecrã, encontra quatro separadores, Contas, Orçamento, Negócios e Contadores. Todas estas
opções são descritas em detalhe no manual do GnuCash. Quando terminar, clique em Avançar.

Esta imagem mostra o terceiro ecrã do assistente Nova hierarquia de contas, onde seleciona as opções
do novo livro.

4. No quarto ecrã, selecione o grupo Contas comuns no painel Categorias. Clique em Avançar para con-
tinuar.

Nota

Se quiser, pode selecionar mais de um grupo predefinido de contas.Para mais informação sobre
os tipos de contas, veja “Contas GnuCash”.
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Esta imagem mostra o quarto ecrã do assistente Nova hierarquia de contas, onde escolhe as várias
contas.

5. No quinto ecrã poderá definir saldos iniciais para cada uma das contas, assim como indicar se as contas
são Marcador de posição. Como estas funcionalidades serão discutidas nos próximos capítulos, deixe
tudo tal como está predefinido pelo GnuCash e clique em Avançar para abrir o último ecrã do assistente.

Esta imagem mostra o quinto ecrã do assistente Nova hierarquia de contas .

6. No último ecrã do assistente, clique em Aplicar para criar todas as contas e sair do assistente.
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O básico

Esta imagem mostra o último ecrã do assistente Nova hierarquia de contas.

7. Após clicar em Aplicar, verá o diálogo de gravação. Selecione o formato de dados XML, nomeie o
ficheiro como gcashdata_1 e selecione a pasta onde gravar o ficheiro. Lembre-se disto, porque este
ficheiro será usado nos tutoriais seguintes e clique em Gravar como.

A sua janela principal deverá agora parecer-se com esta:
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Capítulo 3. Contas
Este capítulo discute alguns conceitos úteis para organizar as suas contas. Uma vez que o GnuCash não
impõe nenhum esquema específico de estrutura de contas, pode desenhar a sua própria estrutura como
desejar. Contudo, há alguns conceitos contabilísticos básicos que provavelmente quererá seguir, para ma-
ximizar a utilidade das suas contas.

Conceitos básicos de contabilidade
Tal como foi dito no capítulo anterior, a contabilidade baseia-se em 5 tipos de contas: Ativo, Passivo,
Capital próprio, Receita e Despesa. Vamos agora expandir a nossa compreensão sobre estes tipos de conta
e mostrar como é que elas são representadas no GnuCash. Mas primeiro, vamos dividi-las em dois grupos,
as contas de folha de balanço por um lado e as contas de receita e despesa por outro.

Como o nome diz, as contas da folha de balanço podem ser sumarizadas no balanço daquilo que possui
em determinado ponto do tempo, enquanto as contas de receita e despesa podem ser sumarizadas no rela-
tório de Lucros & Prejuízo, que mostra as alterações de valor num dado período de tempo, como o ano
económico, por exemplo.

Recordemos a equação contabilística (Ativo - Passivo = Capital próprio + (Receita - Despesa)), antes de
aprofundarmos cada tipo de conta.

Receita Des pes a

Capital próprio
(Ativo - Pass ivo)

Ativo
Valor Pos itivo

Pas s ivo
Valor Negativo

Uma visão gráfica da relação entre as 5 contas básicas. O valor líquido (capital próprio) aumenta com a
receita e diminui com a despesa. As setas representam o movimento dos valores.

Contas do balanço
As três chamadas Contas do balanço são Ativo, Passivo, e Capital própro. As contas de balanço são usadas
para controlar aquilo que possui.

Ativo é o grupo de coisas que possui. Os seus ativos incluem um carro, dinheiro, uma casa, ações ou
qualquer outra coisa que tenha um valor convertível. Valor convertível significa que, teoricamente, pode
vender o item por dinheiro.

Passivo é o grupo de coisas em que deve dinheiro. O seu passivo pode incluir um empréstimo automóvel,
um empréstimo para estudos, uma hipoteca para crédito à habitação ou qualquer coisa que terá de pagar
em determinada altura.

Capital próprio é o mesmo que "valor líquido". Representa o que sobra depois de subtrair o seu passivo
do seu ativo. Pode ser imaginado como a parte do ativo que está livre de dívidas.

Contas de Receita e Despesa
Estas duas contas de receita e despesa são usadas para aumentar ou diminuir o valor das suas contas.
Assim, enquanto as contas de balanço se limitam a "ver" o valor daquilo que possui, as contas de receita
e despesa permitem-lhe alterar o valor das suas posses.
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Receita é o pagamento que recebe pelo seu tempo, serviços prestados ou pelo uso do seu dinheiro. Quando
recebe um ordenado, por exemplo, esse ordenado é o pagamento pelo trabalho que fez a um empregador.
Outros exemplos de receita serão comissões de vendas, gorjetas, dividendos de ações, juros de depósitos a
prazo, etc. As receitas aumentam sempre o valor dos seus ativos, logo, o valor do capital próprio também
aumenta.

Despesa refere-se a dinheiro que gasta a comprar bens ou serviços prestados por outrém para consumo
imediato. Exemplos de despesas são uma refeição no restaurante, a renda de casa, mercearias, gasolina para
o carro ou bilhetes de teatro. As despesas diminuem sempre o capital próprio. Se pagar a despesa a pronto,
diminui os ativos, se pagar a despesa com cartão de crédito ou com um empréstimo aumenta o passivo.

Contas GnuCash
Esta secção mostra como é que a definição de contas do GnuCash se ajusta aos cinco tipos básicos de
contas.

Mas primeiro, vamos começar por uma definição de conta no GnuCash. Uma conta GnuCash é uma enti-
dade que contém outras subcontas ou que contém transações. Uma vez que uma conta pode conter outras
contas, verá frequentemente árvores de contas no GnuCash, nas quais contas logicamente associadas são
agrupadas sob uma conta-mãe comum.

Uma conta GnuCash tem de ter um nome exclusivo (atribuído por si) e um dos “tipos de conta” predefinidos
do GnuCash. Há um total de 12 tipos de conta no GnuCash. Estes 12 tipos de conta são baseados nos 5
tipos contabilísticos básicos. O motivo para haver mais tipos de contas do GnuCash do que os cinco tipos
contabilísticos básicos é permitir ao GnuCash controlar e gerir certas contas especializadas. Há seis contas
de ativos (Dinheiro, Banco, Ação, Fundo de investimento, C/Cobrável e Ativo), três contas de passivos
(Cartão de crédito, C/Pagável e Passivo), uma conta de capital próprio (Capital próprio), uma conta de
receita (Receita) e uma conta de despesa (Despesa).

Estes tipos de conta do GnuCash são apresentados abaixo com mais detalhe.

Contas de balanço
A primeira conta de balanço que vamos examinar é Ativo, que, como se lembra da secção anterior, se
refere a coisas que possui.

Para ajuda na organização das suas contas de ativos e para simplificar introdução de transações, o GnuCash
suporta vários tipos de contas de ativos:

1. Dinheiro - use esta conta para controlar o dinheiro vivo que tem, seja na carteira, no porquinho mea-
lheiro, debaixo do colchão ou onde quer que esteja. Este é o tipo de ativo mais líquido ou facilmente
negociável.

2. Banco - esta conta serve para controlar o saldo do dinheiro que tem em instituições bancárias, corretoras,
empresas de poupanças - o que quer que seja onde o seu dinheiro é guardado por outras pessoas. É o
segundo tipo de conta mais líquido, porque pode ser facilmente convertido em dinheiro na mão.

3. Ação - controle as suas ações e títulos individuais usando este tipo de conta. O diário de contas Ação
oferece colunas extra para inserir o número de ações e a cotação do seu investimento. Este tipo de
ativos pode não ser facilmente convertível em dinheiro, a não ser que encontre um comprador, mas não
é garantido que recupere o dinheiro investido.

4. Fundo de investimento - semelhante às contas Ação, só que é usada para monitorizar fundos. O diário
de conta exibe as mesmas colunas extra para quantidade e cotação dos fundos. Os fundos representam
a propriedade de ações numa variedade de investimentos e, tal como as ações, não oferecem garantias
de valor investido.
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5. C/Cobrável - esta é tipicamente uma conta só para negócios, onde coloca pagamentos que a empresa
tem a receber. É considerado um ativo porque poderá contar com a entrada destes fundos.

Transações envolvendo uma conta C/Cobrável não devem ser adicionadas, alteradas ou eliminadas por
nenhum outro meio que não seja:

• emitir/anular emissão de pagamento/fatura/vale de despesa ou

• processar pagamentos

6. Ativo - não importa quão diversas sejam, o GnuCash gere muitas outras situações facilmente. A cate-
goria “Ativo” cobre todos os ativos não listados acima.

Contas são repositórios de informação, usados para controlar ou registar o tipo de ações que ocorrem
relacionadas com o propósito para que a conta foi definida.

Para negócios, as atividades controladas e reportadas são frequentemente subdivididas mais finamente
do que se fez até agora. Para um tratamento mais desenvolvido das possibilidades, por favor leia as
descrições na secção Capítulo 17, Other Assets deste guia.

Para finanças pessoais, uma pessoa pode seguir os agrupamentos para negócios ou não, conforme sejam
ou não úteis para controlar as atividades de cada um e o tipo de relatórios que sejam necessários para
gerir os seus ativos financeiros. Para informação adicional, consulte o capítulo Capítulo 17, Other Assets
deste guia.

A segunda conta do balanço é Passivo, que, como se lembra, se refere às coisas que deve, dinheiro que
pediu emprestado e será obrigado a pagar algum dia. O passivo representa os direitos dos emprestadores a
receberem o seu pagamento. Controlar os saldos do passivo permite-lhe saber quanto deve em determinado
momento.

O GnuCash oferece três tipos de contas de passivo:

1. Cartão de crédito - use este tipo para controlar os recibos do seu cartão de crédito e reconciliar o extrato
do cartão. Os cartões de crédito representam um empréstimo a curto prazo que tem a obrigação de pagar
à companhia. Este tipo de conta também pode ser usada para outro tipo de empréstimos de curto prazo,
por exemplo, uma linha de crédito do seu banco.

2. C/Pagável - esta é tipicamente uma conta só para negócios, onde coloca os pagamentos que ainda não
fez.

Transações envolvendo uma conta C/Pagável não devem ser adicionadas, alteradas ou eliminadas por
nenhum outro meio que não seja:

• emitir/anular emissão de pagamento/fatura/vale de despesa ou

• processar pagamentos

3. Passivo - use este tipo de conta para todos os outros empréstimos, normalmente a médio e longo prazo,
tais como um crédito à habitação ou uma compra de automóvel. Esta conta permite-lhe controlar quanto
deve e quanto é que já pagou.

Dica

Em contabilidade, o passivo atua de maneira oposta ao ativo: créditos (entradas na coluna direita)
aumentam o saldo de contas do passivo e os débitos (entradas na coluna esquerda) diminuem-no.
(veja a nota mais adiante neste capítulo)
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A última conta do balanço é Capital próprio, que é sinónimo de “valor líquido”. Representa o valor que
sobra depois de subtrair o seu passivo do seu ativo, ou seja, é a parte dos seus bens que possui realmente,
sem dever nada. No GnuCash, use este tipo de conta como origem dos seus saldos bancários iniciais,
porque estes saldos representam o seu valor líquido inicial.

Habitualmente só há uma única conta de capital próprio no GnuCash, chamada, obviamente, Capital pró-
prio. Para empresas, cooperativas, etc. pode criar uma subconta para cada sócio.

Dica

Em contas de capital próprio,os créditos aumentam o saldo das contas e os débitos diminuem-no.
(veja a nota mais adiante neste capítulo)

Nota

A equação contabilística que liga as contas de balanço é Ativo = Passivo + Capital próprio ou,
rearranjada, Ativo - Passivo = Capital próprio. Ou seja, em linguagem corrente, aquilo que é seu
menos aquilo que deve é igual ao seu valor líquido.

Contas de receita e despesa

Receita é o pagamento que recebe pelo seu tempo, por serviços prestados ou pela utilização do seu dinheiro.
No GnuCash, use uma conta de tipo Receita para controlá-las.

Dica

Os créditos aumentam o saldo das contas de receita e os débitos diminuem-no. Como descrito em
“Conceitos contabilísticos”, os créditos representam dinheiro transferido DE uma conta. Assim,
nestas contas especiais de receita, quando transfere dinheiro de (crédito) uma conta de receita
para outra conta, o saldo da conta de receita aumenta. Por exemplo, quando deposita um ordenado
e regista a transação como transferência de uma conta de receita para a conta à ordem, os saldos
de ambas as contas aumentam.

Despesa refere-se a dinheiro que gasta para comprar bens ou serviços. No GnuCash, use uma conta de
tipo Despesa para monitorizar as suas despesas.

Dica

Débitos aumentam o saldo de contas de despesa e créditos diminuem-no (veja a nota mais adiante
neste capítulo).

Nota

Quando subtrai o total de despesas do total de receitas num dado período, obtém a receita líquida.
Esta é depois adicionada ao balanço como ganhos retidos, que é um tipo de conta de capital
próprio.

Abaixo estão as contas predefinidas de Receita e Despesa após selecionar Contas comuns no assistente

Ações → Nova hierarquia de contas...).
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Esta imagem mostra as contas padrão de Receita

Esta imagem mostra algumas contas predefinidas de Despesa

Juntar as peças
Vamos passar pelo processo de construir uma árvore de contas pessoal comum, usando a informação que
aprendemos neste capítulo. Uma árvore de contas é simplesmente um novo ficheiro do GnuCash onde
agrupa as contas para controlar as suas finanças. Ao construir esta árvore de contas, a primeira tarefa é
dividir os itens que quer controlar nos tipos contabilísticos básicos. Isto é relativamente simples, vamos
ver um exemplo.

31



Contas

Exemplo simples

Vamos assumir que tem no seu banco uma conta à ordem e uma conta poupança e que está empregado,
recebendo um ordenado. Tem um cartão de crédito (Visa) e paga serviços mensais na forma de renda,
telefone e eletricidade. Naturalmente também tem de comprar comida. Para já não nos vamos preocupar
com quanto dinheiro tem no banco, quanto deve no cartão de crédito, etc. Queremos simplesmente cons-
truir a estrutura desta árvore de contas.

Os seus ativos seriam a conta poupança e a conta à ordem. O seu passivo seria o cartão de crédito. O seu
capital próprio seriam os valores iniciais do cartão de crédito e das contas no banco (ainda não temos esses
valores, mas sabemos que existem). Tem receitas na forma de ordenado e despesas na forma de comida,
renda, eletricidade, telefone e impostos sobre o ordenado (IRS, Segurança Social, Seguro).

As contas básicas de topo

Agora, tem de decidir como quer agrupar essas contas. Muito provavelmente, quererá os seus Ativos num
grupo, o seu Passivo noutro, o seu Capital próprio noutro, a sua Receita noutro, e a sua Despesa noutro.
Esta é a forma mais comum de construir uma árvore de contas do GnuCash e é altamente recomendável
que comece um ficheiro sempre assim.

Comece com um ficheiro limpo do GnuCash selecionando Ficheiro → Novo ficheiro no menu. Inicia-se
o assistente Nova hierarquia de contas. Clique em Cancelar para fechar o assistente, uma vez que não
queremos usar uma das estruturas de contas predefinidas; em vez disso, vamos construir uma estrutura de

contas básica de raiz. Se necessário, na janela vazia do GnuCash selecione Ver → Nova página de contas
no menu: abre-se o separador Contas. Se já o tiver aberto, passe à frente e, finalmente, selecione Ações

→ Nova conta....

Agora está tudo pronto para começar a construir a estrutura de contas básica

1. Nome de conta Ativos (Tipo de conta Ativo, Conta-mãe Nova conta de topo)
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Esta imagem mostra o diálogo para criar uma conta de ativos

2. Nome de conta Passivo (Tipo de conta Passivo, Conta-mãe Nova conta de topo)

3. Nome de conta Capital próprio (Tipo de conta Capital próprio, Conta-mãe Nova conta de topo)

4. Nome de conta Receitas (Tipo de conta Receita, Conta-mãe Nova conta de topo)

5. Nome de conta Despesas (Tipo de conta Despesa, Conta-mãe Nova conta de topo)

Quando tiver criado todas as contas de topo, a página principal do GnuCash deverá parecer-se com a figura
abaixo.
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Esta imagem mostra as contas de topo básicas.

Criar subcontas
Pode agora aumentar esta estrutura básica de alto nível inserindo subcontas que realmente recebem tran-
sações. Note que contas de impostos são postas numa subconta chamada Impostos. Pode criar subcontas
dentro de subcontas. Isto é feito tipicamente num grupo de contas relacionadas (tais como contas de im-
postos).

Dica

Em vez de selecionar Ações → Nova conta... no menu, pode criar uma conta clicando com o botão
direito do rato no nome da conta principal e selecionando Nova conta.... Isto abre um diálogo
semelhante ao retratado em “As contas básicas de topo” mas onde a nova subconta já estará
definida como subconta da conta principal.

1. Nome de conta Dinheiro (Tipo de conta Dinheiro, Conta-mãe Ativos)

2. Nome de conta Conta à ordem (Tipo de conta Banco, Conta-mãe Ativos)

3. Nome de conta Conta poupança (Tipo de conta Banco, Conta-mãe Ativos)

4. Nome de conta Visa (Tipo de conta Cartão de crédito, Conta-mãe Passivo)

5. Nome de conta Ordenado (Tipo de conta Receita, Conta-mãe Receitas)

6. Nome de conta Telefone (Tipo de conta Despesa, Conta-mãe Despesas)

7. Nome de conta Eletricidade (Tipo de conta Despesa, Conta-mãe Despesas)

8. Nome de conta Renda (Tipo de conta Despesa, Conta-mãe Despesas)

9. Nome de conta Comida (Tipo de conta Despesa, Conta-mãe Despesas)

10.Nome de conta Impostos (Tipo de conta Despesa, Conta-mãe Despesas)

11.Nome de conta IRS (Tipo de conta Despesa, Conta-mãe Despesas:Impostos)

12.Nome de conta Segurança Social (Tipo de conta Despesa, Conta-mãe Despesas:Impostos)

13.Nome de conta Seguro (Tipo de conta Despesa, Conta-mãe Despesas:Impostos)

34



Contas

14.Nome de conta Saldo inicial (Tipo de conta Capital próprio, Conta-mãe Capita próprio)

Após ter criado mais estas subcontas, o resultado final deverá ser parecido com a figura abaixo.

Esta imagem mostra uma árvore de contas simples.

Grave esta árvore de contas com o nome gcashdata_3 e também como gcashdata_3_vazia, uma
vez que continuaremos a usar estes ficheiros nos capítulos futuros.

Acabou de criar uma árvore de contas (ou plano de contas) para controlar um orçamento familiar simples.
Com esta estrutura básica no lugar, podemos agora começar a povoar as contas com transações. O próximo
capítulo cobre este assunto com grande detalhe.

35



Capítulo 4. Transações
Este capítulo dá-lhe a informação básica necessária para compreender e usar transações no GnuCash.
Enquanto as contas são a estrutura de uma árvores de contas, as transações são os dados que cada conta
contém.

Conceitos básicos
Uma transação num sistema contabilístico de dupla entrada tal como o GnuCash é uma troca entre pelo
menos duas contas. Logo, uma transação simples tem de consistir sempre de duas partes, uma conta de
e uma conta para. A conta de está a transferir valor para a conta para. Os contabilistas chamam a estas
partes da transação Entradas do razão. No GnuCash, chamamos-lhes parcelas.

Uma parcela identifica a conta a que se refere, o montante específico em dinheiro que é movido de ou
para essa conta e pode conter mais algumas peças específicas de informação, se necessário. O GnuCash
suporta múltiplas parcelas numa única transação que podem mover dinheiro arbitrariamente de ou para
as contas envolvidas.

Por exemplo, recebeu um ordenado e depositou-o na sua conta poupança, no banco. A transação que
ocorre é que a conta poupança no banco (um ativo) recebeu dinheiro da conta de receita. Duas contas são
afetadas e, neste caso, há um aumento líquido do seu capital próprio.

O trabalho com transações no GnuCash é feito usando o que é conhecido por diário de conta. Cada conta
que cria tem um diário de conta. Ser-lhe-á familiar porque se parece com o talão usado para controlar o
livro de cheques.

O diário de conta é explicado na secção seguinte, “O diário de conta”.

O diário de conta
O diário de conta a janela do GnuCash, que lhe permite ver e editar transações pré-existentes, ou adicionar
novas transações numa conta em particular. Para abrir um diário de conta a partir da árvore de contas, faça
um duplo clique no nome da conta, clique com o botão direito no nome e selecione Abrir conta no menu
ou use o botão na barra de ferramentas. O GnuCash abre a janela do diário de conta.

Funcionalidades do diário de conta
A barra de título do diário de conta mostra o nome da conta. Abaixo da barra de título, a barra de menu
mostra os itens de menu disponíveis dentro do diário de conta e a barra de ferramentas contém cómodos
botões que o ajudam a trabalhar com o diário de conta.

Ao fundo à esquerda da janela do diário, o GnuCash mostra mensagens úteis à medida que se move dentro
do diário. À direita, pode ver o saldo atual da conta e o total de parcelas confirmadas.

Escolher um estilo de diário
O GnuCash oferece várias opções para ver os diários. O estilo predefinido é Livro razão básico, que mostra
só o sumário das parcelas que afetam a conta atual. Este é o estilo que mais se parece com outros pacotes
de gestão populares. Pode escolher um estilo de diário diferente indo a Ver. Há ainda mais dois modos:

• O estilo Ver → Livro razão de parcelas automáticas expande a transação atual automaticamente. Quando
põe uma transação em foco no diário, ela expande-se automaticamente para mostrar todas as parcelas.
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• O estilo Ver → Diário de transações mostra todas as parcelas no diário, o que se parece mais com um
diário contabilístico.

Todos os estilos lhe permitem ver os seus dados em modo de linha única ou em modo de linha dupla.

Selecione Ver → Linha dupla e verá a sua linha de transação expandida para duas linhas do diário. O modo
de linha dupla também mostra o campo Notas da transação.

Abaixo estão imagens que demonstram as diferenças entre o livro razão básico e o diário de transações.

Para este exemplo, imaginemos que comprou três pares de calças de ganga por 1,000 € e registou a compra
como uma transação com parcelas, com cada par numa parcela.

Estas imagens ilustram as diferenças entre os modos.

Primeiro vejamos a transação a partir da conta à ordem:

Esta imagem mostra uma transação com parcelas de compra de calças

Agora, vejamos a conta Despesas:Roupa, no modo básico.

Esta imagem mostra a conta Despesas:Roupa em modo Livro razão básico.

Surgem aqui três entradas, mas só havia uma única entrada com parcelas na conta à ordem. Um exame
mais apurado mostra que cada linha tem um montante diferente, 200€, 300€ e 500€. Isto demonstra que
cada linha nesta vista reflete uma única parcela da transação original.

Se mudar para o modo Diário de transações verá só a transação original com parcelas.

Esta imagem mostra a conta Despesas:Roupa em modo Diário de transações.
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Usando atalhos de introdução
O GnuCash oferece vários atalhos para poupar tempo ao inserir os seus dados. Quando digita os primeiros
caracteres de uma descrição que já utilizou, a funcionalidade Preenchimento rápido preenche automatica-
mente o resto da transação tal como a inseriu antes. Quando digita o primeiro carácter de um nome de
conta, seja no campo Transferência, da linha da transação, seja no campo Conta da linha da parcela, o
nome é completado automaticamente a partir da sua lista de contas. Também o ajuda a inserir subcontas
nestes campos: digite os primeiros caracteres da conta-mãe, seguidos de : (dois pontos) [ou o carácter que
escolheu como separador de contas]e os primeiros caracteres do nome da subconta. Por exemplo, para
inserir Ativo:Conta à ordem, pode digitar A:C e deixar o GnuCash fazer o resto.

Atenção

Por : ser o símbolo de separação de contas, não o pode usar nos nomes de conta.

Dica

Se realmente precisa dos dois pontos no nome de uma conta, pode escolher outro símbolo indo

a Editar → Preferências → Contas+Carácter.

Os atalhos de teclado do diário também lhe poupam tempo e o GnuCash oferece-lhe vários. No campo
de data pode digitar:

• + ou = para incrementar a data e - ou _ para a decrementar

• ] ou } para incrementar o mês e [ ou { para o decrementar

• M ou m para inserir a primeira data do mês

• H ou h para inserir a última data do mês

• Y ou y para inserir a primeira data do ano

• R ou r para inserir a última data do ano

• T ou t para inserir a data de hoje

No campo Nº da linha da transação, pode digitar + para incrementar o número da transação a partir do
último que inseriu. Digitar - decrementa-o. Isto também funciona no campo Ação da linha da parcela, se
escolher inserir números de parcela aí. O campo Ação também suporta preenchimento rápido - se digitar
os primeiros caracteres de uma ação comum (tal como Depósito), o GnuCash preenche o resto.

O campo Transferência suporta o preenchimento rápido dos nomes de conta. Pode começar a escrever o
nome da conta e o GnuCash preenche o que falta. Digitar o carácter separador a qualquer altura completa
o nome de conta no nível atual, deixando o cursor posicionado no início do nome da próxima subconta.
Por exemplo, se escrever A:C, será completado para Ativos:Conta à ordem. Também pode usar as com-
binações Menu ou Ctrl+Seta abaixo neste campo para ver uma lista de todos os nomes de conta.

Em qualquer um dos campos de montantes, pode usar uma calculadora interna. Simplesmente digite o
primeiro valor, seguido de +, -, *, ou / e escreva o segundo valor. O GnuCash faz o cálculo e insere o
resultado no campo de montante quando premir Tab. Por exemplo, pode inserir 50*100/123 para inserir
uma compra de 50 € sem IVA a 23 %

Todos os itens de menu têm teclas de caesso definida e estão marcadas por caracteres sublinhados nos
nomes de menu. Prima Alt + [carácter sublinhado] para abrir o menu e depois selecione o item digitando o
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seu carácter sublinhado. Por exemplo, escrever Alt+A abre o menu Ações, seguido de P divide a transação.
Alguns dos itens de menu têm ainda atalhos que chamam o comando diretamente (tipicamente usando
Ctrl). Estes atalhos estão listados a seguir ao item.

Para se mover dentro do diário, use estas teclas para poupar tempo:

• Tab para passar ao campo seguinte, Shift+Tab para passar ao campo anterior

• Home para se mover para o início do campo, End para se mover para o final do campo

• Enter ou ↓ para se mover para a próxima transação, ↑ para se mover para a transação anterior

• Page Up para se mover um ecrã acima, Page Down para se mover um ecrã abaixo

• Shift+Page Up para ir para a primeira transação, Shift+Page Down para ir para a última transação

Na janela de reconciliação pode usar estes atalhos de teclado:

• Tab move para a caixa seguinte e Shift+Tab move para a caixa anterior

• A barra de espaço alterna o estado entre reconciliada e não reconciliada

• ↑ e ↓ navegam pelas entradas dentro da caixa atual

Transações Simples vs. Com parcelas
Cada transação no GnuCash tem pelo menos duas parcelas, mas uma mesma transação pode ter mais de
duas parcelas. Uma transação com duas parcelas é chamada de transação simples, dado que só envolve a
conta atual e uma única conta remota. Uma transação com três ou mais contas é chamada uma transação
com parcelas.

Quando o diário está em modo básico, verá um sumário das parcelas que afetam a conta atual. Para uma
transação simples, a coluna Transferência mostra a outra conta de onde o dinheiro foi transferido. Para
uma transação com parcelas, a coluna Transferência mostra -- Transação com parcelas --. Pode ver as
parcelas individuais de cada transação clicando em Parcelas na barra de ferramentas depois de selecionar
a transação apropriada.

Para transações com parcelas, a primeira linha da transação é a linha de transação. Contém uma Data, um
Nº opcional (tal como um número de cheque), uma Descrição, o montante total que afeta a conta atual
(Tot Crédito aqui) e saldo atualizado após a transação atual. Note que na vista expandida, o cabeçalho
da coluna Transferência desaparece e não há nome de conta nesse campo. Esta linha mostra-lhe só um
sumário do efeito da transação na conta atual. Para obter informação mais detalhada, tem de ver as parcelas
individuais que constituem a transação.

As linhas parciais abaixo da linha de transação são as linhas de parcelas, e são separadas por linhas cin-
zentas. Quando puser em foco uma dessas linhas de parcelas, os cabeçalhos de colunas alteram-se para
mostrar os campos relacionados com as parcelas:

39



Transações

Esta imagem mostra como se alteram os cabeçalhos das colunas.

Cada parcela contém uma Ação opcional, ou tipo de parcela, que pode inserir ou escolher duma lista.
Contém também um Memorando opcional, que descreve a parcela. Cada parcela afeta uma Conta, que
pode ser selecionada de uma lista pendente de contas. O campo R indica se a parcela foi reconciliada. As
últimas duas colunas mostram o montante da parcela e se o dinheiro está a entrar ou a sair da conta.

Tal como discutimos em “Conceitos contabilísticos”, o total de débitos (coluna esquerda) deve ser igual
ao total de créditos (coluna direita) para cada transação. No exemplo mostrado acima, o total de débitos
é igual ao total de créditos, pelo que a transação está saldada. Se reparar, a linha de transação contém o
mesmo montante de débito que a linha da parcela Conta à ordem. Porque é que vemos isto duas vezes?
Porque a linha de transação é meramente um sumário do efeito da transação na conta atual. A mesma
transação numa conta diferente terá uma linha de transação diferente, uma que mostre o efeito nessa conta
em particular. Pode confirmar isto selecionando outra linha de parcela e clicando no botão Saltar na barra
de ferramentas.

Neste exemplo, se saltar para a conta Receitas:Ordenado, o GnuCash abre a mesma transação no diário
Receitas:Ordenado:

Esta imagem mostra um salto até à conta Receitas:Ordenado.

Note que o total da linha de transação agora sumariza o efeito na conta Receitas:Ordenado em vez da
Conta à ordem, porque está a olhar para o diário da conta Receitas:Ordenado. As parcelas são exatamente
as mesmas, mas a linha de transação agora reflete o crédito para a conta Receitas:Ordenado.

Exemplo com uma transação simples
Começando com a árvore de contas que cirámos no capítulo anterior, gcashdata_3, faça duplo clique
em Conta à ordem. Vamos adicionar uma transação simples a esta conta. Quando primeiro cria as suas
contas no GnuCash, é habitual começar com um saldo inicial.

Na primeira linha da transação, insira uma data (ex: 1 de janeiro de 2006), uma descrição (ex: “Saldo
inicial”), clique na lista pendente Transferência e selecione Capital próprio:Saldo inicial, adicione um
depósito de 1000€ e prima Enter. O diário da conta deverá estar parecido com esta imagem:

Esta imagem mostra o diário de Ativos:Conta à ordem após inserir uma transação de valor inicial.

Definir o saldo inicial de uma conta é um exemplo de uma transação simples entre duas contas. Neste caso,
afetando as contas Ativos:Conta à ordem e Capital próprio:Saldo inicial.
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Como outro exemplo de uma transação simples afetando só duas contas, adicione outra transação para
descrever a compra de mercearias no valor de 45.21€. Dentro da conta Ativos:Conta à ordem, defina
Transferência para Despesas:Comida. O diário de conta deve agora parecer-se com:

Esta imagem mostra o diário de Ativos:Conta à ordem após adicionar uma transação para compra de
mercearias.

Exemplo de transação com parcelas

A necessidade para três ou mais parcelas ocorre quando precisa de dividir uma das contas “de” ou “para”
numa mesma transação em múltiplas contas. O exemplo clássico disto será a receção de um cheque de
ordenado. Aquilo que realmente recebe é tipicamente menos que aquilo que lhe pagam, sendo a diferença
devida a impostos, segurança social e/ou outros itens. Logo, a transação simples de receber um cheque de
ordenado envolve outras contas além da conta Ativos:Conta à ordem e Receitas:Ordenado.

Para adicionar a transação com parcelas a partir do diário de conta  Ativos:Conta à ordem, clique numa
linha de nova transação e clique em Parcelas. Note que se definiu a vista do diário para Livro razão de par-
celas automáticas ou Diário de transações, as parcelas abrem-se sozinhas. Insira a descrição desta transação
na primeira linha (ex: “Empregador”). Nas linhas de parcelas abaixo, insira as várias parcelas que com-
põem esta transação, uma a uma. Para inserir as parcelas, primeiro escolha a conta, depois insira o mon-
tante por que alterar a conta. Tenha em mente que quando está num diário de conta de ativos, os montantes
inseridos na coluna esquerda aumentam o saldo da conta, enquanto montantes inseridos na coluna direita
o diminuem (para mais informação, veja “Transações”). Prima Tab ou clique na próxima linha de parcela
e repita o processo. Note que, se está a usar o teclado para navegar na transação, use Tab para se mover
entre campos, uma vez que a tecla Enter regista a transação e cria parcelas numa conta de desequilíbrio.

Nota

Quando cria uma transação no GnuCash, as parcelas podem ser inseridas em qualquer ordem.
Contudo, quando a transação é fechada (seja saindo da transação, seja premindo Enter), todas as
parcelas de débito passam à frente das parcelas de crédito.

Neste exemplo, escolha a conta de depósito (Ativos:Conta à ordem) e insira o montante a depositar (ex:
670€). Continue a inserir os vários montantes para impostos: conta Despesas:Impostos:IRS, 180€; conta
Despesas:Impostos:Segurança Social, $90€; e conta Despesas:Impostos:Seguro, $60€. Finalmente, insira
o valor bruto do cheque ($1,000€ neste exemplo) como levantamento da conta Receitas:Ordenado.

A divisão final deverá parecer-se com Figura 4.1, “Inserir uma transação com parcelas”. Lembre-se de
premir Enter quando terminar a introdução. Mas também deve saber que quando prime Enter, as parcelas
serão “dobradas” numa vista de transação simples. As parcelas ainda lá estão, só tem de clicar em Parcelas
para as ver. Veja “Funcionalidades do diário de conta” para mais detalhes.
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Figura 4.1. Inserir uma transação com parcelas

Reconciliação
Uma vez inseridas transações no GnuCash, é importante verificar se elas estão de acordo com o extrato
da sua instituição financeira. Este processo de verificação é conhecido por reconciliação e é a chave para
determinar se os seus registos estão corretos. O mais habitual é comparar as suas transações com os extratos
bancários, mas pode usar este processo para verificar qualquer transação.

O GnuCash mantém o estado de reconciliação de cada transação sob controlo. Este estado é mostrado
pelo campo R num diário: r indica que uma transação foi reconciliada, nc indica que não foi confirmada,
e c indica que foi confirmada mas não reconciliada. Uma transação marcada como confirmada significa
que tem alguma confirmação de que a sua ordem foi aceite (por ex., tem o recibo do cartão de crédito
que o restaurante emitiu). Pode alternar o estado de reconciliação entre nc e c clicando no campo R; pode
defini-lo para r usando “Janelas de reconciliação”.

Ao fundo da janela da conta, há (entre outros) dois saldos em execução (os saldos Confirmado e Reconci-
liado) e o saldo Futuro. Os primeiros devem corresponder aquilo que o seu banco pensa que tem na conta,
enquanto o último inclui transações pendentes.

Por exemplo, quando passa um cheque, deve inserir a transação no GnuCash. O campo de reconciliação
R da transação conterá inicialmente nc (não confirmada).A sua nova entrada vai contribuir para o saldo
Futuro, mas não para os saldos Confirmado e Reconciliado. Mais tarde, se obteve confirmação que o
cheque foi cobrado, pode clicar no campo R para o alterar para c (confirmado). Ao fazer isto, o saldo
Confirmado altera-se para incluir esse montante. Quando chegar o extrato do banco, poderá compará-lo
com o que registou no GnuCash, abrindo a janela de reconciliação. Aí, poderá alterar o campo R para r
(reconciliada).

Nota

Não pode reconciliar diretamente numa janela de diário simplesmente clicando no campo R. Tem
de usar a janela de reconciliação. Uma vez que uma transação esteja marcada como reconciliada,
já não pode ser facilmente alterada sem quebrar o Saldo inicial da próxima reconciliação.

Atenção

É importante compreender que a reconciliação é feita para uma determinada data e que quando
reconcilia uma conta baseado num extrato com uma dada data, está a reconciliar todas as tran-
sações anteriores a essa data. Portanto, se adicionar ou modificar transações com data anterior
à da última reconciliação, os seus saldos reconciliados ficam em desequilíbrio.

Janelas de reconciliação
As janelas de reconciliação são usadas para reconciliar uma conta do GnuCash com um extrato que um
banco ou outra instituição financeira lhe enviou. A recociliação é útil, não só para verificar duplamente
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os seus registos com os do banco, mas também para ter uma melhor ideia do que ainda tem pendente, por
exemplo, cheques não cobrados.

Para usar as janelas de reconciliação, selecione uma conta da árvore de contas e clique em Ações → Recon-
ciliar. Abre-se uma janela semelhante à que está abaixo, onde pode inserir a informação de reconciliação.

A janela inicial de reconciliação.

Na janela inicial de reconciliação, tem de inserir alguma informação de reconciliação.

Data do extrato A data do extrato contra o qual vai fazer a re-
conciliação.

Dica

Clique na seta à direita deste campo
para abrir um calendário.

Saldo inicial Este é um item não editável que mostra o sal-
do da reconciliação anterior. Deve correspon-
der ao saldo inicial do seu extrato.

Atenção

Por vezes, o saldo inicial no Gnu-
Cash não corresponde ao encontra-
do no seu extrato. Isto pode aconte-
cer na primeira vez que reconcilia a
sua conta ou quando uma transação
previamente reconciliada foi altera-
da ou eliminada.
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Nota

Na primeira vez que reconcilar a sua
conta, o saldo inicial será 0.00, logo
provavelmente não é o saldo inicial
da sua conta. Quando reconciliar a
conta, o saldo inicial da conta será
incluído na reconciliação e o resul-
tado deverá ficar equilibrado.

Dica

No caso de uma transação previ-
amente reconciliada ser acidental-
mente alterada, pode simplesmen-
te voltar a reconciliá-la juntamente
com as transações do extrato atual e
o resultado deverá ficar equilibrado.

O caso de acidentalmente eliminar
uma transação previamente reconci-
liada apresenta um desafio maior. Se
não puder determinar o que foi apa-
gado e restaurá-lo no diário corres-
pondente, terá de criar uma transa-
ção fictícia para conseguir terminar
a reconciliação.

Cuidado

Embora o último caso não tenha im-
portância na sua contabilidade pri-
vada, se for o contabilista de um clu-
be ou de uma empresa, é melhor que
tenha preparada uma boa explicação
para o sucedido.

Saldo final Este campo deve ser preenchido com o saldo
final que aparece no extrato.

Nota

O GnuCash preenche automatica-
mente este campo com o saldo Atual
mostrado na parte inferior do diário
da conta.

Incluir subcontas Marque esta opção se quiser incluir as transa-
ções que pertencem às subcontas da conta se-
lecionada na reconciliação. Note que todas as
subcontas têm de estar na mesma moeda/mer-
cadoria que a conta-mãe para poder ativar a
opção.
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Inserir pagamento de juros Clicar neste botão abre uma nova janela que
lhe permite inserir uma transação de juros na
conta a ser reconciliada.

Dica

A janela de pagamento de juros po-
derá abrir automaticamente quan-
do inicia uma reconciliação de uma
conta de tipo Banco, Crédito, Fun-
do, Ativo, Cobrável, Pagável e Pas-
sivo. Se quiser desativar este com-
portamento, para qualquer uma das
contas mencionadas, vá ao separa-
dor Diário nas Preferências do Gnu-
Cash e desmarque a caixa Transfe-
rência automática de juros. Em alter-
nativa, para desativar este compor-
tamento só para a conta selecionada,
clique em Sem pagamento automáti-
co de juros nesta conta na janela In-
serir pagamento de juros.

Depois clique em Aceitar e verá a janela de reconciliação com a lista das transações:

A lista de transações na janela de reconciliação.

Os dois painéis chamados Fundos entrados e Fundos saídos, listam todas as transações não reconciliadas
que pertencem à conta que vai ser reconciliada. A coluna R mostra se a transação já foi reconciliada.

Agora, examine cada item no extrato do banco e procure o item correspondente na janela Reconciliar.
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Se não conseguir encontrar uma transação, talvez se tenha esquecido de a inserir, ou não soubesse que ela

tinha acontecido. Pode usar o botão Nova na barra de ferramentas, ou o item de menu Transação → Nova
para abrir o diário e inserir a transação em falta. O novo item vai aparecer na janela Reconciliar quando
premir Enter no diário após inserir a transação.

Quando encontrar o item na janela Reconciliar, compare o montante do item com o montante do extrato.
Se discordar, pode ter cometido um error quando inseriu a transação no GnuCash. Pode usar o botão Editar

na barra de ferramentas ou ir a Transaction → Editar para abrir o diário de conta e corrigir a transação.

Se os montantes concordam, clique no item na janela Reconciliar. Surge uma marca na coluna R ao lado da
transação selecionada. O GnuCash atualiza automaticamente os montantes no painel de sumário inferior
direito.

Dica

Pode usar as teclas de seta acima/abaixo para rolar até ao item, a tecla espaço para marcar o item
como reconciliado e a tecla Tab para alternar entre painéis.

Repita estes passos para cada item que aparece no extrato bancário, verificando se os montantes corres-
pondem aos montantes do GnuCash e marcando as transações no GnuCash à medida que estejam recon-
ciliadas.

Ao fundo da janela Reconciliar há um campo Diferença, que deverá mostrar 0.00 quando terminar a re-
conciliação. Se mostrar qualquer outro valor, ou falhou transações ou alguns montantes estão incorretos
no GnuCash (ou, menos provável, o banco pode ter cometido um erro).

Nota

Sob determinadas circunstâncias, pode ser difícil ou mesmo impossível determinar porque é que
uma conta não reconcilia. Se não for capaz de corrigir a discrepância entre os seus livros e o
extrato, o GnuCash inclui um botão Saldo na barra de ferramentas que cria automaticamente
uma entrada de equilíbrio para o montante em falta.

Para usar isto, faça todas as reconciliações (marcando todas as transações que conseguir identi-
ficar)e clique neste botão. O GnuCash cria a entrada para equilibrar a discrepância restante que
usa a conta especial Contas especiais:Orfã-XXX (onde "XXX" representa a sua moeda). A jane-
la Reconciliar fecha-se; Se a reabrir, conseguirá verificar a recém criada entrada de equilíbrio e
terminar o processo.

Quando tiver marcado todos os itens do extrato bancário e a diferença for 0.00, clique em Terminar na

barra de ferramentas ou selecione Reconciliar → Terminar no menu. A janela Reconciliar fecha-se. No
diário de conta, o campo R das transações reconciliadas altera-se para r.

Neste caso, ainda não recebemos toda a informação, portanto clicamos em Adiar, para que possamos
continuar mais tarde. Observe que a coluna R indica que confirmámos (c) duas transações. Ainda não
foram reconciliadas, mas verificámos duas transações, pelo que foram marcadas como confirmadas. Se
olhar para a barra de sumário ao fundo do diário de conta, verá um sumário do que foi reconciliado e do
que foi confirmado (Confirmado: 954.79€ Reconciliado: 0.00€)
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A conta à ordem após ter adiado a reconciliação.

Transações agendadas
As transações agendadas são criadas para ajudara a inserir operações monetárias repetitivas, como subs-
crições, seguros ou impostos. Usando transações agendadas, só tem de inserir a transação uma vez, definir
alguns parâmetros, como data inicial e frequência, fazer uma breve descrição e depois o GnuCash avisa
quando uma transação agendada estiver pronta para ser criada e cria-a por si.

Neste Como fazer, vamos exemplificar com uma subscrição na Internet com o valor de 20€, paga a 29
de cada mês.

No GnuCash, há duas maneiras de criar transações agendadas, a partir do diário ou no Editor de transações
agendadas.

Criar a partir do diário

Insira a primeira ocorrência da transação a agendar no diário. No campo Transferência desta transação,
digite Despesas:Internet como mostrado na imagem seguinte.

Primeiro passo para criar a transação agendada a partir do diário

Nota

Uma vez que não criámos previamente a conta Despesas:Internet, o GnuCash pergunta-nos se
a queremos criar.

De seguida, clique com o botão direito do rato e selecione Agenda...
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Segundo passo para criar a transação agendada a partir do diário

Surge uma janela parecida com esta:

Terceiro passo para criar a transação agendada a partir do diário

Vamos preencher os valores, sabemos que a subscrição é paga a 29 de cada mês, sendo a próxima para o
mês que vem (uma vez que inserimos a deste mês manualmente) :
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Dados preenchidos numa transação agendada

Clique em Aceitar e a transação será agendada. O GnuCash memorizou esta transação e a 29 do mês que
vem abre uma janela perguntando-lhe se a deve criar (veja mais abaixo uma imagem desta janela).

Criar no Editor de transações agendadas

A outra maneira de inserir transações agendas é a partir do Editor de transações agendadas, que pode ser
mais rápida se tivermos várias transações a criar de uma só vez.

Na janela principal de contas, selecione Ações → Transações agendadas → Editor de transações agendadas
na barra de menus. Abre-se um novo separador Transações agendadas na janela atual do GnuCash, como
mostrado abaixo:
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Separador Transações agendadas vazio

Este separador contém uma lista, aqui vazia, de todas as transações agendadas. Vamos criar uma nova,
clicando em Nova na barra de ferramentas. Abre-se uma janela como a seguinte:
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Separador Visão geral da janela Editar transação agendada

Primeiro, vamos inserir um nome para esta nova transação, ao cimo da janela.

Nota

Este nome só identifica a transação na janela Editar transação agendada, nunca aparece no diário.

No painel Opções da Visão geral tem quatro opções:

Ativar Define o estado da transação agendada.

Criar automaticamente Se marcada, insere esta transação no diário sem
lhe perguntar primeiro (veja abaixo). Se neces-
sário, pode ser avisado quando a transação for
inserida, marcando a caixa Notificar-me quando
criada.

Criar antecipadamente Define com quantos dias de antecedência a tran-
sação será criada.

Lembrar antecipadamente Define com quantos dias de antecedência o
lembrete é mostrado. Pode ser usado para, por
exemplo, quando tem de pagar algo por cheque.
Um lembrete antecipado permite-lhe enviar o
cheque sem exceder o prazo.

O painel Ocorrências permite-lhe dizer ao GnuCash que esta transação agendada não dura para sempre.
Por exemplo, se está a pagar um empréstimo, pode inserir a data de fim do empréstimo ou o número de
ocorrências restantes.
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Selecione agora o separador Frequência na janela Editar transação agendada. Aqui pode definir as opções
temporais da transação.

Separador Frequência da janela Editar transação agendada

Frequência Define a frequência básica da transação, com
opções para Uma vez, Diariamente, Semanal-
mente, Quinzenalmente e Mensalmente. Nes-
te exemplo, está definida como Mensalmente.

Nota

É possível definir uma transação de
forma a que ocorra noutros interva-
los diferentes daqueles que constam
na lista Frequência, alterando a de-
finição no controlo Cada (veja abai-
xo).

Data inicial Define quando começa a transação. No exem-
plo, estaria definida para o dia 29 do mês que
vem.

Cada Esta opção permite-lhe agendar transações
em múltiplos do valor no campo Frequência.
Por exemplo, para criar uma transação que
ocorre a cada três semanas, defina Frequência
para Semanalmente e Cada para 3.
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A e exceto aos fins de semana Define o dia do mês em que a transação es-
tá agendada e controla o que o GnuCash faz
quando o dia ocorrer a um fim de semana.

Nota

Sabemos que a subscrição é paga a 29 de cada mês, portanto a Data inicial será 29 de janeiro
de 2016 (assumindo que janeiro é o mês seguinte), a Frequência será Mensalmente, será paga
mensalmente a 29 de cada mês. Dado que no nosso exemplo, a subscrição na Internet á paga
automaticamente da conta, não há necessidade de a criar antecipadamente, nem de indicar uma
data final.

Quando os elementos neste separador estiverem preenchidos, o GnuCash realça os calendários abaixo para
indicar quando é que vão ocorrer as futuras transações.

Finalmente, selecione o separador Transação modelo e insira a sua transação na parte inferior, tal como
faria no diário de conta, com a única diferença de não ter data.

Deverá agora ter uma janela como esta:

Separador Transação modelo da janela Editar transação agendada

Lembre-se de clicar no ícone Registar, para validar e inserir a transação.

Clique em Aceitar, e voltará ao separador Transações agendadas, que agora mostra um item na lista Tran-
sações:
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Transação agendada inserida

Dica

Se clicar nos calendários, abre-se um balão, que segue o rato e mostra o que está planeado para
cada dia. Para fazer desaparecer o balão, clique novamente no calendário.

Agora já pode fechar o separador Transações agendadas e gravar o seu trabalho.

Nota

O que vê abaixo é só uma ilustração e não deve ser inserido na base de dados do GnuCash nesta
altura. Para este exemplo, o diálogo abaixo surge quando a transação agendada for executada.

A partir de agora, quando o GnuCash iniciar e uma transação estiver agendada ou precisar de ser inserida,
poderá ver uma janela Desde a última execução..., sumarizando as operações com transações agendadas
(Lembrete, A criar etc.. Pode encontrar uma melhor descrição de cada opção no manual do GnuCash):
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Janela de lembretes de transações agendadas

Pode clicar na coluna Estado para alterar o estado da transação agendada, se necessário. Depois clique
em Aceitar para fechar a janela Desde a última execução... e aplicar as operações pendentes. Selecione
Cancelar para saltar a introdução das operações pendentes no diário.

Se o campo Estado foi definido como A criar, se reparar no diário da sua conta à ordem, verá que a
transação já foi criada.

Dica

Se ativar a opção Rever transações criadas ao fundo à direita na janela Desde a última execução...,
o GnuCash abre, após clicar em Aceitar, o diário de cada conta onde as transações agendadas
foram inseridas automaticamente.

Nota

Se inseriu a transação para 29 de janeiro nesta fase, por favor reverta para a última gravação do

ficheiro do GnuCash, selecionando Ficheiro → Abrir e escolhendo a gravação anterior do ficheiro
gcashdata_3 do GnuCash.

Juntar as peças
Nas secções anteriores deste capítulo foram discutidos os conceitos e a mecânica do trabalho com transa-
ções no GnuCash. Esta secção vai laborar sobre a árvore de contas inicialmente construída no capítulo
anterior, definindo saldos iniciais, adicionando transações e agendando uma transação.

Abrir o ficheiro do GnuCash
Comece por abrir o ficheiro de dados previamente gravado, gcashdata_3_vazia e grave-o como
gcashdata_4 diretamente. A janela principal deverá parecer-se com esta:
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Esta imagem mostra o ponto de partida desta secção.

Saldos iniciais

Tal como mostrado antes com a conta Ativos:Conta à ordem, os saldos iniciais numa conta são tipicamente
atribuídos a uma conta especial, chamada Capital próprio:Saldo inicial. Para começa a preencher esta
árvore de contas, comece por definir os saldos iniciais das contas. Assuma que tem 1000€ na conta de
poupanças e 500€ em dívida no cartão de crédito.

1. Abra o diário Ativos:Conta poupança. Selecione Ver no menu e certifique-se que está no modo Livro
razão básico. Terá de ver as suas transações noutros modos mais tarde, por agora vamos inserir uma
transação bãsica no modo básico predefinido.

2. No diário Ativos:Conta poupança, insira uma transação básica entre duas contas para definir o seu saldo
inicial para 1000€, transferidos da conta Capital próprio:Saldo inicial. Lembre-se, transações básicas
transferem dinheiro de uma conta origem para uma conta destino. Grave a transação (prima Enter ou
clique no ícone Enter).

3. No diário Ativos:Conta à ordem, insira uma transação básica entre duas contas para definir o seu saldo
inicial para 1000€, transferidos da conta Capital próprio:Saldo inicial.

4. No diário Passivo:Visa, insira uma transação básica entre duas contas para definir o seu saldo inicial
para 500€, transferidos da conta Capital próprio:Saldo inicial. Isto é feito inserindo os 500€ como A
crédito na conta Visa (ou Tot Decréscimo na conta Saldo inicial), uma vez que é dinheiro que pediu
emprestado. Registe a transação (prima Enter ou cliqeu no ícone Enter).

Deverá ter agora três contas com os saldos iniciais definidos, Ativos:Conta à ordem, Ativos: Conta pou-
pança, e Passivo:Visa.
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Esta imagem mostra os saldos iniciais.

Exemplos adicionais de transações

Vamos agora adicionar mais algumas transações para simular as despesas do mês. Durante o mês gastou
78€ em eletricidade, 45€ em telefone e 350€ em renda. Tudo pago com cheque. Gastou ainda 45,21€ em
mercearias, recebeu 670€ de ordenado e pagou a sua subscrição mensal na Internet. Finalmente, tem de
mover 100€ da conta poupança para a conta à ordem.

1. Abra o diário Despesas:Eletricidade e insira uma transação simples entre duas contas para pagar os 78€
da fatura de eletricidade, com a data do final do mês (no exemplo, 30-01-2016) e o número do cheque
(ex: 102). Insira uma descrição (ex: Elétrica Barata). A conta de Transferência deve ser Ativos:Conta
à ordem.

2. Abra o diário Ativos:Conta à ordem e insira uma transação simples entre duas contas para pagar os 45€
da fatura de telefone, com a data do final do mês (no exemplo, 30-01-2016) e o número do cheque (ex:
103). Insira uma descrição (ex: Telefone fixo). A conta de Transferência deve ser Despesas:Telefone.
Note que pode inserir transações de despesa tanto do lado do crédito (as contas de despesa) como do
lado do débito (as contas de ativos).

3. Abra o diário Despesas:Renda e insira uma transação simples entre duas contas para pagar os 350€ da
renda de casa, com a data do final do mês (no exemplo, 30-01-2016) e o número do cheque (ex: 104).
Insira uma descrição (ex: Renda de janeiro). A conta de Transferência deve ser Ativos:Conta à ordem.

4. Duplique esta transação, usando o botão Duplicar na barra de ferramentas. Comece por selecionar a
transação de renda atual e clique em Duplicar. Insira a data da transação algures no futuro (ex: 29 de
março) e repare na linha azul que o GnuCash usa para separar transações futuras de transações atuais.
Assim pode inserir transações antes de elas ocorrerem.

Também pode configurar uma transação agendada para pagar a renda de casa, uma vez que não se
prevêm alterações de valor num futuro próximo.

• Selecione a transação de renda atual e clique em Agenda

• Altere para Mensalmente, altere a descrição, se necessário e clique em Aceitar
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5. Para transferir dinheiro da sua conta de poupança para a conta à ordem, abra o diário Ativos:Conta
poupança e adicione uma nova transação, definindo Transferência para Ativos:Conta à ordem, com um
montante de 100€ (com data de 1 de janeiro de 2016).

6. Como mais um exemplo de transação simples, adicione outra transação para descrever a compra de
mercearias no valor de 45,21€ a 5 de janeiro de 2016. No diário da conta Ativos:Conta à ordem, defina
Transferência para Despesas:Comida.

7. Para adicionar uma transação de recebimento de ordenado, abra o diário Ativos:Conta à ordem clique
numa linha em branco e clique em Parcelas. Insira a descrição da transação na primeira linha (ex:
“Ordenado”), assim como a data. Na linha de “parcela” abaixo desta, insira o depósito nas contas Ati-
vos:Conta à ordem 670€, Despesas:Impostos:IRS 180€, Despesas:Impostos:Seguro 90€, Despesas:Im-
postos:Segurança social 60€ e por fim, o total bruto do recebimento, 1000€ como levantamento trans-
ferido da conta Receitas:Ordenado.

8. Também tem de pagar a subscrição na Internet, 20€ a cada dia 25.

Esta imagem mostra os saldos finais após definir todas as Capítulo 4, Transações do mês de janeiro de
2016.

Gravar o ficheiro
Antes de passarmos à secção de relatórios, vamos gravar o ficheiro de dados do GnuCash (gcashda-
ta_4).

Relatórios
Mas ter os dados disponíveis só no ecrã do seu computador não fará o seu contabilista feliz. Assim, o
GnuCash tem um grande número de relatórios altamente personalizáveis.
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Vamos dar uma vista de olhos ao Fluxo de caixa e ao Relatório de transações.

1. Primeiro o Fluxo de caixa para o mês de janeiro.

Selecione o relatório no menu Relatórios → Receita & Despesa → Fluxo de caixa.

Esta imagem mostra o fluxo de caixa para as Capítulo 4, Transações do mês de janeiro de 2016.

Para obter este relatório personalizado, clique com o botão direito do rato no relatório e escolha Opções
do relatório. Defina o intervalo de datas e especifique as contas que quer ver no relatório.

2. Agora vamos ver o correspondente relatorio de transações para a conta Ativos:Conta à ordem.

Selecione o relatório de transações no menu Relatórios → Relatório de transações.
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Esta imagem mostra o relatório de transações da conta à ordem durante o mês de janeiro de 2016.

3. Agora vamos alterar o relatório de transações para mostrar só as várias contas de despesa.

Esta imagem mostra o relatório de transações das contas de despesas durante o mês de janeiro de 2016.
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Capítulo 5. Livro de cheques
Este capítulo dá-lhe toda a informação específica que necessita para gerir o seu livro de cheques com o
GnuCash. Gerir o diário do seu livro de cheques é o primeiro passo para controlar as suas finanças e o
GnuCash torna-o muito mais fácil do que fazê-lo em papel.

Para começar, tal como discutido no capítulo Capítulo 4, Transações, a introdução de dados de transa-
ções comuns é praticamente feita por si no GnuCash, dada a sua funcionalidade de autopreenchimento.
O GnuCash mantém um saldo corrente para cada conta e torna fácil reconciliar estas contas. E o método
de dupla entrada ajuda-o a contabilizar os gastos, por requerer sempre uma conta de transferência para os
levantamentos, pelo que pode sempre encontrar facilmente quanto dinheiro gasta em diferentes áreas.

Uma vez que se sinta confortável a usar o GnuCash com a sua conta à ordem e as outras contas, quererá
progredir e controlar também outras contas financeiras. Os capítulos Capítulo 6, Cartões de crédito a
Capítulo 9, Ganhos de capital examinam métodos para gestão de outras contas.

Configurar as contas
O primeiro passo na gestão do seu livro de cheques é configurar as contas necessárias. Tanto pode usar as
contas predefinidas do GnuCash como configurar as suas próprias contas.. Para mais detalhes sobre como
configurar uma nova conta, veja “As contas básicas de topo”. Para instruções sobre importação de contas
de outro programa, consulte o manual do GnuCash.

Vamos começar com as contas bancárias que necessita. Precisa de uma conta do GnuCash de tipo Banco
para cada conta física que tenha nos seus bancos. Seja para as contas predefinidas do GnuCash, seja para
contas configuradas por si, certifique-se que tem à mão um extrato com o saldo atual das contas físicas.
Pode inserir este valor na janela de informação de conta, como parte do assistente de Configuração de
nova hierarquia de contas, ou pode inserir uma transação manual diretamente na conta. Para o fazer ma-
nualmente, insira uma transferência a partir da conta Saldo inicial (tipo Capital próprio).

As contas bancárias típicas que pode querer controlar incluem:

• Conta à ordem - qualquer conta à ordem institucional que ofereça privilégios para passar cheques, usar
o multibanco, etc..

• Conta poupança - qualquer conta institucional que ofereça juros, geralmente usada para manter dinheiro
por um prazo mais ou menos longo.

As transações mais comuns que afetam estas contas bancárias são pagamentos e depósitos. Pagamentos
são transferências de dinheiro para fora da conta bancária, habitualmente para uma conta de despesa.
Depósitos são transferências de dinheiro para dentro da conta bancária, habitualmente vindos de uma conta
de receitas. Tem de configurar contas de receita e despesa para poder controlar de onde vem o seu dinheiro
e para onde ele vai.Lembre-se que uma transação saldada requer a transferência de igual soma de dinheiro
de pelo menos uma conta para pelo menos outra conta. Assim, se depositar dinheiro na sua conta à ordem,
também terá de inserir a conta de onde o dinheiro veio. Se pagar uma despesa a partir da sua conta à ordem,
terá de inserir a conta para onde o dinheiro foi.

Inserir depósitos
A maioria das transações de depósito são inseridas como transferência de uma conta de receita para uma
conta bancária. A receita pode ter muitas origens e é sempre boa ideia configurar uma conta de receitas
para cada uma delas. Por exemplo, a sua receita pode vir maioritariamente do seu ordenado, mas também
pode receber juros das suas poupanças. Nesse caso, deve ter uma conta de receita para o ordenado e outra
para os juros.
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Dica

Certifique-se que marca a caixa Relativa a impostos e atribui o formulário e código apropriados

no diálogo Informação de impostos (Editar → Opções do relatório Impostos) quando configura
contas de receita coletáveis. Alguns tipos de receita. tais como ofertas, podem não ser considera-
das coletáveis, portanto verifique as regras fiscais apropriadas para determinar o que não faz parte
da coleta. Para formas de controlar ganhos de capital, consulte Capítulo 9, Ganhos de capital.

Nota

Para atribuir códigos de formulários de impostos a contas do GnuCash, sugerimos que consulte
um contabilista profissional. Os códigos predefinidos e o relatório Impostos ainda só são válidos
para os EUA.

Antes de começar a inserir depósitos de cheques de ordenado, decida o nível de detalhe que quer controlar.
O nível básico de detalhe é inserir o valor líquido, tal como faria em papel. Este é o mais fácil, mas com o
GnuCash consegue obter muito mais informação se inserir o valor bruto e os descontos. Exige um pouco
mais de esforço ao inserir as transações, mas controlar as suas deduções para impostos ao longo do ano
permite-lhe executar úteis relatórios do GnuCash sobre o estado dos seus impostos. Estes relatórios podem
ajudá-lo a determinar a sua declaração de impostos antecipadamente. Se não tem a certeza do nível de
detalhe, comece por inserir o valor líquido. Pode sempre voltar atrás e editar as suas transações mais tarde,
se decidir aumentar o nível de detalhe.

Inserir levantamentos
Quando levanta dinheiro da sua conta bancária, seja porque razão for, está a transferir dinheiro da sua
conta bancária para qualquer outra localização. No GnuCash, esta outra localização é controlada como
uma conta. Quanto mais contas detalhadas criar e usar para os seus gastos, mais informação obtém sobre
a maneira como gasta o seu dinheiro.

Os levantamentos assumem várias formas. Os levantamentos ATM são uma das transações mais comuns.
Passar cheques é outra forma de levantar dinheiro para pagar despesas, fazer compras ou doar para carida-
de. Dependendo do seu banco, pode também ter taxas de serviço, em que o próprio banco levanta dinheiro
da sua conta. Transferências de dinheiro para outra conta também são levantamentos. Vamos ver cada um
destes tipos de levantamento e como registá-los no GnuCash.

Levantamentos ATM/Balcão
Os levantamentos de dinheiro são geridos como uma transferência de uma conta bancária para uma conta
de dinheiro. O GnuCash oferece contas especiais de tipo Dinheiro para controlar as suas despesas em
dinheiro, pelo que deve configurar pelo menos uma conta deste tipo para registar os levantamentos no
multibanco ou ao balcão do banco.

As contas Dinheiro podem ser usadas para diferentes níveis de detalhe. Num nível básico, limitamo-nos a
transferir dinheiro da conta bancária para a conta Dinheiro. Isto diz-lhe que tirou dinheiro do banco num
determinado dia, mas não lhe diz para onde esse dinheiro foi. Com um bocadinho mais de esforço, pode
usar a conta de dinheiro para também controlar as suas compras em dinheiro, para que possa ver para onde
foi o seu dinheiro. Registe estas despesas como transferências da conta Dinheiro para contas de despesa.

Algumas pessoas registam todas as despesas em dinheiro, mas isto exige muito trabalho. Uma forma
simples é registar as suas compras que tenham recibos, mas depois terá de ajustar o saldo aquilo que tem
na carteira.
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É sempre boa ideia configurar uma conta Dinheiro para controlar os seus levantamentos. Depois, se decidir
controlar para onde vai o seu dinheiro, pode inserir transações para o dinheiro gasto. A escolha do nível
de detalhe é sua.

Reconciliar as suas contas
O GnuCash torna a reconciliação das suas contas Banco com o seu extrato mensal muito fácil. A secção
“Reconciliação” dá-lhe instruções sobre como reconciliar as suas transações com o extrato bancário men-
sal. Esta é a tarefa de reconciliação principal, que deve ser feita pelo menos uma vez por mês.

Mas e o que se passa com todas as outras contas que criou? Também devem ser reconciliadas? Se recebe
um extrato dessas contas, deve pensar em as reconciliar. Exemplos incluem o extrato da conta à ordem,
o extrato da conta poupança e o extrato do cartão de crédito. Este último, assim como as transações com
cartões de crédito, são explicados em Capítulo 6, Cartões de crédito, portanto, se está interessado em
controlar os seus cartões de crédito com o GnuCash, siga as instruções ali fornecidas.

As contas de receita e despesa, habitualmente não são reconciliadas, porque não há extrato para compa-
ração. Também não precisa de reconciliar contas Dinheiro, pelo mesmo motivo. No entanto, com uma
conta Dinheiro, poderá querer ajustar o saldo de vez em quando, para que o dinheiro que realmente tem
na carteira corresponda ao saldo da conta no GnuCash. Ajustar saldos é coberto na secção seguinte.

Juntar as peças
No capítulo Capítulo 4, Transações, inseriu algumas transações na sua conta à ordem. Neste capítulo,
vamos acrescentar mais algumas e depois reconciliá-las.

Saldos iniciais

Então, vamos começar por abrir o ficheiro que gravou no último capítulo (gcashdata_4). A sua árvore
de contas deve parecer-se com esta:

Esta imagem mostra a árvore de contas.
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Adicione algumas transações

1. Abra o diário da Conta à ordem. No último capítulo, inseriu algumas transações de recebimento do
ordenado como depósitos na conta à ordem. Agora vamos inserir outro tipo de depósito - uma trans-
ferência da conta de poupanças para a conta à ordem. Numa linha em branco, insira uma transação
para transferir 500€ da Conta poupança para a Conta à ordem (neste caso, a última data de transação
foi a 30 de janeiro de 2016, mas esta transferência ocorreu a 6 de janeiro de 2016). A sua conta de
transferência é Conta poupança, uma vez que está no diário da Conta à ordem. A Conta à ordem deve
estar parecida com isto:

Esta imagem mostra o diário da conta à ordem.

2. Agora vamos passar alguns cheques sobre esta conta. Primeiro passe um cheque a Hipermercado da
avenida, no valor de 75€ com data de 5 de janeiro. A sua conta de transferência é Comida, dado que
todo este dinheiro serviu para comprar mercearias. A seguir, passe outro cheque, desta vez a Drogaria
ABC, no valor de 100€ com data de 6 de janeiro. Divida este montante entre as contas Higiene (50€) e
Ferramentas (50€). Precisará de criar estas duas contas de Despesa. A sua conta deverá agora parecer-se
com a figura abaixo:

Esta imagem mostra o diário da conta à ordem após registar mais alguns cheques.

3. Suponha que agora precisa de levantar dinheiro e não tem uma conta Dinheiro configurada na sua #vore
de contas. Terá de criar uma. Crie a conta Dinheiro como conta de topo de tipo Ativo. A partir do
diário da Conta à ordem, insira um levantamento ATM para transferir 100€ para a conta Dinheiro a
25 de janeiro.
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Esta imagem mostra o diário da conta à ordem após registar um levantamento ATM.

Saldos iniciais

Agora estamos prontos para reconciliar a Conta à ordem, usando este simples extrato bancário:

Esta imagem mostra um exemplo de extrato bancário.

1. Selecione Ações → Reconciliar no menu, e preencha o saldo final como 1.415,79€. Clique em Aceitar
para começar a reconciliar a conta. Marque as entradas tal como aparecem no exemplo de extrato.
Quando as tiver marcado todas, a janela de reconciliação deverá parecer-se com esta:

Esta imagem mostra a janela de reconciliação com uma diferença de 5€.

Repare que há uma diferença de 5€ entre o saldo reconciliado e o seu saldo final. Se olhar para o extrato
bancário, verá que há uma taxa de serviço no valor de 5€ que não foi adicionada à sua Conta à ordem.

2. Clique no diário da Conta à ordem e adicione os 5€ da taxa de serviço. Numa linha em branco do
diário, insira uma transação para transferir 5€ da Conta à ordem para uma conta Taxas de serviço (terá
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de criar esta conta como tipo Despesas). Use a data impressa no extrato. Deverá ter a Conta à ordem
semelhante a esta figura:

Esta imagem mostra o diário da conta à ordem com a taxa de serviço adicionada.

3. Volte à janela Reconciliar e verá a taxa de serviço agora já sob Fundos saídos. Marque-a como recon-
ciliada e note que a diferença é agora 0,0. Clique em Terminar na barra de ferramentas para completar
a reconciliação. A coluna R no diário da Conta à ordem deve mostrar agora r para cada transação que
acabou de reconciliar. Observe também a linha de estado, que agora indica Reconciliado: 1451.79€

Esta imagem mostra o diário da conta à ordem reconciliada.

Gravar o ficheiro
Grave o ficheiro com o nome gcashdata_5. Volte ao separador Contas. A sua árvore está a crescer
consistentemente e deve agora ser parecida com esta:
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A árvore de contas.

Relatórios

Tal como fizémos no capítulo anterior, vamos ver o Fluxo de caixa e um relatório de transações.

1. Primeiro vamos ver o fluxo de caixa do mês de janeiro.

Selecione este relatório em Relatórios → Receita & Despesa → Fluxo de caixa.

Esta imagem mostra o fluxo de caixa para o mês de janeiro de 2016 após o capítulo Capítulo 5, Livro
de cheques.

2. Vamos agora ver o relatório de transações correspondente para as contas de ativos.

Selecione o relatório em Relatórios → Relatório de transações.
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Esta imagem mostra o relatório de transações para as contas de ativos durante o mês de janeiro de 2016.

3. Agora, altere o relatório para mostrar só as contas de Despesas.
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Esta imagem mostra o relatório de transações para as contas de despesa durante o mês de janeiro de
2016.

Note que ainda não usou uma das contas listadas na sua árvore, a conta Cartão de crédito. Agora que já
sabe controlar as suas contas Banco e Dinheiro com o GnuCash, vai querer começar a controlar o seu
cartão de crédito também. O GnuCash oferece um tipo de conta especial para cartões de crédito, que é
discutido no próximo capítulo.
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Capítulo 6. Cartões de crédito
Neste capítulo vamos mostrar-lhe como gerir os seus cartões de crédito usando o GnuCash.

Conceitos
Dado que muito provavelmente passa um cheque ou faz um pagamento eletrónico à companhia do cartão
de crédito uma vez por mês, poderá pensar no cartão de crédito como sendo uma despesa - mas na realidade
não o é. Porquê? Um cartão de crédito é um empréstimo a curto prazo, permite comprar coisas nessa conta
de empréstimo e depois terá de pagar esse dinheiro, muitas vezes com juros (a sua taxa financeira). As
compras que faz com o cartão de crédito é que são as despesas.

Tem algumas opções disponíveis quando insere transações com cartões de crédito, portanto escolha aquela
que mais se adequar ao nível de detalhe desejado. O método mais simples é controlar simplesmente o
pagamento mensal à companhia do cartão. A partir da sua conta à ordem, faz uma transferência mensal de
dinheiro para a conta de despesa do cartão de crédito. Isto mostra-lhe a quantidade de dinheiro que paga por
mês à companhia do cartão, mas não lhe mostra informação sobre o saldo do cartão ou compras a crédito.

Uma maneira mais completa de controlar os seus cartões de crédito no GnuCash é inserir cada compra e
cada pagamento como uma transação separada. Usando o diário da conta do cartão de crédito, insere os
recibos ao longo do mês. Quando chegar o extrato do cartão, faz a reconciliação da conta com o extrato e
insere uma transferência da conta à ordem para a conta cartão. Este método dá-lhe mais informação sobre
o seu saldo e evidencia discrepâncias durante a reconciliação, mas tem mais dados para inserir.

Configurar as contas
Para começar a gerir os seus cartões de crédito no GnuCash, deve configurar uma conta de topo de tipo
Passivo e, sob esta conta-mãe, criar as contas de tipo Cartão de crédito que usa. Se só está a controlar os
pagamentos que faz à companhia, só precisa de uma conta à ordem e uma conta de cartão de crédito para
inserir as suas transações.

As compras que faz com o cartão de crédito são despesas, logo, terá de configurar estas contas sob a conta
de topo de tipo Despesa. Se decidir manter um registo mais detalhado das suas compras, terá de criar contas
de despesa para cada tipo de compra que faça. Uma vez que também irá reconciliar o saldo da conta com o
extrato do cartão, também deve inserir um saldo inicial em cada conta Cartão de crédito. A maneira mais
fácil de o fazer é usar o último extrato como saldo inicial.

Configuração simples

Se não quer controlar cada despesa feita com o cartão de crédito, pode configurar um plano de contas
simples, como este:

-Ativos
   -Banco
-Passivo
   -Cartão de crédito
-Despesas
   -Cartão de crédito
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Neste exemplo, insere o montante total gasto com o cartão por mês como uma transação entre Passi-
vo:Cartão de crédito e Despesas:Cartão de crédito. Quando fizer um pagamento, insere uma transação
entre Ativos:Banco e Passivo:Cartão de crédito.

A limitação óbvia desta configuração simplista de cartões de crédito é que não consegue ver para onde
vai o dinheiro. Todas as compras com o cartão são inseridas numa mesma conta de despesa. No entanto,
é muito simples configurar e manter este tipo de controlo.

Configuração completa

Se quer controlar as suas despesas com mais rigor, deve configurar múltiplas contas de despesa, nomeadas
a partir do tipo de despesa que tem. Cada compra feita com o cartão de crédito é então inserida como
uma transação separada entre a conta do passivo e uma conta de despesa específica. Abaixo encontra um
exemplo de plano de contas deste tipo:

-Ativos
    -Banco
-Passivo
    -Cartão de crédito
-Despesas
    -Comida
    -Carro
    -Roupas
    -Lazer
    -Juros
    -Taxas de serviço
   

Claramente, deve criar contas de despesa que se adequem aos seus hábitos de consumo. A única diferença
entre esta configuração e a outra mais simples, é que as despesas foram divididas em grupos. Note ainda
que há uma despesa de tipo “Juros”, usada quando o seu cartão de crédito lhe cobra juros por saldo não
liquidado. A conta “Taxa de serviço” usada para controlar despesas de serviço associadas com o cartão de
crédito, por exemplo, o custo anual do cartão, se existir. Com esta configuração, poderá ver para onde vai
o seu dinheiro todos os meses, agrupado de acordo com as suas contas de despesa.

No resto deste capítulo, vamos assumir que usa a configuração completa.

Inserir compras
Inserir as suas compras oferece-lhe um quadro mais completo dos seus hábitos de consumo. As compras
com um cartão de crédito são controladas como transações entre a conta cartão do passivo e as contas.

Quando paga bens ou serviços com o seu cartão de crédito, está a dizer à companhia do cartão de crédito
que faça o pagamento por si. Esta transação aumenta o montante de dinheiro que deve à companhia do
cartão de crédito e o saldo do cartão de crédito aumenta. O outro lado destas transação será, na maioria
dos casos, uma conta de despesa. Por exemplo, se comprar roupa numa loja com o cartão de crédito por
50€, estará a transferir dinheiro da conta do cartão de crédito para a conta Despesas:Roupas.

Inserir estas transações no GnuCash permite-lhe controlar quanto é que deve à companhia do cartão de
crédito, assim como lhe oferece uma melhor visão geral das suas contas. Também lhe permite monitorizar
a sua conta e garantir que evita fraudes.
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Adicionar transações a uma conta de cartão de crédito é semelhante a fazê-lo em qualquer outra conta.
Pode inseri-las manualmente, ou importá-las da companhia do cartão, usando um formato de importação
compatível.

Para assistência na introdução de transações, por favor consulte o capítulo 6 do manual de ajuda e também
o capítulo sobre Capítulo 4, Transações.

Inserir pagamentos
A maioria dos pagamentos à companhia do cartão de crédito são inseridos sob a forma de transações entre
uma conta bancária (ativo) e uma conta de cartão de crédito (passivo). Quando paga a quantia mensal, está
a levantar dinheiro de uma conta bancária para liquidar o saldo do cartão. Esta transação diminui tanto o
saldo da conta bancária como o montante da dívida no cartão de crédito.

Quando devolve uma compra, recebe um reembolso no seu cartão de crédito. Este é outro tipo de paga-
mento que diminui o montante em dívida no cartão de crédito. Se registou a transação de compra original
como transferência do cartão de crédito para uma conta de despesa, terá simplesmente de reverter a tran-
sação: transfira o dinheiro da conta de despesa de volta para a conta cartão. Esta transação diminui tanto o
saldo da conta de despesa como o do cartão de crédito. Por exemplo, se gravou originalmente uma compra
de roupa com o cartão de crédito, a transação é uma transferência do cartão de crédito para a conta de
despesa. Se entretanto devolveu a roupa e recebeu um reembolso, volte a transferir o dinheiro da conta
de despesa para a conta cartão.

Nota

Um erro comum é inserir um reembolso como receita. Não é uma receita, mas simplesmente uma
“despesa negativa”. É por isso que tem de transferir o dinheiro da sua conta de despesa para a sua
conta do cartão de crédito quando recebe um reembolso.

Para clarificar isto, vamos criar um exemplo. Comprou algumas calças por 74,99€ com o seu cartão Visa,
mas depois de as experimentar, verificou que são muito grandes e tem de as devolver. A lojista aceita
graciosamente a devolução e reembolsa o seu cartão.

1. Comece por abrir o ficheiro gravado anterior, (gcashdata_5), e grave-o como gcashdata_6.

2. Abra o diário Passivo:Visa e insira uma transação simples entre duas contas para pagar os 74.99€ em
calças. A conta de Transferência deve ser Despesas:Roupa e vai creditar a sua conta Visa em 74.99€.

Nota

Dado que ainda não tínhamos criado a contaDespesas:Roupa, o GnuCash pede-nos que o
façamos. Lembre-se só de a criar como conta de Despesas.

3. Insira o reembolso de uma das seguintes formas:

• insira a mesma transação que a transação de compra, mas em vez de um montante de “crédito”, use
um montante de “Pagamento” no diário do cartão de crédito;

• selecione a transação de compra que quer reembolsar (ou seja, a compra das calças, neste caso) e

selecione Transação → Adicionar transação reversa. Modifique a data como for necessário.

Após reverter a transação, a sua conta do cartão de crédito deverá parecer-se com isto:
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Esta imagem mostra um diário de conta Passivo:Cartão de crédito após reverter uma transação de
compra.

E o diário Despesas:Roupas deve parecer-se com isto:

Esta imagem mostra um diário de conta Despesas:Roupa após reverter uma transação de compra.

4. Grave o ficheiro do GnuCash.

Juntar as peças
Agora que cobrimos as ideias básicas por trás das várias transações que tem de fazer para controlar efi-
cazmente o seu cartão de crédito no GnuCash, vamos ver outro exemplo. Aqui, vamos fazer compras com
o cartão de crédito, reembolsos de duas dessas compras, pagar juros sobre saldo não liquidado, reconciliar
a conta cartão e finalmente, fazer um pagamento parcial do cartão de crédito.

Abra o ficheiro do GnuCash

Comece por abrir o ficheiro gcashdata_5 e grave-o como gcashdata_6 diretamente. A janela prin-
cipal deve parecer-se com esta:
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Árvore de contas inicial para controlar um cartão de crédito no exemplo Juntar as peças.

Compras
Vamos fazer compras com o cartão Visa. Comece por comprar comida no valor de 25€ no Café Gorduroso,
100€ de roupa na Modista da moda, 25€ de gasolina na Rodinhas, 125€ em mercearias e detergentes no
Hipermercado da avenida (divida a compra em 85€ em mercearias e 40€ em detergentes) e, finalmente,
60€ em ferragens na Drogaria ABC.

Também refazemos o exercício da secção anterior, com a compra de calças por 74,99€ e respetivo reem-
bolso dois dias depois.

O diário para a conta do passivo do cartão de crédito deve parecer-se com isto:

Compras iniciais com o cartão de crédito.

Reembolso
Agora suponha que a 15 de fevereiro devolveu as roupas que comprou na Modista da moda a 11 de fevereiro
e que a loja devolveu o dinheiro ao seu cartão de crédito. Insira uma transação para reembolso no cartão
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de crédito no valor total de 100€. Lembre-se de usar a mesma conta de transferência que usou antes para a
compra original e insira o montante na coluna pagamento. O GnuCash completa automaticamente o nome
e a conta de transferência por si, mas também insere os 100€ automaticamente na coluna de crédito. Tem
de reinserir este valor na coluna de pagamentos. A transação parece-se com isto:

Devolução de roupa à modista da moda, reembolso no cartão de crédito.

Crédito de juros

Após o mês de gastos, infelizmente chega a conta do cartão de crédito, por correio ou por a Internet.
Foram-lhe cobrados 20€ em juros no último dia de fevereiro por causa do saldo do mês anterior. Isto é
inserido no diário do cartão de crédito como uma despesa.

Cobrança de juros.

Reconciliação

Quando o extrato do seu cartão de crédito chega, deve reconciliar a sua conta com este documento. Isto
é feito usando a aplicação interna do GnuCash. Ponha a conta do cartão de crédito em foco e vá a Ações

→ Reconciliar.... Este processo de reconciliação é descrito com detalhe em “Reconciliação”, mas vamos
passar pelo processo aqui também. Para este exemplo, vamos assumir que o extrato do cartão de crédito está
datado de 1 de março, com um saldo final de 455€. Insira estes valores na janela inicial de reconciliação.
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Janela inicial de reconciliação da conta.

Durante o processo de reconciliação, marque cada transação na conta para confirmar que elas aparecem
tanto na conta do GnuCash, como no extrato do cartão de crédito. Neste exemplo, há uma diferença de
300€ entre a sua conta no GnuCash e o extrato do cartão de crédito.

Janela principal de reconciliação de conta, demonstrando uma discrepância de 300€.

Com alguma investigação, descobre que se esqueceu de registar um pagamento que fez a 5 de fevereiro
à companhia do cartão de crédito, no valor de 300€, tem de inserir esta transação de pagamento da sua
conta à ordem para a conta cartão. Agora o extrato do cartão de crédito e a sua conta no GnuCash podem
ser reconciliadas com um saldo de 455€.

Pagamento

Assumindo que completou a reconciliação da sua conta de cartão de crédito, tem de fazer um pagamento à
companhia do cartão de crédito. Neste exemplo, devemos 455€, mas só vamos fazer um pagamento parcial
de 300€ este mês. Para tal, insira uma transação da sua conta à ordem para a conta cartão, no valor de

80



Cartões de crédito

300€, o que deverá reduzir o saldo do seu cartão para 155€. O seu diário da conta cartão deverá agora
parecer-se com isto:

Diário de conta após reconciliação e pagamento.

Volte à janela principal e grave o seu ficheiro como (gcashdata_6). A sua árvore de contas continua
a crescer consistentemente e deve agora parecer-se com esta:

Árvore de contas do GnuCash após reconciliação e pagamento do cartão de crédito.

Gravar o ficheiro
Por último, grave o o ficheiro de dados do GnuCash (gcashdata_6).

Relatórios
Tal como nos capítulos anteriores, vamos ver o Fluxo de caixa e um Relatório de transações.
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1. Comecemos pelo Fluxo de caixa para a conta do passivo Visa durante o mês de fevereiro.

Selecione o relatório em Relatórios → Receita & Despesa → Fluxo de caixa.

Esta imagem mostra o fluxo de caixa para o mês de fevereiro após o capítulo Capítulo 6, Cartões de
crédito.

2. Agora vejamos o correspondente relatório de transações.

Selecione o relatório em Relatórios → Relatório de transações.
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Esta imagem mostra o relatório de transações para a conta Visa durante fevereiro/março.

3. Vamos alterar o relatório de transações para mostrar só as contas de despesa.
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Esta imagem mostra o relatório de transações para o mês de fevereiro.
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Capítulo 7. Empréstimos
Este capítulo explica-lhe como gerir os seus empréstimos com o GnuCash.

Conceitos básicos
Um empréstimo é definido como uma transação financeira na qual alguém paga pela utilização do dinheiro
de outrém. Há muitos exemplos familiares de empréstimos: cartões de crédito, crédito à habitação, crédito
automóvel ou uma linha de crédito empresarial.

Terminologia
Antes de discutirmos o controlo de empréstimos no GnuCash especificamente, será útil apresentar um
glossário de terminologia. Os termos aqui apresentados representam alguns dos conceitos básicos encon-
trados no que diz respeito a empréstimos. É boa ideia familiarizar-se com estes termos, ou pelo menos
voltar a esta lista se encontrar alguma palavra pouco familiar nas secções seguintes.

• Amortização - o plano de pagamentos que assegura que um empréstimo acaba eventualmente por ser
pago, tipicamente usando pagamentos mensais de igual valor. Estes pagamentos são habitualmente di-
vididos entre juros e capital amortizado, onde o montante do capital amortizado por pagamento aumenta
(e os juros diminuem) à medida que o período de amortização encurta.

• Mutuário - a pessoa ou companhia que recebe dinheiro emprestado.

• Garantia - quando o mutuário falha o pagamento do empréstimo de acordo com os termos acordados
com o mutuante.

• Adiamento - um atraso temporário no pagamento de um empréstimo.

• Delinquência - o termo que se refere a pagamentos em atraso.

• Desembolso - montante do empréstimo pago ao mutuário. Alguns empréstimos têm várias tranches,
significando que o mutuário não recebe o total do empréstimo de uma só vez.

• Juro - a despesa cobrada pelo mutuante ao mutuário pelo uso do dinheiro emprestado. Tipicamente
expresso em termos de uma percentagem anual sobre o capital emprestado, conhecida por Taxa anual
de juros ou TAJ.

• Mutuante - a companhia ou pessoa que empresta dinheiro a um mutuário.

• Taxa de empréstimo - uma taxa administrativa, removida do capital na altura em que o mutuário recebe
o empréstimo.

• Capital - o montante original do empréstimo, ou o montante original do empréstimo que ainda é devido.
Quando faz um pagamento mensal de um empréstimo, parte do dinheiro é para juros e parte é para o
capital.

• Contrato - o acordo legal entre mutuário e mutuante com respeito ao empréstimo.

Configurar as contas
Quando um mutuário obtém um empréstimo, é habitualmente com a intenção de comprar qualquer coisa
de valor. De fato, a maioria dos empréstimos são concedidos para que o mutuário compre um ativo pré-
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determinado, tal como uma casa. Este ativo é normalmente a garantia quando o mutuário falha o pagamento
do empréstimo. Claro que há exemplos de empréstimos que não têm forçosamente associado um ativo de
grande valor, tal como os créditos para educação.

Para a árvore de contas aqui apresentada, vamos assumir que o empréstimo foi contraído para comprar
um ativo compensador.

Um empréstimo é um passivo, os juros que acumula do empréstimo são uma despesa corrente e as taxas
administrativas que possa ter de pagar são outra despesa. O objeto comprado com o dinheiro do emprés-
timo é um ativo. Com estes parâmetros, podemos agora criar uma estrutura básica de contas para um em-
préstimo:

Estrutura básica de contas para um empréstimo

-Ativo
    -Ativos
        -Conta poupança
    -Ativos fixos
        -Ativo comprado
-Passivo
   -Empréstimos
       -Crédito à habitação
-Despesas
   -Juros
       -Juros do empréstimo
   -Taxas administrativas
  

O GnuCash tem um grande número de árvores de contas predefinidas para empréstimos disponível, in-
cluindo crédito automóvel e crédito à habitação. Para aceder a estas árvores predefinidas, clique em Ações

→ Nova hierarquia de contas... e selecione os tipos de empréstimo em que está interessado.

Cálculos
Determinar os prazos de amortização de um empréstimo, os montantes de pagamento periódico, o valor
total de pagamentos, ou as taxas de juro pode ser algo complexo. Para facilitar este tipo de cálculos, o
GnuCash tem uma Calculadora de amortização de empréstimos interna. Para aceder à calculadora, vá a

Ferramentas → Calculadora de amortização de empréstimos.
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A calculadora de amortização de empréstimos do GnuCash.

A calculadora de amortização de empréstimos pode ser usada para calcular qualquer um dos parâmetros
Períodos de pagamento, Taxa de juro, Valor atual, Pagamento periódico, ou Valor futuro, desde que os
outros quatro estejam definidos. Também terá de especificar a composição e os métodos de pagamento.

• Períodos de pagamento - o número de períodos de pagamento.

• Taxa de juro - a taxa de juro nominal do empréstimo, i.e., a taxa de juro anual.

• Valor presente - o valor presente do empréstimo, i.e., o valor atual em dívida.

• Pagamento periódico - o montante a pagar por cada período.

• Valor futuro - o valor futuro do empréstimo, i.e., o montante em dívida após todos os pagamentos terem
terminado.

• Composição - existem dois métodos de composição de juros, discreta e contínua. Para composição
discreta, selecione a frequência de composição na lista, desde anualmente até diariamente.

• Pagamentos - a lista permite-lhe selecionar a frequência de pagamento, desde anualmente até diaria-
mente. Também pode selecionar se os seus pagamentos ocorrem no início ou no final do período. Paga-
mentos feitos no início do período de pagamento têm juros aplicados ao pagamento assim como qual-
quer dinheiro já pago ou ainda em dívida.

Exemplo: pagamentos mensais
Qual é a sua prestação mensal num empréstimo de 100.000€ com a duração de 30 anos com uma taxa fixa
de 4%, composta mensalmente?

Este cenário é mostrado na imagem exemplo acima. Para realizar este cálculo, defina os períodos de pa-
gamento para 360 (12 meses x 30 anos), a taxa de juro para 4%, o valor presente para 100.000, deixe o
pagamento periódico vazio e defina o valor futuro para 0 (não quer ficar a dever nada no final do emprés-
timo). A composição é mensal, os pagamentos são mensais e assuma que os pagamentos são feitos no
final do período e que a composição é discreta. Agora, clique em Calcular ao fundo à esquerda. Deverá
ver um pagamento periódico de -477.42€.

Resposta: tem de fazer pagamentos mensais de 477.42€.

Exemplo: duração do empréstimo
Quanto tempo leva a pagar um empréstimo de 20.000€ à taxa de juro fixa de 10% composta mensalmente,
se pagar 500€ por mês?

Para realizar este cálculo, deixe Períodos de pagamento vazio, defina Taxa de juro para 10, Valor atual
para 20.000, Pagamento periódico para -500, e Valor futuro para 0 (não quer ficar a dever nada no final
do empréstimo). A Composição é Mensalmente, os Pagamentos são Mensalmente, assuma pagamentos no
Fim do Período e Composição Discreta. Agora, clique em Calcular. Deverá ver 49 no campo Períodos
de pagamento.

Resposta: pagaria o empréstimo em 4 anos e 1 mês (49 meses).

Avançado: detalhes do cálculo
Para podermos discutir as fórmulas matemáticas usadas pela calculadora de amortização de empréstimos,
primeiro temos de definir algumas variáveis.
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 n  == número de período de pagamentos
 %i  == taxa de juro nominal aplicada, TAN
 VA  == valor atual
 PGT == pagamento periódico
 VF  == valor futuro
 FC == frequência de composição por ano
 FP == frequência de pagamento por ano

Valores normais para FC e FP são:
   1   == anual
   2   == semestral
   3   == quadrimestral
   4   == trimestral
   6   == bimensal
   12  == mensalmente
   24  == quinzenalmente
   26  == quinzenal
   52  == semanalmente
   360 == diariamente
   365 == diariamente

Converter entre taxa de juro nominal e efetiva

Quando é requerida uma solução para n, VA, PGT ou VF, a taxa de juro nominal (i) tem primeiro de
ser convertida em taxa de juro efetiva por período de pagamento (ief). Esta taxa, ief, é então usada para
calcular a variável selecionada. Qunado é requerida uma solução para i, o cálculo produz a taxa de juro
efetiva, ief. Logo, precisamos de funções para converter i em ief e ief em i.

Para converter de i em ieff,são usadas as seguintes expressões:
Juro discreto:     ief = (1 + i/FC)^(FC/FP) - 1
Juro contínuo: ief = e^(i/FP) - 1 = exp(i/FP) - 1

Para converter ief em i, São usadas as seguintes expressões:
Juro discreto:      i = FC*[(1+ief)^(FP/FP) - 1]
Juro contínuo: i = ln[(1+ief)^FP]

Nota

NOTA: nas equações abaixo para a transação financeira, todas as taxas de juro são efetivas, “ief”.

A equação financeira básica

Há uma equação que fundamentalmente, liga as cinco variáveis. É conhecida pela equação financeira
básica:

VA*(1 + ief)^n + PGT*(1 + iefX)*[(1+ief)^n - 1]/ief + VF = 0

  Onde: X = 0 para pagamentos no final do período e 
         X = 1 para pagamentos no início do período

A partir desta equação, podem ser derivadas funções resolvidas em ordem a cada variável individual. Pa-
ra uma explicação detalhada sobre a derivação desta equação, veja os comentários no ficheiro src/calcu-
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lation/fin.c, no código fonte do GnuCash. As variáveis A, B, e C são definidas primeiro, para tornar as
equações posteriores mais simples de ler.

A = (1 + ief)^n - 1
B = (1 + iefX)/ief
C = PGT*B

n = ln[(C - VF)/(C + VA)]/ln((1 + ief)
VA = -[VF + A*C]/(A + 1)
PGT = -[VF + VA*(A + 1)]/[A*B]
VF = -[VA + A*(VA + C)] 

A solução para o juro é dividida em dois casos: 
O caso mais simples para quando PGT == 0 dá a solução:
i = [VF/VA]^(1/n) - 1

O caso em que PGT != 0 é razoavelmente complexo e não será discutido aqui. Em vez de envolver uma
função exatamente resolúvel, determinar a taxa de juro quando PMT !=0 envolve um processo interativo.
Por favor, veja o ficheiro src/calculation/fin.para uma explicação detalhada.

Exemplo: pagamentos mensais

Vamos recalcular o “Exemplo: pagamentos mensais”, desta vez usando as fórmulas matemáticas em vez da
calculadora de amortização de empréstimos. Qual é o seu pagamento mensal num empréstimo de 100.000€
a 30 anos, com uma taxa fixa de 4%, composta mensalmente?

Primeiro vamos definir as variáveis: n = (30*12) = 360, VA =100000, PGT =desconhecido, VF = 0, i =
4%=4/100=0.04, FC = FP = 12, X = 0 (pagamentos no final do período).

O segundo passo é converter a taxa de juro nominal (i) para taxa de juro efetiva (ief). Uma vez que a taxa é
composta mensalmente, discreta, usamos: ief = (1 + i/FC)^(FC/FP) - 1, que dá ief = (1 + 0.04/12)^(12/12)
- 1, igual a ief = 1/300 = 0.0033333.

Agora podemos calcular A e B. A = (1 + ief)^n - 1 = (1 + 1/300)^360 - 1 = 2.313498. B = (1 + iefX)/
ief = (1 + (1/300)*0)/(1/300) = 300.

Com A e B, podemos calcular PGT. PGT = -[VF + VA*(A + 1)]/[A*B] = -[0 + 100000*(2.313498 + 1)] /
[2.313498 * 300] = -331349.8 / 694.0494 = -477.415296 = -477.42.

Resposta: tem de fazer pagamentos mensais de 477.42€.

Como fazer - crédito à habitação
Um crédito à habitação (hipoteca) pode ser configurado usando a árvore de contas preparada em “Confi-
gurar as contas”.

Como exemplo, assuma que tem 60.000€ na sua conta poupança e que compra uma casa de 150.000€. A
hipoteca cobra-lhe uma taxa anual (TAN) de 6% e tem taxas administrativas (custos de fecho, etc.) de 3%.
Decide avançar com 50.000€. Logo, tem de pedir 103.000€ emprestados, que lhe deixa 100.000€ limpos
após pagar as taxas administrativas (3% dos 100.000€).

As suas contas antes de receber o empréstimo:
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Contas antes de receber o empréstimo

A compra da casa é registada com uma transação com parcelas na conta Ativos:Casa, com 50.000€ vindos
do banco (i.e., a sua entrada inicial) e 100.000€ vindos da hipoteca. Pode colocar os 3.000€ de custos na
mesma parcela e aumentar o empréstimo para 103.000€ para incluir as taxas administrativas.

Tabela 7.1. Parcelas da transação de compra de uma casa

Conta Aumento Diminuição

Ativos:Ativos fixos:Casa 150.000€

Aivos:Ativos atuais:Banco 50.000€

Passivo:Empréstimos:Emprésti-
mo para habitação

103.000€

Despesas:Taxas administrativas
de empréstimos

3.000€

As parcelas seriam estas, na conta Ativos:Ativos fixos:Casa:

Parcelas da transação de compra de habitação

O que resulta numa árvore de contas como esta:
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Contas com a hipoteca

Como fazer - empréstimo pessoal a um amigo
Nem sempre se pede dinheiro emprestado ao banco, por vezes pedimos emprestado à família ou talvez
até emprestemos dinheiro a amigos. Esta secção Como fazer descreve uma forma de gerir um empréstimo
a um amigo.

Baseamos este Como fazer no seguinte plano de contas:

-Ativo
   -Banco 
        -Conta bancária
   -Dinheiro que lhe devem
        -Pessoa
-Receita
   -receita de juros
        -Pessoa
  

Este exemplo mostra-lhe como controlar um empréstimo pessoal de 2.000€ ao seu amigo José da Esquina.

Especificações do empréstimo
O José da Esquina quer um empréstimo de 2.000€ e pensa pagar-lhe mensalmente durante os 18 meses
seguintes. Dado que é seu amigo (mas não tão chegado), concordam ambos com uma taxa de juro de 5%.

Abaixo resumimos os detalhes do empréstimo:

• Capital - 2.000€

• Termo - 18 meses com 12 pagamentos por ano
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• Taxa de juro anual: 5%

• Pagamento mensal: ??

Então como é que se calcula o pagamento mensal?

Tem várias opções, tais como papel e caneta, calculadora do Linux, o módulo Calc do Apache OpenOffice,
etc.. Mas o método mais fácil é usar a calculadora de amortização de empréstimos do GnuCash. Esta dir-
lhe-á que o pagamento mensal é de 115.56€.

Mas precisa de saber quando deste valor é juro e quanto é capital, para poder fazer uma contabilização
adequada. Para tal, precisa de uma ferramenta mais poderosa, como o módulo Calc do Apache OpenOffice,
e em particular, da função PGTO.

Figura 7.1. Vista detalhada do empréstimo ao José da Esquina (no Apache Open
Office)

Vista detalhada do empréstimo ao José da Esquina (no Apache Open Office)

Contas para o empréstimo
Vamos começar com as seguintes contas (todas as contas têm a mesma moeda, neste caso, o Euro)

Ativos:Banco:Euro
Ativos:Dinheiro que me devem:José da Esquina
Receita:Receita de juros:José da Esquina
Capital próprio:Saldos iniciais:Euro
  

Emprestar o dinheiro
Quando empresta dinheiro ao seu amigo, na realidade está a movimentar dinheiro de uma conta do ativo
(Conta à ordem, Conta poupança ou semelhante) para uma conta do ativo Dinheiro que me devem. Para
registar isto, insira a transação seguinte no diário Ativos:Dinheiro que me devem:Amigo.

Tabela 7.2. Empréstimo pessoal a um amigo

Conta Aumento Diminuição

Ativos:Dinheiro que me de-
vem:Amigo

2.000€

Ativos:Banco:Euro 2.000€
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Árvore de contas após ter emprestado dinheiro

Receber o primeiro pagamento
Quando o primeiro pagamento (115,56€) for recebido, terá de determinar quanto é juro e quanto é capital.

• Montante do empréstimo em dívida neste período = 2.000€

• Pagamento por mês = 115,56€

• Divisão do pagamento

• 5%/12 * 2.000€ = 8,33€ de juros

• 115,56€ - 8,33€ = 107,23€ de capital

Isto pode ser traduzido na seguinte transação do GnuCash:

Vista detalhada do primeiro pagamento

O saldo do empréstimo do José é agora de 2.000€ - 107,23€ =1.892,77€

Receber o segundo pagamento
Quando o segundo pagamento (115,56€) for recebido, terá novamente de determinar quanto é juro e quanto
é capital.

• Montante do empréstimo em dívida neste período = 1.892,77€

• Pagamento por mês = 115,56€

• Divisão do pagamento
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• 5%/12 * 1.892,77€ = 7,89€ de juros

• 115,56€ - 7,89€ = 107,67€ de capital

Isto pode ser traduzido na seguinte transação do GnuCash

Vista detalhada do segundo pagamento

O saldo do empréstimo do José é agora de 1.892,77€ - 107,67€ =1.785,10€

A árvore de contas agora parece-se com esta:

Árvore de contas após o segundo pagamento

Como pode ver, o juro varia todos os meses, assim como o capital. Portanto, para cada pagamento que
recebe terá de calcular os montantes apropriados para as várias parcelas.

O montante dos juros será cada vez menor (uma vez que é calculado sobre um valor de capital também
menor todos os meses), até ao último pagamento, em que é aproximadamente 0. Veja Figura 7.1, “Vista
detalhada do empréstimo ao José da Esquina (no Apache Open Office)” para mais detalhes.

Como fazer - empréstimo para compra de auto-
móvel

O empréstimo para compra de automóvel, ou mais simplesmente, crédito automóvel, é tratado mais ou
menos como o crédito à habitação. A diferença está nas contas usadas e nas taxas de juro.

Estrutura básica de contas para crédito automóvel

-Ativos
    -Ativos atuais
        -Conta poupança
    -Ativos fixos
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        -Carro
-Passivo
   -Empréstimos
       -Crédito automóvel
-Despesas
   -Juros
       -Juros do crédito automóvel
   -Taxas administrativas do crédito automóvel

Para mais informação, por favor veja “Como fazer - crédito à habitação”

Como fazer - reconciliação com extratos de
empréstimos

Reconciliar um extrato de empréstimo não é diferente da reconciliação com um extrato bancário ou de
cartão de crédito.

Durante o período, deve ter registado todas as transações relacionadas com o empréstimo e cada uma
delas mexe na conta Passivo:Empréstimos:Crédito. Por exemplo, pagar um bocadinho do empréstimo
diminui a sua Conta bancária, e aumenta as contas Empréstimo, Juros do empréstimo assim como talvez
a conta Taxas administrativas do empréstimo.

Com o extrato do empréstimo na mão, abra a conta Empréstimo, inicie o assistente de reconciliação e
marque todas as transações que registou. Quando terminar, a diferença deve ser 0. Se não for, terá de
percorrer a conta e compará-la com o extrato para achar a diferença. Quando tiver obtido 0 na diferença,
tem a conta empréstimo reconciliada e pode fechar o assistente.

Para mais informação sobre reconciliação, por favor veja “Reconciliação”

Como fazer - vender uma casa ou um carro
Quando registar a venda da sua casa no GnuCash tem várias opções. Aqui vamos discutir duas delas, uma
em que só registou o montante de compra e agora só regista o montante de venda. A outra, em que seguiu
as subidas e descidas do mercado e registou vários ganhos não realizados ao longo do tempo.

Transação simples
Desta maneira, só regista o valor de venda propriamente dito.

Vamos trabalhar dois exemplos de venda de uma casa, uma com lucro e outra com prejuízo. Se preferir
vender antes um carro, substitua as contas apropriadas.

-Ativos
  -Ativos fixos
    -Casa
  -Ativos atuais
    -Conta poupança
-Receita
  -Ganho de capital a longo prazo
    -Casa
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• Comprou uma casa por 300.000€ há anos atrás e agora conseguiu vendê-la por 600.000€. Como é que
regista isto?

Para registar isto precisa de aumentar a sua conta bancária em 600.000€ e diminuir outra conta qualquer
nesse mesmo valor. A conta Casa só contém 300.000€, que é aquilo porque a comprou, portanto vai
mover este montante para a conta bancária. Mas ainda lhe faltam 300.000€. Este montante, vai buscá-lo
à conta Receita:Ganhos de capital a longo prazo:Casa. A transação com parcelas a inserir na Ativos:A-
tivos atuais:Conta poupança deve ser parecida com isto:

Tabela 7.3. Venda de um ativo (casa) com lucro

Conta Aumento Diminuição

Ativos:Ativos atuais:Conta pou-
pança

600.000€

Ativos:Ativos fixos:Casa 300.000€

Receita:Ganhos de capital a lon-
go prazo:Casa

300.000€

• Comprou uma casa por 300.000€ Há anos atrás, mas devido à criação do novo aeroporto, só a conseguiu
vender por 230.000€. Como é que regista isto?

Para registar isto precisa de aumentar a sua conta bancária em 230.000€ e diminuir outra conta qualquer
nesse mesmo valor. A conta Casa contém 300.000€, que é mais do que aquilo porque a vendeu, portanto
vamos mover este montante para a conta bancária. Após este movimento, tem 70.000€ restantes na
sua conta Casa, que têm de ser removidos. Mova-os para a conta Receita:Ganhos de capital a longo
prazo:Casa, o que indicará um prejuízo. A transação a inserir na conta Ativos:Ativos fixos:Casa será
parecida com isto:

Tabela 7.4. Venda de um ativo (casa) com prejuízo

Conta Aumento Diminuição

Ativos:Ativos fixos:Casa 300.000€

Ativos:Ativos atuais:Conta pou-
pança

230.000€

Receita:Ganhos de capital a lon-
go prazo:Casa

70.000€

Uma transação mais complexa
Neste exemplo, vamos abordar alguns princípios contabilísticos algo mais complexos. Para mais detalhes
sobre este assunto, por favor veja Capítulo 9, Ganhos de capital

Aqui só veremos o caso em estimou precisamente o valor atual da sua casa. Para outros casos, (sobre e
subestimada), por favor veja Capítulo 9, Ganhos de capital.

-Ativos
    -Ativos fixos
        -Casa
            -Custo
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            -Ganhos não realizados
    -Ativos atuais
        -Conta poupança
-Receita
    -Ganhos realizados
        -Casa
    -Ganhos não realizados
        -Casa
    

Comprou uma casa por 300.000€ há anos e manteve sempre um olho no mercado, atualizando os seus
registos com o valor atual estimado da sua casa. À data em que a quiser vender, determina que o valor
atual de mercado é 600.000€.

A diferença entre os 600.000€ (valor de mercado estimado) e os 300.000€ (valor de compra) é o valor de
Ganhos não realizados. Logo, tem um valor de 300.000€ na sua conta Ativos:Ativos fixos:Casa:Ganhos
não realizados

Como é que regista esta transação de venda?

Para registar isto tem de aumentar a sua conta bancária em 600.000€ e diminuir outra conta qualquer no
mesmo valor. Primeiro tem de transformar os ganhos não realizados em ganhos realizados na sua conta
Receitas. Por fim, tem de transferir os montantes totais das subcontas de Ativos:Ativos fixos:Casa.

A transação a inserir na sua conta Receitas:Ganhos realizados:Casa deve parecer-se com isto:

Tabela 7.5. Venda de um ativo (casa) com lucro

Conta Aumento Diminuição

Receitas:Ganhos realizados:Casa 300.000€

Receita:Ganhos não realiza-
dos:Casa

300.000€

A transação a inserir na sua conta Ativos:Ativos atuais:Conta poupança deve parecer-se com isto:

Tabela 7.6. Venda de um ativo (casa) com lucro 2

Conta Aumento Diminuição

Ativos:Ativos atuais:Conta pou-
pança

600.000€

Ativos:Ativos fixos:Casa:Custo 300.000€

Ativos:Ativos fixos:Casa:Ganhos
não realizados

300.000€

Após registar estas transações, verá que o seu ativo Casa tem um valor 0, a sua conta poupança aumentou
em 600.000€ e que a conta Receitas: Ganhos realizados aumentou em 300.000€.
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Capítulo 8. Investimentos
Este capítulo explica como gerir os seus investimentos com o GnuCash. A maioria das pessoas tem um
plano de investimento, Seja ele simplesmente pôr dinheiro numa conta a prazo, seja um plano de poupança
reforma, seja a compra e venda de ações numa corretora. O GnuCash dá-lhe ferramentas para gerir estes
investimentos, tais como o Editor de cotações, que lhe permite registar alterações nas cotações das ações
que possui.

Conceitos básicos
Um investimento é algo que compra na esperança de gerar receita, ou algo que pensa vender no futuro
por mais dinheiro que aquele que lhe custou. Usando esta definição simples, ,muitas coisas podem ser
consideradas investimentos: a casa onde vive, uma pintura valiosa, ações numa companhia cotada em
bolsa, a sua conta poupança ou um certificado de aforro. Estes tipos de investimentos serão discutidos
neste capítulo em termos da forma como podem ser controlados usando o GnuCash.

Terminologia
Antes de discutirmos investimentos especificamente, será útil apresentar um glossário de terminologia.
Os termos abaixo representam alguns dos conceitos básicos de investimento. É boa ideia familiarizar-se
com estes termos ou, pelo menos, voltar a esta lista se encontrar uma palavra pouco familiar nas secções
seguintes.

Ganhos de capital É a diferença entre os preços de compra e ven-
da de um investimento. Se o preço de venda
for inferior ao preço de compra, são chama-
dos de perdas de capital. Também conheci-
dos como Ganhos/Perdas realizados.

Comissão É a taxa que paga a um corretor para comprar
ou vender mercadorias.

Ação comum É uma mercadoria que representa a proprieda-
de de pequena fração de uma empresa. é o que
obtém quando “compra ações” de uma com-
panhia no mercado aberto. Também é conhe-
cido por capital em ações.

Composição É o conceito de que o juro reinvestido pode
mais tarde gerar juros por si próprio (juros so-
bre juros). É frequentemente referido como
juro composto.

Dividendos Dividendos são pagamentos em dinheiro que
uma empresa faz aos acionistas. O montante
deste pagamento é habitualmente determina-
do por uma fração dos lucros da empresa. No-
te que nem todas as ações comuns dão divi-
dendos.

Capitais próprios São investimentos nos quais o investidor se
torna parte (ou completamente) proprietário
de algo. Isto inclui ações comuns ou imóveis.
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Juro É o que um mutuário paga a um mutuante pelo
uso do seu dinheiro. Normalmente, é expres-
so como percentagem anual do capital. Por
exemplo, um depósito a prazo com 1% de ju-
ros (é o mutuante e o banco é o mutuário) pa-
ga-lhe 1€ por ano por cada 100€ que lá tenha.

Liquidez É a medida da facilidade com que um inves-
timento pode ser convertido em dinheiro. Di-
nheiro num depósito a prazo é muito líquido,
enquanto que dinheiro investido numa casa
tem pouca liquidez, porque leva tempo a ven-
der uma casa.

Capital É o montante original de dinheiro investido
ou emprestado.

Ganhos/Perdas realizados vs não realizados Ganhos ou perdas não realizados ocorrem
quando tem uma alteração na cotação de um
ativo. Na realidade, realiza ganhos ou perdas
quando efetivamente vende um ativo. Veja
também Ganhos/Perdas de capital.

Retorno É a receita total mais ganhos ou perdas de um
investimento. Veja também Rendimento.

Risco É a probabilidade do retorno de um investi-
mento ser diferente do esperado. Os investi-
mentos são muitas vezes agrupados por esca-
las de risco, baixo (contas poupança, títulos
do tesouro) a alto (ações comuns, fundos de
investimento). Como regra geral, quanto mai-
or for o risco, maior será o retorno.

Acionista Acionista é a pessoa que detém ações de uma
empresa.

Desdobramento de ações Ocorre quando uma empresa se oferece para
emitir múltiplos adicionais de ações existen-
tes. Por exemplo, um desdobramento “2 para
1” significa que, se detiver 100 ações, rece-
berá outras 100 adicionais sem qualquer cus-
to para si. A cotação unitária das ações será
ajustada para que não haja alteração do va-
lor líquido. Neste exemplo, a cotação por ação
passaria a metade.

Avaliação É o processo de determinação do valor de
mercado ou cotação a que o investimento se-
ria vendido dentro de um “intervalo de tempo
razoável”.

Rendimento É a medida do montante de dinheiro que ga-
nha com um investimento (ou seja, a recei-
ta do investimento). Tipicamente é reportado
como percentagem do capital. O rendimento
não inclui ganhos ou perdas de capital (veja

100



Investimentos

Retorno). Por exemplo, uma ação que se ven-
de a 100€ e dá 2€ por ano em dividendos tem
um rendimento de 2%.

Tipos de investimentos
Abaixo são mostrados os tipos gerais de investimentos disponíveis e exemplos de cada um deles.

• Conta ou instrumento remunerados

Este tipo de investimento normalmente permite acesso imediato ao seu dinheiro e costuma pagar juros
ao mês, baseados na quantia que tiver depositada. Exemplos disto são as contas poupança (e algumas
contas à ordem remuneradas) e contas em dinheiro na sua corretora. É um investimento de muito baixo
risco, nos EUA estas contas estão normalmente seguras contra perdas até um certo limite.

Por vezes, um investimento remunerado tem um prazo bloqueado. Este tipo de investimento requer
que mantenha o seu dinheiro investido por um dado período de tempo, pelo qual receberá um retorno
previamente definido. Normalmente, quanto maior for o prazo, maior serão as taxas de juro. Levan-
tar o dinheiro antes do fim do prazo normalmente acarreta penalizações. É um investimento de risco
relativamente baixo. São exemplos os certificados de depósito ou títulos do tesouro. Outros tipos de
títulos poderão ter maiores rendimentos baseados em mais altos riscos pela qualidade da “classificação
de crédito” do emissor.

• Ações e fundos de investimento

Este é um investimento que faz numa empresa, da qual se torna efetivamente proprietário parcial. Nor-
malmente não há prazos bloqueados em ações negociadas publicamente, contudo, pode haver alterações
nas taxas de impostos que paga por ganhos de capital, dependendo do tempo que mantém as ações.
Assim, as ações têm geralmente muita liquidez, pode aceder ao seu dinheiro muito rapidamente. Este
é um investimento de mais alto risco, uma vez que não tem qualquer mercadoria da cotação futura de
uma ação.

Um fundo de investimento é um mecanismo de investimento em grupo no qual pode comprar várias
ações diferentes em simultâneo. Por exemplo, um fundo "S&P 500 index fund" é um fundo que compra
todas as 500 ações listadas no índice Standard and Poor’s. Quando compra uma ação deste fundo, está
realmente a comprar uma pequena parte de cada uma das ações contidas no fundo. Fundos de investi-
mento são tratados exatamente como uma ação única, tanto em termos contabilísticos como em termos
de impostos.

• Ativos fixos

Ativos que aumentam de valor ao longo do tempo são outra forma de investimento. São exemplos uma
casa, um terreno, ou uma pintura valiosa. Neste tipo de investimento só se consegue determinar o valor
real após a venda. As implicações tributárias da venda destes itens variam, dependendo do item. Por
exemplo, pode ter benefícios fiscais se vender uma casa, se for a sua residência primária, mas isto pode
não acontecer se vender uma pintura valiosa.

Investimentos em ativos fixos são discutidos em Capítulo 9, Ganhos de capital e Capítulo 18, Depreci-
ation. Tipicamente, não há muito a fazer em termos contabilísticos com investimentos em ativos fixos
exceto registar as transações de compra e venda.

Configurar contas
Para configurar contas de investimento no GnuCash pode usar a hierarquia de contas predefinida ou criar
a sua própria. O mínimo que precisa para controlar investimentos é configurar uma conta para cada tipo de
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investimento que possui. Contudo, tal como foi visto em capítulos anteriores, é habitualmente mais lógico
criar uma estrutura de contas agrupando investimentos relacionados. Por exemplo, pode querer agrupar
todas as ações negociadas em bolsa sob uma mesma conta mãe, com o nome da corretora que usa para
comprar e vender as ações.

Nota

Independentemente de como configura a sua hierarquia de contas, lmebre-se que pode sempre
mvover as contas mais tarde (sem perder o trabalho que fez com elas), portanto, o seu plano de
contas original não precisa de ser perfeito.

Usar as contas de investimentos predefinidas
A opção Contas de investimentos do assistente Nova hierarquia de contas cria automaticamente uma hie-
rarquia de contas de investimento por si. Para aceder à hierarquia predefinida de contas de investimento,
tem de se certificar que tem um ficheiro do GnuCash aberto, mudar para o separador contas e escolher

Ações → Nova hierarquia de contas. Isto executa o assistente Nova hierarquia de contas e permite-lhe
selecionar contas adicionais à sua hierarquia. Escolha Contas de investimentos (juntamente com quaisquer
outras em que possa estar interessado). Presumindo que só selecionou as contas de investimento, criará
um plano de contas semelhante a este:

Dica

Também pode executar o assistente Nova hierarquia de contas criando um novo ficheiro do Gnu-
Cash.

Esta imagem mostra o separador Contas após criar um novo ficheiro e selecionando só as contas de in-
vestimento predefinidas.

Provavelmente quererá adicionar pelo menos uma conta Banco aos Ativos e eventualmente uma conta
Capital próprio:Saldos inicias, tal como fizémos em capítulos anteriores. Não se esqueça de gravar o seu
novo ficheiro com um nome relevante!

Criar contas de imvestimento manualmente
Se quer criar as suas próprias contas de investimento, é claro que o pode fazer. Os investimentos normal-
mente têm associado um número de contas que têm de ser criadas: uma conta de ativos para o investimeto

102



Investimentos

em si mesmo, uma conta de receita para as transações de dividendos e contas de despesa para taxas de
investimento e comissões.

Exemplo de contas personalizadas
A seguir vemos um exemplo algo mais complicado de um plano de contas personalizado no GnuCash
para controlar os seus investimentos, que tem a vantagem de agrupar cada diferente investimento sob a
corretora que os negoceia. Assim é mais fácil comparar os extratos que recebe com as suas contas no
GnuCash e detetar onde o GnuCash difere dos extratos.

 Ativos
    Investimentos
       Contas da corretora
          Eu*Negoceio
             Ações
                ACME Corp
             Fundos do mercado monetário
                Eu*Negoceio Fundo Municipal
             Dinheiro
          Meu corretor
             Fundos do mercado mobiliário
                Fundo de ativos
             Títulos do Tesouro
                Título OT xxx
                Nota OT yyy
             Fundos mutualistas
                Fundo A
                Fundo B
             Dinheiro
 Receitas
    Investimentos
       Contas da corretora
          Ganhos de capital
             Eu*Negoceio
             Meu corretor
          Dividendos
             Eu*Negoceio
                Coletável
                Não coletável
             Meu corretor
                Coletável
                Não coletável
          Receita de juros
             Eu*Negoceio
                Coletável
                Não coletável
             Meu corretor
                Coletável
                Não coletável
 Despesas
    Despesa do investimento
       Commissões
          Eu*Negoceio
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          Meu corretor
       Taxas de gestão
          Eu*Negoceio
          Meu corretor
 

Dica

Não há realmente um padrão para a forma como configura as suas contas de investimentos. Ex-
perimente, tente disposições diferentes até que encontre uma solução que divida as suas contas
de investimentos em grupos lógicos que façam sentido para si.

Contas remuneradas
Investimentos que têm uma taxa de juro fixa ou variável são uma das formas de investimento mais simples
e mais comum. Investimentos remunerados incluem a sua conta bancária, um certificado de depósito, ou
qualquer outro tipo de investimento em que receba juros sobre o seu capital. Esta secção descreve como
gerir este tipo de investimentos no GnuCash.

Configuração das contas

Quando compra o investimento remunerado, tem de criar uma conta de ativos para registar essa compra,
uma conta de receita para registar os ganhos em juros e uma conta de despesa para registar as taxas ban-
cárias. Abaixo está uma disposição exemplo de contas, na qual tem uma conta poupança remunerada e
um certificado de depósito no seu banco.

Ativos
   Banco ABC
      Certificado de depósito
      Conta poupança
Despesas
   Banco ABC
      Taxas
Receita
   Receita de juros
      Certificado de depósito
      Conta poupança
  

Como habitual, esta estrutura é mostrada como exemplo, deve criar a sua própria estrutura da forma que
melhor corresponda à sua situação real.

Exemplo

Vamos povoar estas contas com números reais. Assumindo que começa com 5.000€ na sua conta poupança,
que paga 1% de juros e que compra um certificado de depósito por 5.000€, com vencimento a seis meses e
rendimento de 2%, é claramente melhor manter o seu dinheiro no certificado de depósito do que na conta
poupança. Após a compra inicial, as suas contas deverão parecer-se com isto:
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Esta imagem mostra as suas contas após a compra de um certificado de depósito.

Agora, durante os próximos 6 meses, receberá extratos bancários que descrevem a atividade da sua conta.
No nosso exemplo, não fazemos nada com o dinheiro neste banco, portanto, a única atividade é a receita
de juros e as taxas bancárias. As taxas mensais são de 2€. Após 6 meses, os diários das contas devem ser
parecidos com estes:

Esta imagem mostra o diário de conta do certificado de depósito após 6 meses.

Esta imagem mostra o diário da conta poupança após 6 meses.

E este é o separador Contas do GnuCash:
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Esta imagem mostra o separador Contas após 6 meses.

Na imagem acima do separador Contas do GnuCash, verá um bom resumo do que aconteceu com os in-
vestimentos ao longo dos seis meses. Enquanto o rendimento do certificado é o dobro do da conta pou-
pança, o retorno do CD foi de 50,21€, enquanto o da conta poupança foi de 13,03€, ou seja, quase quatro
vezes mais. Porquê? Por causa dos incómodos 2€ de taxas bancárias na conta poupança (que representam
12€ ao longo dos seis meses).

Após este período de seis meses, o CD atingiu o seu vencimento, o que significa que o pode vender sem
qualquer penalização de levantamento antecipado. Para o fazer, simplesmente transfira os 5.050,21€ da
conta de certificadopara a conta poupança.

Configurar um portfólio de investimentos
Agora que já construiu uma hierarquia de contas na secção anterior, vamos mostrar-lhe como criar e povoar
as suas contas com o seu portfólio de investimentos. Após esta configuração do seu portfólio, poderá ter
ações compradas antes de começar a usar o GnuCash. Para estas ações, siga as instruções na secção Inserir
ações pré-existentes mais abaixo. Se acabou de comprar as suas ações, use a secção Comprar novas ações.

Configurar contas para ações e fundos de investimento
Esta secção mostra-lhe como adicionar contas de ações e fundos de investimento ao GnuCash. Aqui, vamos
assumir que está a usar a configuração básica introduzida na secção anterior, mas os princípios podem ser
aplicados a qualquer hierarquia de contas.

Deverá ter dentro da conta de topo Ativos, alguns níveis abaixo, uma conta chamada Ação. Expanda a
árvore de contas até este nível, clicando no “triângulo virado à direita” à esquerda dos nomes de conta até
que a árvore esteja expandida até à nova conta. Terá de criar uma subconta (de tipo Ação) para cada ação
que possua. Cada ação real é uma conta separada. A nomenclatura destas contas de ações é normalmente
feita de acordo com o símbolo de mercado, embora os nomes das contas possam ser qualquer coisa que
seja clara para si e outros utilizadores. Assim, por exemplo, pode chamar às suas contas AMZN, IBM e NST
para as sua ações na Amazon, na IBM e na NSTAR, respetivamente. Abaixo está o modelo esquemático
da disposição, só com as subcontas de Ativos.
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 Ativos
    Investimentos
       Contas na corretora
          Obrigação
          Fundos de investimento
          Índice de mercado
          Ação
             AMZN
             IBM
             NST
 

Nota

Se quer controlar receitas (dividendos/juro/ganhos de capital) por ação ou fundo, tem de criar
uma conta Receitas:Dividendos:SÍMBOLO, Receitas:Ganhos de capital(longo):SÍMBOLO, Re-
ceitas:Ganhos de capital(curto):SÍMBOLO e Receitas:Juros:SÍMBOLO para cada ação/fundo
que pague dividendos ou juros.

Exemplo de conta de ações

Como exemplo, vamos assumir que possui atualmente 100 ações da Amazon. Primeiro, crie a conta
AMZN, após clicar em Ações+Nova conta.... Abre-se o diálogo de novas contas, siga os passos na sequên-
cia abaixo para configurar a sua nova conta de ações.
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Janela de nova conta

1. Nome da conta - por norma, use o símbolo de mercado, neste caso: “AMZN”

2. Código de conta - campo opcional, use CUSIP, o símbolo usado nos jornais, ID da família do fundo
de investimentos ou código da sua escolha.

3. Descrição - campo opcional para descrição detalhada da mercadoria/ação. Note que este campo é mos-
trado na árvore de contas, separador Contas por predefinição.

4. Tipo de conta - selecione o tipo de conta que está a criar na lista inferior esquerda.
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5. Conta-mãe - selecione a conta-mãe da nova conta na lista inferior direita. Expanda a lista de contas,
se necessário.

6. Criar a nova mercadoria - para usar uma nova ação, tem de a criar como nova mercadoria

• Selecione Garantia/Moeda - clique em Selecione..., junto à linha Garantia/Moeda. Tem de alterar
a predefinição (a sua moeda predefinida) para esta ação específica. Isto abre o diálogo Selecione a
mercadoria.

• Tipo - altere o tipo do atual para a bolsa onde a mercadoria é negociada (neste exemplo, NASDAQ).

Clique em Novo para abrir a janela Nova mercadoria.

Diálogo Selecione a mercadoria

• Crie a mercadoria - clique em Novo e insira a informação apropriada no formulário Nova mercadoria.

• O Nome completo: é “Amazon.com”.

• O Símbolo/abreviatura: é “AMZN”. O símbolo é aquele usado na sua origem de cotações, defini-
da várias linhas abaixo neste mesmo formulário. Note que serão usados símbolos diferentes em
origens de cotação diferentes para a mesma ação. Por exemplo, Ericsson é ERIC-B na bolsa de
Estocolmo e ERRICB.ST na Yahoo

• O Tipo: já deverá estar preenchido com NASDAQ, porque foi selecionado no seletor de merca-
dorias, mas pode alterá-lo aqui, inclusive adicionando mais categorias. Há mais informação sobre
isto disponível no manual de ajuda, na secção 7.7, “Editor de mercadorias”.

• O campo ISIN, CUSIP ou outro código é onde pode inserir outros códigos ou texto (em branco
neste exemplo).

• O campo Fração negociada deve ser ajustado para a mais pequena fração de mercadoria que se
pode negociar, normalmente 1/100 ou 1/10000.

• A caixa “Obter cotações online”, a origem das cotações e o fuso horário devem estar seleciona-
dos para definir as origens de cotações online. Veja também Definir cotações de ações automati-
camente.

Nota

Se a caixa Obter cotações online não estiver ativa, e não puder ser marcada, é porque o
pacote Finance::Quote não está instalado. Veja a secção  Instalar o Finance::Quote.
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Eis como a janela se deve parecer após terminar:

Janela de nova mercadoria

• Grave a mercadoria - clique em Aceitar para gravar a nova mercadoria. Isto fecha a janela Nova
mercadoria e volta à janela Nova conta.

7. Selecione a mercadoria - deve agora ver a recém criada mercadoria disponível na lista pendente em
Garantia/Moeda. Selecione-a (provavelmente já está) e clique em Aceitar.

8. Menor fração - especifique a menor fração da mercadoria/moeda que é negociada.

9. Notas - insira quaisquer notas ou mensagens relacionadas com esta mercadoria/moeda.

10.Relativo a impostos - vá a Editar → Opções do relatório Impostos para marcar esta caixa se as transações
da conta fazem parte da coleta.

11.Marcador de posição - marque esta caixa se a conta é um “marcador de posição”, ou seja, se a conta
não contiver transações.

12.Terminou - deve agora ter voltado automaticamente ao diálogo Nova conta, com Garantia/Moeda: de-
finida como “AMZN (Amazon.com)”. Clique em Aceitar para gravar esta nova conta de ações.

Acabou de criar a conta de ações da Amazon, a sua árvore de contas deve parecer-se com a figura abaixo
(note que há algumas contas extra, uma conta bancária e uma conta de capital próprio):
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Separador Contas após a criação da primeira conta de ações (AMZN)

Abra a janela de diário para esta conta de ações AMZN (com duplo clique). Aqui terá a vista Mercadoria.
Isto dá-lhe uma visão geral das transações nesta mercadoria, incluindo o número de unidades (ações de uma
empresa ou fundo de investimento) compradas ou vendidas, o preço líquido por unidade e o montante total.
Obviamente, ainda não comprámos nem vendemos ações da AMZN, pelo que o diário deve estar vazio.

Comprar ações
Inserir ações pré-existentes

Para registar as 100 ações iniciais da AMZN que já tinha comprado antes, na primeira linha da transação
insira a data de compra (ex.: 1 de janeiro de 2005), uma descrição (ex.: Compra inicial), transferência
de Capital próprio:Saldos iniciais, Ações (ex.: 100) e cotação (ex.: 20€). Não precisa de preencher a
coluna Compra, o GnuCash fá-lo por si. Este exemplo presumiu que não houve nenhuma comissão nesta
transação, para simplificar as coisas. O seu diário da mercadoria AMZN deve estar parecido com isto:

Esta imagem mostra o diário da conta AMZN após a primeira “compra” de ações.

Note que o Saldo está em unidades da mercadoria (ações AMZN) e não em dinheiro. Logo, o saldo é 100
(unidades AMZN) e não 2000€. É assim que deve ser.

Comprar novas ações
A única diferença entre configurar uma compra de novas ações e configurar ações pré- existentes é que em
vez de transferir dinheiro da conta Capital próprio:Saldos iniciais, transfere-o da conta Ativos:Banco ABC.

Agora vamos comprar 5.000€ de ações IBM, com uma comissão de 100€. O primeiro passo será criar a
conta de ações IBM. A conta existente Despesas:Comissões será usada. Se quiser controlar comissões de
ações individualmente, precisará de subcontas para cada mercadoria.
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Agora, para a transação, na primeira linha insira a data de compra (ex.: 3-1-2005), uma descrição (ex.:
Compra IBM inicial), ignore Ações (a serem calculadas), o preço (ex.: 96,6€), e valor de compra (5.000€).
Não precisa de preencher a coluna Ações, ela será calculada por si. A linha seguinte da transação será
a compra de Despesas:Comissões, no valor de 100€. A terceira linha será a transferência da conta Ati-
vos:Banco ABC:Conta poupança, como venda no valor de 5.100€, para saldar a transação. O diário da
sua mercadoria IBM deve parecer-se com isto:

Esta imagem mostra o diário da mercadoria IBM após a primeira “compra” de ações com uma comissão
paga.

Definir a cotação de ações
O valor de uma mercadoria, tal como uma ação, tem de ser explicitamente definido. As contas de ações
controlam a quantidade de ações que possui, mas o valor das ações é armazenado no Editor de cotações.
Os valores definidos no Editor de cotações podem ser atualizados manual ou automaticamente.

Configuração inicial do editor de cotações
Para usar o Editor de cotações para controlar o valor de uma ação, tem de inserir primeiro a ação. Para

tal, abra o Editor de cotações (Ferramentas → Editor de cotações) e clique em Adicionar. Na primeira vez
que uma mercadoria/ação é inserida, esta janela estará em branco, só com os botões ao fundo. Selecione
a mercadoria apropriada no que quer inserir no Editor de cotações. Neste ponto, pode inserir a cotação
manualmente. Há seis campos na janela do editor de cotações:

Espaço de nome O mercado bolsista onde a mercadoria será negociada (NASDAQ, nes-
te exemplo)

Garantia O nome da mercadoria, tem de ser escolhido da lista pendente

Moeda A moeda em que a cotação é expressa.

Data Data em que a cotação é válida

Tipo Um de: Compra (o preço para comprar no mercado), Venda (o preço
para vender no mercado), Última (a cotação na última transação), Va-
lor líquido do ativo (cotação do fundo mutualista por ação), ou Desco-
nhecido. Ações e moedas normalmente têm as cotações como Compra,
Venda ou Última. Os fundos mutualistas são muitas vezes avaliados
como valor líquido do ativo. Para outras mercadorias, escolha simples-
mente Desconhecido. Isto é só para informação, não é usado pelo Gnu-
Cash.

Preço O preço de uma unidade desta mercadoria.

Como exemplo de adição de uma mercadoria AMZN ao editor de cotações, com um valor inicial de 40.5€
por ação:

112



Investimentos

Adicionar a mercadoria AMZN ao editor de cotações, com um valor inicial de 40.5€ por ação.

Clique em Aceitar quando terminar. Uma vez realizada esta colocação incial da mercadoria no Editor de
cotações, já não terá de o fazer novamente, mesmo que utilize a mesma mercadoria noutra conta.

Nota

Se ativou a obtenção de cotações online (veja “Configurar a obtenção automática de cotações”),
pode inicializar uma mercadoria sem fazer uma entrada manual. Quando inicialmente adiciona a
mercadoria ao Editor de mercadorias, marque a opção Obter cotações online e grave a mercadoria.
Depois, na Base de dados de cotações, clique em Obter cotações e a nova mercadoria será inserida
na lista de cotações com o preço obtido.

Definir a cotação de ações manualmente

Se o valor da mercadoria (ação) se alterar, pode ajustá-lo no Editor de cotações, selecionando a mercadoria,
clicando em Editar e inserindo a nova cotação.

A janela do editor de cotações, mostrando a lista de todas as mercadorias conhecidas.
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Configurar a obtenção automática de cotações
Se tem mais de um par de mercadorias, acabará por se cansar de atualizar as cotações à mão. O GnuCash
tem a capacidade de transferir as cotações mais recentes das suas mercadorias usando a Internet. Isto
é conseguido através do módulo Perl Finance::Quote, que tem de estar instalado para poder usar esta
funcionalidade.

Para determinar se o módulo Perl Finance:: Quote já está instalado, digite perldoc Finance::Quote num
terminal. Veja se há alguma documentação disponível. Se houver, o módulo está instalado.

Instalar o Finance::Quote

Microsoft Windows:

• Feche o GnuCash.

• Execute Install Online Price Retrieval no menu “Start” do GnuCash.

MacOS: tem de ter o XCode instalado. O XCode é um item opcional do DVD da sua distribuição do
MacOS. Execute Update Finance Quote no dmg do GnuCash. Pode executá-lo a partir do dmg ou copiá-lo
para a mesma pasta para onde copiou o GnuCash. Vai abrir um terminal e executar um script que lhe fará
muitas perguntas. Aceite as predefinições a não ser que saiba o que está a fazer..

Linux:

• Feche todas as instâncias do GnuCash em execução.

• Localize a pasta onde o GnuCash está instalado, procurando por gnc-fq-update

• Vá para essa pasta e abra um terminal como root

• Execute o comando gnc-fq-update

Isto vai iniciar uma sessão Perl CPAN de atualização que vai à Internet e instala o módulo Finance::Quote
no seu sistema. O programa gnc-fq-update é interativo, no entanto, na maioria dos sistemas poderá respon-
der “não” à primeira questão: “Are you ready for manual configuration? [yes]” e a atualização continua
automaticamente a partir daí.

Após terminar a instalação, deve executar o programa de teste “gnc-fq-dump”, na mesma pasta, distribuído
com o GnuCash para verificar se o Finance::Quote está instalado e a trabalhar adequadamente.

Nota

Se não se sente confortável a executar estes passos, por favor envie uma mensagem à lista de
correio dos utilizadores do GnuCash - <gnucash-user@gnucash.org> para ajuda, ou ve-
nha ao canal IRC do GnuCash em irc.gnome.org. Também pode saltar estes passos e atualizar
manualmente as cotações das suas ações.

Configurar mercadorias para cotações online

Com o Finance::Quote instalado e a funcionar adequadamente, terá de configurar as mercadorias no Gnu-
Cash para usarem esta funcionalidade e obterem as cotações atualizadas automaticamente. Seja para criar

novas mercadorias ou para modificar já existentes, use Ferramentas → Editor de mercadorias, para editar a
mercadoria e marque a caixa Obter cotações online. Poderá agora modificar as opções para Tipo de origem
de cotação, as listas pendentes para especificar as origens e o fuso horário das cotações. Quando terminar a
edição, Feche o Editor de mercadorias para voltar à Base de dados de cotações e clique em Obter cotações
para atualizar as cotações das suas ações na internet.
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O comando gnucash --add-price-quotes $HOME/ficheiro-gnucash pode ser usado para obter as cota-
ções atuais das suas ações. O ficheiro especificado, $HOME/ficheiro-gnucash depende do nome
e localização do seu ficheiro de dados. Pode identificá-lo na barra de título do GnuCash, antes do “-”.
Também o pode encontrar no menu Ficheiro, na lista de ficheiros recentes; o primeiro item, numerado 1,
é o nome do ficheiro atualmente aberto.

Isto pode ser automatizado criando uma entrada crontab. Por exemplo, para atualizar o seu ficheiro a cada
sexta feira às 16:00, após o fecho dos mercados relevantes (ajuste a hora para o que for conveniente), pode
adicionar o seguinte à sua aplicação crontab pessoal:

0 16 * * 5 gnucash --add-price-quotes $HOME/gnucash-filename > /dev/null 2>&1

Lembre-se que as “cotações” dos fundos mutualistas são realmente “valores líquidos dos ativos (NAV)”
e precisam de várias horas após o fecho dos mercados para estarem disponíveis. Se já tinha transferido
NAVs antes dos NAVs do dia de hoje estarem determinados, são usados os NAVs de ontem.

Mostrar o valor da ação
A janela principal de contas, por predefinição, só mostra a quantidade de cada mercadoria que possui, sob
a coluna Total. No caso de ações, esta mercadoria é o número de ações. Contudo, frequentemente quererá
ver o valor das suas ações, expresso em termos de uma qualquer unidade monetária. Isto é facilmente
conseguido na janela principal, selecionando o separador Contas, clicando em Opções (a seta a apontar
para baixo no extremo direito da barra de cabeçalhos) e marcando a opção para mostrar “Total (EUR)”.
Verá uma nova coluna com este cabeçalho, Total (EUR) que vai expressar o valor de todas as mercadorias
em moeda.

Nota

Aqui foi usado Total (EUR). EUR pode variar consoante a moeda que tenha predefinida.

Mostrar o valor das ações/mercadorias na janela principal, usando a coluna Total com a moeda dos rela-
tórios.

Selecionar a “origem da cotação” em relatórios de valor
das ações

A maioria dos relatórios de ativos do GnuCash têm opções para definir/modificar vários parâmetros. A
janela de opções é mostrada selecionando o separador do relatório e clicando em Opções na barra de
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menu ou selecionando Editar → Opções do relatório. O separador Geral na janela de opções contém vários
parâmetros para o relatório. Um destes é a “Fonte da cotação” que oferece três alternativas para determinar
a cotação das ações nos relatórios:

Nota

No exemplo abaixo, o relatório é uma personalização do Saldo Médio no submenu Ativo &
Passivo dos Relatórios.

Determinar a cotação de uma mercadoria num relatório, definindo a opção Fonte da cotação.

• Média ponderada - dá um gráfico com a cotação ponderada de todas as transações. Não leva em conta
cotações definidas no editor de cotações.

• Mais recente - mostra o valor corrente das suas ações, baseado unicamente na cotação mais recente
disponível no editor de cotações. A cotação contida nas suas transações de ações não é considerado.

• Mais próximo no tempo - o gráfico é exclusivamente baseado em cotações disponíveis no editor de
cotações. O valor das suas ações em cada passo e cada ponto no tempo é calculado com base no preço
do editor mais próximo no tempo.

Controlar o valor que as suas ações teriam na bolsa de valores.
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Vender ações
Inserir uma venda de investimentos é feito da mesma forma que inserir uma compra (veja “Comprar novas
ações”), exceto que o custo total da transação é inserido na coluna Venda e na coluna Ações é inserido
um valor negativo. As receitas líquidas da venda devem ser transferidas da conta de ações para a conta
bancária ou conta na corretora.

O registo apropriado da venda de ações *tem* de ser feito usando uma transação com parcelas. Nesta,
tem de contar com o lucro (ou prejuízo) como vindo de uma conta Receitas:Ganhos de capital (ou Des-
pesas:Perdas de capital). Para saldar esta receita, tem de inserir o ativo em ações duas vezes. Uma para
registar a venda real (usando o número correto de ações e cotação correta por ação) e outra para saldar o
lucro recebido (definindo o número de ações para 0 e o preço por ação para 0).

Nota

Para levar o GnuCash a submeter esta parcela zero-ações, preço-zero na transação, *tem* de sair
da parcela com Tab. Se usar a tecla Enter, o GnuCash converte a parcela em ações da mercadoria.

No esquema de transação com parcelas mostrado abaixo, o símbolo NUM_AÇÕES é o número de ações
que está a vender, PREÇO_VENDA é o preço por que as vendeu, BRUTO é o valor total da venda,
igual a NUM_AÇÕES*PREÇO_VENDA. LUCRO é o montante de dinheiro que realizou na venda.
COMISSÕES são as comissões pagas pela venda. VENDA_LÍQUIDA é o montante limpo que recebeu
pela venda, igual a BRUTO - COMISSÕES.

Tabela 8.1. Vender ações usando o esquema de transação com parcelas

Conta Número de
ações

Preço da ação Compra Venda

Ativos:Banco ABC VEN-
DA_LÍQUIDA

Ativos:Ação:SÍMBOLO 0 0 LUCRO (prejuízo)

Despesas:Comissões COMISSÕES

Ativos:Ação:SÍMBOLO -NUM_AÇÕES PREÇO_VEN-
DA

BRUTO

Receitas:Ganhos de capital (prejuízo) LUCRO

Se vai registar a venda de ações como ganho de capital (ou prejuízo), por favor veja Capítulo 9, Ganhos
de capital e Capítulo 18, Depreciation para mais informações.

Exemplo - venda de ações com lucro
A título de exemplo, vamos usar a conta AMZN criada na secção anterior. Assim, comprou 100 ações da
AMZN por 20€ cada e mais tarde vendeu-as todas por 36€ cada, com uma comissão de 75€. No esquema
de transação com parcelas acima, PREÇO_COMPRA é 20€ (o preço original), NUM_AÇÕES é 100,
TOTAL_COMPRA é 2.000€ (o custo original de compra), BRUTO é 3.600€ e, finalmente, o LUCRO é
1.525€ (BRUTO-TOTAL_COMPRA-COMISSÃO).

Tabela 8.2. Vender ações usando o esquema de transação com parcelas

Conta Ações Preço Com-
pra

Venda

Ativos:Banco ABC 3.525,00
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Ativos:Conta na corretora:A-
ção:AMZN

0 0 1.600,00

Despesas:Comissões 75,00

Ativos:Conta na corretora:A-
ção:AMZN

-100 36,00 3.600,00

Receitas:Ganho capital (lon-
go):AMZN

1.600,00

Um exemplo de venda de ações para obter lucro. Comprou 100 ações da AMZN por 20€ por ação e vendeu
por 36€.

Uma imagem da árvore de contas após vender ações para obter lucro.

Exemplo - venda de ações com prejuízo
Como exemplo, vamos usar a conta IBM criada na secção anterior. Tinha comprado 51,7598 ações da IBM
por 96,6001€ cada. Mais tarde vendeu-as por 90€ cada. No esquema da transação com parcelas abaixo,
PREÇO_COMPRA é 96,001€ (o preço original de compra), NUM_AÇÕES é 51,7598, TOTAL_COM-
PRA é 5.000€ (o valor original da compra), (prejuízo) é 341,62€ e BRUTO é 4.658,38€. Presumimos uma
comissão de 100€.

Tabela 8.3. Esquema de transação com parcelas para uma venda de ações com
prejuízo

Conta Ações Preço Com-
pra

Venda
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Ativos:Banco ABC 4558,38

Ativos:Conta na corretora:A-
ção:IBM

0 0 341,62

Despesas:Comissões 100

Ativos:Conta na corretora:A-
ção:IBM

-51,759890,00 4658,38

Receitas:Ganho de capital (lon-
go):IBM

341,62 0

Nota

Pode inserir o prejuízo como número positivo na coluna “Compra” ou como número negativo na
coluna “Venda”, o GnuCash move o “lucro negativo” para a outra coluna.

Acima está uma imagem de uma venda de ações. Comprou 5.000€ em ações da IBM por 96,001€ cada
e vendeu por 90€ cada.

Uma imagem da árvore de contas após vender ações com prejuízo.

Dividendos
Algumas companhias e/ou fundos de investimento pagam dividendos periódicos aos acionistas. Os divi-
dendos são tipicamente dados de uma de duas formas, ou são automaticamente reinvestidos na mercado-
ria ou são pagos em dinheiro. Os fundos de investimento são muitas vezes configurados para reinvestir
automaticamente os dividendos, enquanto os dividendos das ações comuns são normalmente pagos em
dinheiro.
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Dividendos em dinheiro
Se o dividendo for pago em dinheiro, deve registar a transação na conta do ativo que recebeu o dinheiro,
como receita de Receitas:Dividendos. Adicionalmente, se quiser ligar o dividendo em dinheiro a uma ação
em particular, junte uma parcela fictícia à conta da ação com quantidade 0, preço 1 e valor 0.

A título de exemplo, considere o seguinte: os dividendos depositados em dinheiro na conta Corretor com
uma ligação à conta da ação.

Uma imagem do diário da Conta na corretora após uma série de dividendos ser recebida em dinheiro.

Nota

Se quiser controlar dividendos por ação, terá de criar uma conta Receitas:Dividendos:SÍMBO-
LO_AÇÃO para cada ação que possui que pague dividendos.

Dividendos reinvestidos
Se recebe os dividendos na forma de reinvestimento automático, a transação deve ser gerida dentro da
conta de ação/fundo de investimento como “Receitas:Dividendos” para o número apropriado de ações
reinvestidas. Este tipo de conta de reinvestimento é muitas vezes referida como DRIP (Dividend Re-In-
vestment Program).

Como exemplo, vejamos a seguinte compra de ações NSTAR (NST) com os dividendos reinvestidos numa
conta DRIP. As transações de reinvestimentos de fundos devem ser feitas de igual forma.

Comece com a compra de 100 ações a 3 de janeiro de 2005, todos os dividendos serão reinvestidos e crie
uma conta para controlar os dividendos desta ação específica. O Se o primeiro dividendo for de 0,29€ por
ação, insira 53,28 (preço de compra + dividendo) no Preço da ação e 100*0,29 na Compra. O GnuCash
calcula o correspondente número de ações

Imagem do diário da conta de ações da NST após o reinvestimento de dividendos

Desdobramentos e uniões
As empresas podem desdobrar as suas ações por muitos motivos, mas o mais comum é o preço ter subido
mais do que aquilo que é razoável para a maioria dos investidores. Alguns destes desdobramentos são
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simples trocas (2 por 1 ou 3 por 2) e outros são trocas complexas com distribuição de capital. Os desdo-
bramentos também podem resultar em menos ações se a taxa de câmbio for inversa (1 por 3 ou 0,75 por 1).

Desdobramento simples de ações

Como exemplo, a detentora de ações NST declarou um desdobramento de 2 por 1, efectivo a 6 de junho de

2005. O processo para inserir esta transação é o seguinte: Ações → Desdobramento de ações para iniciar
o assistente.

Seleção do assistente de desdobramento de ações.

O primeiro ecrã é uma introdução, clique em Avançar para ver a seleção de contas de ações para desdobrar.
Terá de criar uma entrada para cada Conta:Ação que possua.

Passo 2 do assistente de desdobramento de ações - seleção de conta/ação.

Selecione Ativos:Investimentos:DRIPs:NST e clique em Avançar.

No ecrã seguinte tem 5 campos disponíveis:

• Data - insira a data do desdobramento.

• Ações - o número de ações (a mais ou a menos) na transação.

No nosso exemplo, é um desdobramento 2 por 1, pelo que o número de ações é o número atualmente
no diário.

• Descrição - a descrição deve conter uma breve explicação da transação.
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• Novo preço - se quiser, insira o novo preço da ação após o desdobramento.

• Moeda - a moeda da transação é necessária. Deve ser a mesma em que as ações foram compradas.

Clique em Avançar.

Passo 3 do assistente de desdobramento de ações - detalhes do desdobramento.

Neste exemplo saltamos o ecrã seguinte, dado que não houve nenhum “Montante auferido”.

Passo 4 do assistente de desdobramento de ações - montante auferido.

Um ecrã Terminar dá as últimas opções para Cancelar, Recuar para modificar os dados ou Aplicar para
completar o desdobramento com os dados inseridos.

Clique em Aplicar.
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Diário da conta Ativos:Investimentos:DRIPs:NST após uma transação de desdobramento simples de ações.

União de ações moderadamente complexa

Vamos presumir que detinha ações da AT&T durante a fusão de 18 de novembro de 2005 entre a SBC e a
AT&T. Neste exemplo, teria comprado ações da AT&T a 1 de abril de 2005 e todos os dividendos teriam
sido pagos em dinheiro, logo, não constam do diário das ações da AT&T.

As condições da fusão foram a troca de 0,77942 ações da SBC por cada ação da AT&T. A companhia
final continuou a usar o símbolo “T” da AT&T.

A AT&T pagou um “dividendo” de 1.20€/ação na data da transação, mas isto não vai aparecer na conta
da ação, uma vez que foi uma distribuição de capital.

O processo para inserir esta transação é idêntico ao desdobramento simples até ao ecrã “Detalhes”. Tem
de criar uma entrada separada para cada combinação de Conta de investimento:Ação que tenha desdobra-
mento de ações.

Passo 2 do assistente de desdobramento de ações - seleção de conta/ação (Conta de investimento:T).

SelecioneAtivos:Investimentos:Conta na corretora:Ação:T e clique em Avançar.

No ecrã seguinte tem 5 campos disponíveis:

• Data - insira a data do desdobramento. Aqui vamos inserir 18 de novembro de 2005.

• Ações - o número de ações (a mais ou a menos) na transação.
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Neste exemplo é uma fusão de 0,77942 por 1, pelo que o número de ações diminui em relação ao número
de ações atualmente no diário. Pode usar a capacidade do GnuCash para realizar cálculos, inserindo
dados diretamente (“(0,77942*100)-100”) para calcular a diminuição das ações na fusão.

• Descrição - a descrição deve conter uma breve explicação da transação.

• Novo preço - se quiser, insira o novo preço da ação após o desdobramento.

• Moeda - a moeda da transação é necessária. Deve ser a mesma em que as ações foram compradas.

Clique em Avançar.

Passo 3 do assistente de desdobramento de ações - detalhes da fusão

Neste exemplo saltamos o ecrã seguinte, dado que não houve nenhum “Montante auferido”.

Um ecrã Terminar dá as últimas opções para Cancelar, Recuar para modificar os dados ou Aplicar para
completar o desdobramento com os dados inseridos.

Clique em Aplicar.

Exemplo de transação de fusão moderadamente complexa na Conta de investimento:T em que as ações
diminuem.
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Capítulo 9. Ganhos de capital
Este capítulo apresenta algumas das técnicas usadas para controlar ganhos e perdas realizados e não rea-
lizados, mais conhecidos por ganhos e perdas de capital.

Conceitos básicos
Certos ativos vendáveis podem mudar de valor ao longo do tempo, tais como ações, obrigações, casas,
carros, etc.. Alguns ativos (por exemplo, uma ação) podem aumentar de valor, outros (por exemplo, um
carro) podem diminuir. É importante poder controlar estas variações ao longo do tempo. Vamos mos-
trar-lhe como o fazer.

Provavelmente, tudo o que possui vai aumentar ou diminuir de valor ao longo do tempo. Portanto, a questão
é para quais dos seus ativos deve controlar este valor variável? A resposta mais simples é que deve controlar
os itens que podem ser vendidos no futuro ou aqueles sujeitos a impostos.

Itens consumíveis e não reutilizáveis (ex.: comida, gasolina ou papel de impressora) obviamente não estão
aqui incluídos. Logo, embora as roupas novas que comprou se desvalorizem, não há interesse em controlar
esta desvalorização, dado que não pensa em vender essas roupas, assim como não há implicações de
impostos nessa desvalorização. Assim sendo, a compra de roupas neste exemplo deve ser registada como
despesa pura... Gastou o dinheiro e foi-se!

A valorização de ativos ocorre quando algo que possui aumenta de valor ao longo do tempo. Quando isto
acontece, a diferença entre a preço de compra e o novo valor é conhecida por ganhos não realizados.
Quando vende o ativo, o lucro é conhecido como ganhos realizados ou ganhos de capital. Um exemplo
de um ativo do qual poderia ter ganhos não realizados e eventuais ganhos de capital, é uma ação de uma
empresa pública.

Estimar valorizações
Como mencionado atrás, os ganhos de capital são os lucros recebidos da venda de um ativo. Esta secção
descreve como registar ganhos de capital no GnuCash.

Os métodos contabilísticos para registar uma valorização são algo diferentes da desvalorização, porque,
tipicamente só há preocupação com o momento da venda do ativo e realização do ganho de capital. Isto é o
oposto à natureza contínua do controlo da desvalorização. Os ganhos de capital são um assunto importante
no mundo fiscal, porque os governos tendem a ter neles muito interesse, de uma ou de outra maneira.

Nota

Como sempre, há exceções. Se detiver uma obrigação que paga todos os juros no vencimento,
as autoridades fiscais impõem muitas vezes a declaração de juros anuais e recusam o tratamento
como ganho de capital. Consulte os códigos fiscais adequados para determinar o tratamento apro-
priado para cada tipo de ativo que possa ser abrangido por impostos relativos a ganhos de capital.

Estimar o aumento de valor dos ativos não é, de maneira geral, tarefa simples. Muitas vezes é difícil saber
o valor exato até ao momento da venda.

Mercadorias negociadas diariamente em mercados abertos, como as bolsas de valores, são possivelmente o
tipo de ativo mais fácil de avaliar e vender o ativo a preço de mercado pode ser tão simples como contactar
um corretor e emitir uma ordem de mercado. Por outro lado, estimar o valor de uma casa é mais difícil. As
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casas vendem-se menos que as ações e as vendas tendem a envolver um gasto considerável de esforço e
negociações, o que significa que as estimativas são menos precisas. Igualmente, a venda de um automóvel
usado envolve uma negociação que torna a avaliação menos previsível.

Valores de objetos de coleção, tais como jóias, arte, coleção de selos, etc., são ainda mais difíceis de avaliar.
Os mercados para este tipo de objetos são ainda mais restritos que o mercado imobiliário ou automóvel.
Pior ainda são os ativos únicos no mundo. As fábricas produzem, por vezes, um produto único e muito
específico e personalizado que pode custar centenas de milhares de euros. Estes produtos podem ter vários
valores conflituosos, nenhum dos quais pode ser correto sem ambiguidades.

Em contabilidade, a regra geral para estimar ganhos (ou perdas) de capital é que só deve reavaliar ativos
como ações, que estão prontos a vender e para os quais há estimativas de valor fidedignas. Para todos os
outros ativos, é melhor esperar até que os venda, altura em que pode determinar exatamente os ganhos de
capital. Claro, não há nenhuma regra rígida a respeito disto, diferentes contabilistas podem ter diferentes
opiniões.

Configuração das contas
Assim como na maioria das práticas contabilísticas, há um sem número diferente de configurar contas de
ganhos de capital. Apresentamos aqui um método geral que deve ser suficientemente flexível para gerir
a maioria das situações. A primeira conta que precisa é uma conta de custo do ativo (conta GnuCash tipo
Ativo), que é simplesmente um local onde regista a compra original do ativo. Normalmente, esta compra
é conseguida com uma transação a partir da conta bancária.

Para controlar a valorização do ativo, precisa de três contas. A primeira é a conta de ativo Ganhos não
realizados, na qual reune a soma de todos os montantes de valorização. Esta conta é saldada com a conta
de receita Ganhos não realizados, na qual toda a valorização periódica recebida é registada. Finalmente,
é precisa outra conta de receita, chamada Ganhos realizados, na qual regista os ganhos de capital reais
após a venda do ativo.

Abaixo está uma hierarquia de contas genérica para controlar a valorização de dois ativos, ITEM1 e ITEM2.
As contas Ativos:Ativos fixos:ITEMX:Custo são saldadas pela conta Ativos:Ativos atuais:Conta poupança
e as contas Ativos:Ativos fixos:ITEMX:Ganhos não realizados são saldadas pela conta Receita:Ganhos
não realizados.

Nota

Deverá criar uma estrutura igual para cada ativo que pretenda controlar, ITEM1, ITEM2, ...,
ITEMN.

-Ativos
    -Ativos atuais
        -Conta poupança
    -Ativos fixos
        -ITEM1 
            -Custo
            -Ganhos não realizados
        -ITEM2
            -Custo
            -Ganhos não realizados
-Receita
    -Ganhos realizados
    -Ganhos não realizados
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Exemplo
Vamos supor que compou um ativo que se espera que aumente de valor, por exemplo uma pintura de
Degas, para a qual quer controlar a valorização (a companhia de seguros preocupa-se com isto, mesmo
que mais ninguém o faça).

Comece com um plano de contas semelhante ao mostrado em “Configuração das contas”, mas substitua
“ITEM1” por “Degas” e remova as contas “ITEM2”. Vamos presumir que a pintura de Degas tinha um
valor inicial de cem mil euros. Ofereça a si mesmo os 100.000€ para a conta à ordem e depois transfira-os
para a conta Ativos:Ativos fixos:Degas:Custo (a transação de compra do ativo). A sua janela pricipal deverá
ser parecida a esta:

Exemplo de contas para controlo da valorização de ativos

Ganhos não realizados
Um mês depois, tem motivos para suspeitar que o valor da sua pintura aumentou em 10.000€ (um ganho
não realizado). Para registar esta alteração, transfira os 10.000€ da conta Receita:Ganhos não realizados
para a conta Ativos:Ativos fixos:Degas:Ganhos não realizados:

Plano de contas depois do ganho não realizado
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Vender
Vamos supor que algum tempo depois os valores das pinturas de Degas subiram ainda mais, cerca de
20,000€ estimados. Diligentemente, regista a subida como anteriormente e decide vender a pintura.

Surgem três possibilidades. Pode ter valorizado precisamente o ganho não realizado, subvalorizado o
ganho não realizado, ou sobrevalorizado o ganho não realizado.

1. Valorização precisa do ganho não realizado.

A sua valorização otimista da pintura estava correta. Primeiro tem de registar os lucros como ganhos
realizados. Faça-o transferindo a receita de Receita:Ganhos não realizados para Receita:Ganhos rea-
lizados.

Segundo, tem de creditar a sua conta bancária com o preço de venda da pintura. O dinheiro vem dire-
tamente das subcontas de Ativos:Ativos fixos:Degas. Transfira o total da conta Ativos:Ativos fixos:De-
gas:Custo para Ativos:Ativos atuais:Conta poupança e o total da conta Ativos:Ativos fixos:Degas:Ga-
nhos não realizados para a conta Ativos:Ativos atuais:Conta poupança.

As transações devem estar como se segue:

Tabela 9.1. Transformar um ganho acumulado num ganho realizado

Conta Transferir para Montante da transação Total da conta

Receita:Ganhos não rea-
lizados

Receita:Ganhos realiza-
dos

30.000€ 0€

Ativos:Ativos fixos:De-
gas:Custo

Ativos:Ativos atu-
ais:Conta poupança

100.000€ 0€

Ativos:Ativos fixos:De-
gas:Ganhos não realiza-
dos

Ativos:Ativos atu-
ais:Conta poupança

30.000€ 0€

Isto deixa a conta Ativos:Ativos atuais:Conta poupança com um total de 130.000€ e a conta Recei-
ta:Ganhos realizados com um total de 30.000€.

Plano de contas após um ganho realizado

2. Subvalorização de ganhos não realizados.
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Foi demasiado otimista sobre o valor da pintura. Em vez dos 130.000€ que pensava que a pintura valia,
só lhe oferecem 120.000€. Mas mesmo assim decide vender, porque dá mais valor ao dinheiro do que
à pintura. Os números alteraram-se, mas não dramaticamente.

As transações serão como se segue (observe a última transação, que salda as contas Ganhos não rea-
lizados):

Tabela 9.2. Transformar um ganho acumulado num ganho realizado

Conta Transferir para Montante da transação Total da conta

Receita:Ganhos não rea-
lizados

Receita:Ganhos realiza-
dos

20.000€ 10.000€

Ativos:Ativos fixos:De-
gas:Custo

Ativos:Ativos atu-
ais:Conta poupança

100.000€ 0€

Ativos:Ativos fixos:De-
gas:Ganhos não realiza-
dos

Ativos:Ativos atu-
ais:Conta poupança

20.000€ 10.000€

Ativos:Ativos fixos:De-
gas:Ganhos não realiza-
dos

Receita:Ganhos não rea-
lizados

10.000€ 0€

Isto deixa a conta Ativos:Ativos atuais:Conta poupança com um total de 120.000€ e a conta Recei-
ta:Ganhos realizados com um total de 20.000€.

3. Sobrevalorização de ganhos não realizados.

Conseguiu vender a pintura por um valor acima dos seus sonhos, por 150.000€. O valor extra é, de
novo, registado como ganho, i.e., receita.

As transações serão como se segue (observe a última transação, que salda as contas Ganhos não rea-
lizados):

Tabela 9.3. Transformar um ganho acumulado num ganho realizado

Conta Transferir para Montante da transação Total da conta

Receita:Ganhos não rea-
lizados

Receita:Ganhos realiza-
dos

50.000€ -20.000€

Ativos:Ativos fixos:De-
gas:Custo

Ativos:Ativos atu-
ais:Conta poupança

100.000€ 0€

Ativos:Ativos fixos:De-
gas:Ganhos não realiza-
dos

Ativos:Ativos atu-
ais:Conta poupança

50.000€ -20.000€

Receita:Ganhos não rea-
lizados

Ativos:Ativos fixos:De-
gas:Ganhos não realiza-
dos

20.000€ 0€

Isto deixa a conta Ativos:Ativos atuais:Conta poupança com um total de 150.000€ e a conta Recei-
ta:Ganhos realizados com um total de 50.000€.
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Cautela com as avaliações
Como vimos neste exemplo, para ativos não financeiros é difícil estimar corretamente o “verdadeiro” valor
de um ativo. É bastante fácil pensar que estamos ricos, baseados em estimativas questionáveis que não
refletem o “dinheiro no banco”.

Quando se lida com valorização de ativos,

• tenha cuidado com a estimativa dos valores, não embarque em sonhos impossíveis;

• nunca, nunca, conte com dinheiro que não tenha no banco ou em casa. Até que tenha realmente vendido
o seu ativo e recebido o dinheiro, quaisquer números num papel (ou padrões magnéticos no seu disco
rígido) são meramente isso. Se conseguir convencer um banqueiro a emprestar-lhe dinheiro usando os
seus ativos como garantia, já é prova convincente do valor desses ativos, já que os mutuantes tendem
a ser profissionalmente desconfiados a respeito de sobrevalorizações dúbias. Esteja atento: demasiadas
empresas que pareciam “lucrativas” no papel foram à falência por falta de dinheiro em caixa, devido a
“ativos valiosos” que não são a mesma coisa que dinheiro na mão.

Impostos
As políticas de impostos variam consideravelmente de país para país, portanto torna-se virtualmente im-
possível dizer algo que seja universalmente útil. Contudo, é comum que as receitas geradas por ganhos de
capital não sejam taxadas até à data em que o ativo é efetivamente vendido. E nalguns casos, nem mesmo
assim. Os norteamericanos que vendem a sua residência familiar verificam que os ganhos de capital gera-
dos por essa venda estão isentos de impostos. Noutros países, isto é tratado de maneira diferente, cobrando
impostos às pessoas por esses ganhos. As autoridades alemãs, por exemplo, só cobram impostos sobre
esses ganhos se possuiu a propriedade por menos de dez anos.

O Chris Browne tem uma história dos seus dias de preparação profissional de formulários de impostos
em que uma família vendeu uma quinta, esperando uma liquidação de impostos considerável, acabando
por ser virtualmente nula por terem mantido a propriedade desde antes de 1971 (data crítica de “Dia de
valorização” no Canadá) e devido a ser uma quinta de produtos diários, com algumas deduções bastante
peculiares. A moral desta história é que embora aquilo que aqui se disse pareça relativamente simples, as
declarações de impostos são muitas vezes terrivelmente complicadas...
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Capítulo 10. Múltiplas moedas
Este capítulo mostra-nos como configurar contas no GnuCash para usar múltiplas moedas.

Conceitos básicos
O GnuCash suporta mais de 100 moedas diferentes, desde o Franco de Andorra até ao dólar do Zimbabué.
Por exemplo, pode ter uma conta bancária configurada em Euros e outra em dólares de Hong Kong.

Algumas das dificuldades que surgem ao usar múltiplas moedas são, como transferir fundos entre contas
com diferentes moedas? Como é que se calcula o valor global com contas de diferentes moedas? Como
é que os relatórios lidam com moedas misturadas?

Nota

Uma forma alternativa de gerir contas com múltiplas moedas em vez da apresentada nas secções
seguintes, é usar as funcionalidades para contas de bolsa do GnuCash. Estas, que foram adicio-

nadas na versão 2.3.14, podem ser ativadas indo a Ficheiro → Propriedades, separador Contas.

Para um guia completo sobre contas de bolsa, pode seguir  este tutorial por Peter Selinger [http://
www.mathstat.dal.ca/~selinger/accounting/tutorial.html].

Configuração das contas
A sua moeda predefinida é configurada no separador Contas sob Editar → Preferências (GnuCash →
Preferências em MacOS). Defina este parâmetro corretamente, dado que lhe poupará muito tempo ao criar
o plano de contas.

De igual forma, o GnuCash oferece uma opção para predefinir a sua moeda favorita em relatórios (tais
como a folha de saldo e a declaração de rendimentos). A opção chama-se Moeda predefinida de relatórios
e está no separador Relatórios das Preferências do GnuCash. Defina ambas as opções quando começar
a usar o GnuCash, porque se (por exemplo) as suas contas estiverem em dólares canadianos mas gerar
relatórios em dólares americanos, os relatórios só dirão que não há “dados/transações (ou só zeros) para
o intervalo de tempo selecionado”.

Quando cria uma nova conta, tem a opção de definir a mercadoria. Para contas de moeda, pode especificar
uma das centenas suportadas pelo GnuCash simplesmente selecionando-a da lista de mercadorias. Repare
que a moeda predefinida é sempre a que definiu nas preferências. Por isso, se trabalha maioritariamente em
Euro mas tem ocasionalmente uma conta com Birr etíope, garanta que define a sua preferência para Euro..

Como exemplo, vamos definir um cenário de contas bancárias típico em que trabalha maioritariamente
com euros, mas também tem uma conta que usa a moeda americana dólar e uma outra em Hong Kong que
usa dólares de Hong Kong. Configure três contas bancárias, uma em Euro, outra em dólares americanos e
outra em dólares de Hong Kong. Uma estrutura de contas possível seria:

-Ativos                          (USD)
   -Ativos atuais                (USD)
      -Banco americano           (USD)
      -Banco europeu             (EUR)
      -Banco de Hong Kong        (HKD)
-Capital próprio                 (USD)
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   -Saldos iniciais 
      -USD                       (USD)
      -EUR                       (EUR)   
      -HKD                      (HKD)

Nota: a moeda de cada conta é mostrada entre parênteses.
 

Dado que neste exemplo se trabalha principalmente em EUR, todas as contas-mãe estão definidas em
EUR. Claro que, se trabalhar principalmente com USD, pode alterar esta definição. Os totais mostrados
na árvore de contas são sempre convertidos para a moeda de cada conta em particular. Note que também
configurámos três contas de saldos iniciais de capital próprio, usadas para povoar os três bancos.

Nota

Também podia configurar uma única conta de saldo inicial e usar uma transferência de moeda para
povoar as contas de “diferentes moedas”. Contudo, esta é uma opção mais avançada, explicada
na secção “Compra de um ativo com moeda estrangeira”.

Abaixo temos o resultado deste exemplo, no qual começa com 10.000 USD, 10.000 EUR e 10.000 HKD
em cada uma das três contas bancárias. Note que o total das contas-mãe só mostra o valor da moeda de
subcontas com a mesma moeda. No futuro poderá definir taxas de câmbio entre moedas. As contas-mãe
vão então calcular o valor convertido de todas as subcontas. Veja a secção “Como fazer - registar/atualizar
câmbios de moedas”.

Configuração inicial de contas bancárias com múltiplas moedas.

Note que a coluna "Total (moeda dos relatórios)" está a ser mostrada. Isto é configurado através da seta
para baixo no extremo direito da linha de cabeçalhos. Clique na seta e selecione “Total(EUR)”.

Moedas definidas pelo utilizador
Normalmente, quando falamos de moeda, queremos dizer moeda oficial de governos (ou mais preci-
samente, moedas definidas numa norma internacional chamada ISO 4217 [http://en.wikipedia.org/wi-
ki/ISO_4217]). O GnuCash não lhe permite criar as suas próprias moedas. Se quiser controlar moedas
não-ISO, pode usar um de dois processos, dependendo de qual melhor se adapta às suas necessidades.

Vamos supor que quer controlar PontosGasolina, que contam quantos pontos de fidelização já ganhou
por abastecer sempre no mesmo fornecedor de gasolina. A conta para tal seria Ativos:Outros:Fidelização-
PontosGasolina.
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O primeiro método é definir uma nova mercadoria, de tipo FUNDO, chamada PontosGasolina. Isto é
bastante simples quando cria a nova conta FidelizaçãoPontosGasolina, simplesmente defina o tipo de
conta como Ação ou Fundo de investimento, clique em Selecionar..., ao lado do campo Garantia/Moeda:
e clique em Novo para definir uma nova mercadoria de tipo FUNDO.

Não é realmente para isto que as contas de ações e fundos servem, mas o GnuCash normalmente permi-
te-lhe decidir como é que o quer usar, em vez de lhe impôr uma utilização. O lado mau é que terá de inserir
uma “cotação” para cada transação envolvendo PontosGasolina, porque o GnuCash precisa de cotações
para calcular o valor monetário de PontosGasolina e tratá-los como um dos seus ativos..

O segundo método é usar uma das moedas “fictícias” para controlar PontosGasolina. As moedas fictícias
são “XTS (código para efeitos de testes)” e “XXX (sem moeda)”. Se usar uma desta para a conta Fideli-
zaçãoPontosGasolina, pode inserir transações sem cotações para cada transação. E pode continuar a usar
as duas moedas fictícias para controlar quaisquer tipos de montantes - euros de férias ganhos e usados
durante este ano, dias de férias já usados, etc.. Pode já imaginar que o GnuCash pode ser o centro de toda
a espécie de medidas pessoais, além das suas finanças.

A falha do segundo método é que não pode definir taxas de câmbio para as moedas fictícias, para as
converter em moedas ISO. Se o quiser fazer, deve realmente usar o primeiro método.

Como fazer - registar/atualizar câmbios de mo-
edas

O GnuCash permite atualizar as taxas de câmbio de duas maneiras diferentes, manualmente ou automati-
camente. Nas duas secções seguintes vamos aprender ambas.

Antes de começar, vamos voltar a olhar para o plano de contas:

Configuração inicial de 3 contas bancárias com múltiplas moedas.

Atualizar taxas de câmbio manualmente

Abra a Base de dados de cotações indo a Ferramentas → Base de dados de cotações.
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Janela da base de dados de cotações.

Clique em Adicionar para adicionar uma nova taxa de câmbio. Abre uma janela parecida com esta:

Janela Adicionar da base de dados de cotações

Defina Espaço de nome para CURRENCY e Mercadoria para USD (Dólar EUA). Depois defina a taxa
de câmbio entre a mercadoria selecionada e a moeda selecionada. Neste exemplo, vamos definir a taxa
de câmbio como 1€ para 1 (pense assim, quantas unidades da moeda, neste caso €, teria de gastar para
comprar uma unidade da mercadoria, neste caso a moeda 1).

Janela da base de dados de cotações após ter definido a taxa de câmbio entre euros e dólares americanos
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Árvore de contas após ter definido a taxa de câmbio entre euros e dólares americanos.

Observe que, dado que não tem taxa de câmbio para HKD, o GnuCash não converte as contas HKD para
EUR. Isto será adicionado na secção seguinte.

Como fazer - atualização automática das taxas de câm-
bio

Na secção anterior aprendemos a definir manualmente uma taxa de câmbio para novas mercadorias. Mas
há uma forma mais fácil de o fazer. Aqui está ela.

Abra a Base de dados de cotações indo a Ferramentas → Base de dados de cotações.

Janela da base de dados de cotações antes de obter as cotações online

Clique em Obter cotações para carregar automaticamente as várias taxas de câmbio de que necessita.

Nota

Se o botão Obter cotações estiver desativado, significa que o módulo Perl Finance::Quote não está
instalado. Para informação sobre a instalação, por favor veja “Configurar a obtenção automática
de cotações”

Janela da base de dados de cotações após obter as cotações online.
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Pode observar que o GnuCash transfere taxas de câmbio para todas as moedas que está a utilizar nas
suas várias contas. Isto vai acontecer de cada vez que clicar em Obter cotações ou configurar o GnuCash
para transferir cotações/taxas de câmbio automaticamente, como explicado em “Configurar a obtenção
automática de cotações”

E se olhar para a árvore de contas, verá que o GnuCash converteu automaticamente o montante em HKD
para EUR nas contas-mãe que estão em EUR, assim como na coluna Total (EUR). Também as contas em
euro foram atualizadas com a última taxa de câmbio.

Árvore de contas após ter obtido as cotações online.

Desativar a obtenção de taxas de câmbio
Sempre que cria uma conta que use uma moeda diferente da predefinida, a obtenção de taxas de câmbio
para essa conta é automaticamente ativada. Contudo, se mais tarde eliminar essa conta, o GnuCash não
desativa automaticamente a obtenção de taxas de câmbio.

Se eliminou a última conta com uma determinada moeda e já não quiser obter taxas de câmbio para essa
moeda, faça o seguinte:

• Vá a Ferramentas → Editor de garantias.

• Certifique-se que a caixa Mostrar moedas nacionais está marcada.

• Expanda a linha CURRENCY.

• Faça duplo clique na moeda para a qual quer desativar a obtenção de taxas de câmbio.

• Desmarque a caixa Obter cotações online e clique em Aceitar.

Como fazer - registar compras em moeda es-
trangeira

Pode fazê-lo de duas formas diferentes.

1) Use a conversão de câmbios interna do GnuCash quando fizer as suas transações. Usado principalmente
para transações únicas, nada que aconteça regularmente.
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2) Use contas separadas para esta compra, em que todas as contas envolvidas usam a mesma moeda.
Este é o método recomendado, dado que permite muito maior controlo e rastreio. Desta maneira, faz uma
transação de conversão de câmbio e, a partir daí, faz as transações normais.

O resto desta secção explicará mais sobre o método 2).

Compra de um ativo com moeda estrangeira

A sua residência habitual é no Algarve, portanto usa EUR como moeda predefinida. Mas, gosta de passar
umas férias nas Bahamas e ir à pesca. Gosta tanto que decidiu comprar lá um barco. Para o fazer, abriu
uma conta num banco jamaicano, transferiu para lá algum dinheiro e comprou o barco dos seus sonhos
(versão curta).

Para registar isto no GnuCash vamos usar a seguinte estrutura de contas:

-Ativos                      (USD)
   -Ativos atuais            (USD)
      -Banco europeu         (USD)
      -banco jamaicano       (JMD)
   -Ativos fixos             (USD)
      -Barco                 (JMD)
-Capital próprio             (USD)
   -Saldos iniciais 
      -USD                   (USD)

Nota: a moeda de cada conta é mostrada entre parênteses.   
 

Primeiro tem de transferir o dinheiro para a Jamaica (10.000€), usando a sua conta bancária normal (com
um saldo de 100.000€). O banco indica uma taxa de câmbio de EUR 1 = JMD 64, mas cobra-lhe 150€
para transferir o dinheiro.

Transferir dinheiro para a Jamaica

Selecione a parcela do banco da Jamaica (9,850.00), clique com o botão direito do rato e selecione Editar
taxa de câmbio
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Um diálogo onde é especificada a taxa de câmbio de uma transação

Como taxa de câmbio, insira 1 EUR = 64 JMD, dado que foi esta a taxa indicada pelo banco. Clique em
Aceitar e grave a transação com parcelas. Eis o aspeto da nova árvore de contas:

Árvore de contas antes de comprar o barco

Encontra o barco e, como é uma pechincha de JMD 509.000. decide comprá-lo. Para registar esta transação
no GnuCash, tem de inserir uma transação simples em Ativos:Ativos atuais:Banco jamaicano, levantando
509.000 J e transferindo-os para Ativos:Ativos fixos:Barco
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Árvore de contas após comprar o barco

A árvore de contas agora reflete que a sua conta bancária viu o valor reduzido em 509.000 J e os seus
ativos fixos aumentados no mesmo valor. Se tiver ativa a coluna "Total (EUR)" verá os montantes corres-
pondentes em euro. Este valor vai usar sempre a última taxa de câmbio que atualizou manual ou automa-
ticamente no GnuCash.

Comprar ações estrangeiras
Este exemplo mostra como comprar ações que estão cotadas numa moeda diferente da predefinida.

Assumindo que vive em New York, terá a moeda predefinida como USD. Decide comprar uma ação
negociada em Hong Kong, cotada em HKD. Também gostaria de controlar os vários montantes de receita
e despesa por ação e por corretor.

Decidiu comprar ações Beijing Airport em Hong Kong (afinal de contas, os jogos olímpicos de 2008 em
Pequim já terminaram e as cotações desceram à Terra).

Nota

As ações mencionadas acima (Beijing Airport) foram escolhidas apenas como exemplo e não
deve entender este exemplo como qualquer espécie de conselho de compra.

Tem de encontrar o símbolo da ação. Para isto, faça um bocadinho de investigação na Internet, em parti-
cular em Yahoo! Finance - Ticker Symbol Lookup [http://finance.yahoo.com/lookup] (http://finance.yaho-
o.com/lookup). Obterá o seguinte:

• Beijing Airport tem o símbolo 0694.HK na Yahoo

Dado que também queremos controlar os vários montantes de receita e despesa, criámos a seguinte estru-
tura de contas:

Ativos:Investimentos:Conta na corretora:Boom:0694.HK     (Beijing Airport)
Ativos:Investimentos:Conta na corretora:Boom:Banco        (HKD)
Capital próprio:Saldos iniciais:HKD                            (HKD)
Despesas:Comissões:Boom.0694.HK                      (HKD)
Receitas:Investimentos:Dividendos:Boom:0694.HK               (HKD)
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Eis o plano de contas após criar todas as contas necessárias:

Árvore de contas para ações internacionais

Pode ver a definição da ação no editor de mercadorias (Ferramentas+Editor de mercadorias).

Mercadorias internacionais

Se ainda não moveu HKD 50.000 para a conta na corretora (Ativos:Investimentos:Conta na corretora:Bo-
om:Banco), faça-o agora, usando a conta de capital próprio (HKD), ou uma conta bancária já existente
(transferência de dinheiro).

Vamos presumir que a cotação de cada ação é de HKD 3. Para registar a compra, abra a conta na corretora
HKD (Ativos:Investimentos:Conta na corretora:Boom:Banco) e insira o seguinte:

Compra de ações
 Ativos:Investimentos:Conta na corretora:Boom:Banco  Levantamento 50.000
 Despesas:Investimentos:Comissão:Boom:HKD Depósito 500
 Ativos:Investimentos:Conta na corretora:Boom:0694  Depósito 49,500 (16,500 shares)

Se o diálogo de taxa de câmbio não abrir automaticamente, clique com o botão direito do rato na linha da
ação e selecione Editar taxa de câmbio. Insira o número de ações (16,500) como Montante de destino.
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Definir o número de ações no diálogo de transferência de fundos

Se voltar à árvore de contas, verá a compra de ações refletida no total da conta de ações:

Árvore de contas com algumas ações internacionais compradas

Contudo, como pode ver, os totais em USD serão zero enquanto o GnuCash não tiver uma taxa de câmbio

entre USD e HKD. Para tal, vá a Ferramentas → Base de dados de cotações e clique em Obter cotações
para obter automaticamente as cotações que necessita.

Nota

Este exemplo mostra como pode comprar ações em qualquer moeda, inserindo a transação no
diário da conta à ordem usada para fazer o pagamento. Também pode inserir a compra no diário
da conta de ações, mas tenha cautela! Ao fazê-lo dessa forma, presume-se que a ação está cotada
na moeda da conta-mãe da conta de ações.
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Neste exemplo, a conta-mãe da conta de ações (Ativos:Investimentos:Conta na corretora:Boom)
está em HKD. Dado que esta é a mesma moeda da cotação da ação, a compra pode ser registada
no diário da conta de ações sem problemas.

Como fazer - controlar investimentos em moe-
da

Investimento em moeda é quando decide investir em moedas de diferentes países, esperando que essas
moedas se valorizem em relação à sua própria moeda.

Quando introduz estas transações no GnuCash, terá de decidir o nível de detalhe que quer ter.

Se não está interessado em detalhes, é suficiente uma estrutura de contas bastante simples:

    Ativos:Investimentos:Moeda:Banco (USD)
    Ativos:Investimentos:Moeda:XXX (XXX)

Mas, se quiser ser capaz de controlar ganhos ou perdas de capital, assim como as várias taxas, tem de criar
uma disposição um pouco mais complexa:

    Ativos:Investimentos:Moeda:Banco                    (USD)
    Ativos:Investimentos:Moeda:Banco da moeda:XXX       (XXX)
    Despesas:Investimentos:Moeda:Banco da moeda:XXX     (XXX)
    Receitas:Investimentos:Banco da moeda:Ganhos de capital:XXX  (XXX)

Onde XXX é a moeda em que está a investir.

Comprar um investimento em moeda
Uma ordem de compra típica seria algo como isto, visto da conta Ativos:Investimentos: Moeda:Banco.

Tabela 10.1. Comprar moeda com um esquema de transação com parcelas

Conta Depósito Levantamento

Ativos:Investimentos:Moe-
da:Banco

Montante investido

Despesas:Investimentos:Moe-
da:Banco da moeda:XXX

Despesa de câmbio

Ativos:Investimentos:Moe-
da:XXX

Montante investido - Despesa de
câmbio

Deverá abrir-se um diálogo para a taxa de câmbio quando sai da última linha da transação de moeda acima.
Se o diálogo de taxa de câmbio não abrir automaticamente, clique com o botão direito do rato na linha da
ação e selecione Editar taxa de câmbio. Insira a taxa de câmbio indicada pelo banco.

Vender um investimento em moeda
Inserir uma venda de moeda é feito da mesma forma que uma compra, exceto que agora está a transferir
dinheiro da conta da moeda para a conta à ordem (muito semelhante a “Vender ações”).
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A venda correta de moeda *tem* de ser feita usando uma transação com parcelas. Nesta, tem de contabilizar
o lucro (ou perda) como vindo da conta Receitas:Ganhos de capital (ou Despesas:Perdas de capital). Para
saldar esta receita, terá de inserir o ativo Moeda duas vezes na transação. Uma para registar a venda real
(com o montante e taxa de câmbio corretos) e outra para saldar o lucro (definindo o montante como 0).

Resumindo, uma transação de venda de Moeda deve parecer-se com isto, de novo visto da conta Ativos:In-
vestimentos:Moeda:Banco:

Tabela 10.2. Vender um investimento em moeda estrangeira com um esquema de
transação com parcelas

Conta Depósito Levantamento

Ativos:Investimentos:Moe-
da:Banco

Montante vendido - Despesa de
câmbio

Despesas:Investimentos:Moe-
da:Banco da moeda:XXX

Despesa de câmbio

Ativos:Investimentos:Moe-
da:XXX

Montante vendido

Receitas:Investimentos:Banco da
moeda:Ganhos de capital:XXX

[PREJUÍZO] LUCRO

Ativos:Investimentos:Moe-
da:XXX

LUCRO (com Montante de desti-
no = 0)

[PREJUÍZO (com Montante de
destino = 0) ]

Como fazer - reconciliar extratos em moeda es-
trangeira

Reconciliar extratos estrangeiros é feito da mesma forma que o extrato do banco local. Se criou uma
estrutura de contas que lhe permite ter a mesma moeda por conta que o seu extrato, é exatamente igual a
reconciliar com o extrato local, fora o fato de que pode precisar de um dicionário.

Se tiver várias moedas, poderá ter de converter os montantes de uma moeda para outra enquanto reconcilia
as contas.

Juntar as peças
Vamos usar aqui bastante do que já aprendemos até agora neste guia, com uma reviravolta. Sendo esta a
utilização de várias moedas diferentes.

Cenário básico
• Vive na Austrália e usa AUD como moeda predefinida

• Ganha a lotaria e herda algum dinheiro

• Paga o seu crédito à habitação existente

• Compra algumas ações na Suécia, usando SEK (Ericsson B-Fria)

• Compra algumas ações em Hong Kong usando HKD (Beijing Airport)
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• Compra algumas ações nos EUA usando USD (Amazon)

• Empresta alguns EURO a um amigo (José da Esquina)

• Pede algum dinheiro emprestado a um banco japonês

• Compra uma casa na Nova Zelândia

• Usa um cartão de crédito na Austrália

• Quer ter o máximo controlo nas suas despesas

Nota

Mais uma vez, estes exemplos não têm nenhuma intenção de serem conselhos válidos de investi-
mento. São apenas para serem considerados exemplos de aplicação das técnicas usadas no Gnu-
Cash, NÃO são conselhos de investimento. Por favor, fale com um consultor financeiro apropri-
ado para investimentos/empréstimos internacionais.

Configurar contas

Desta vez vamos começar com um novo ficheiro de dados do GnuCash, vá a Ficheiro → Novo ficheiro,

e edite as preferências(Editar → Preferências, GnuCash → Preferências em MacOS) para escolher AUD
como moeda predefinida. Uma vez que decidiu controlar o maior número de detalhes de receitas e despesas,
pode usar a seguinte hierarquia de contas:

Ativos:Ativos atuais:Conta poupança         (AUD)
      

Saldo inicial
Uma bela manhã abre o correio e para sua grande surpresa, verifica que é o último parente vivo de um
familiar distante que era podre de rico e que faleceu. E assim, agora tem mais 500.000 AUD. Mas não é
tudo, ainda tem mais uma carta a comunicar-lhe que ganhou uma lotaria de 250.000 AUD.

Para registar estas transações, precisamos das seguintes contas:

Capital próprio:Lotaria  (AUD)
Capital próprio:Herança (AUD)      
      

As transações que inserir na conta Ativos:Ativos atuais:Conta poupança devem parecer-se com isto:

Tabela 10.3. Recebeu algum dinheirinho extra

Conta Aumento Diminuição

Capital próprio:Lotaria 250.000

Capital próprio:Herança 500.000

E a árvore de contas deve parecer-se com esta após inserir as transações acima.
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Árvore de contas após receber algum dinheirinho

Compra de uma casa

Por fim pode acabar de pagar aquele crédito à habitação que contraiu há alguns anos atrás (com um depósito
de 50.000).

Ativos:Ativos fixos:Casa                  (AUD) 300.000
Passivo:Empréstimos:Hipoteca                 (AUD) 250.000
Despesas:Juros:Juros da hipoteca        (AUD)
Capital próprio:Saldo inicial                     (AUD) 50.000
      

Após ter uma breve conversa com o banco do crédito à habitação, eles concordaram em receber o paga-
mento total do crédito, mais alguns juros (AUD 30.000). Deve inserir a seguinte transação com parcelas
na conta Ativos:Ativos fixos:Casa.

Tabela 10.4. Pagamento do crédito à habitação

Conta Aumento Diminuição

Ativos:Ativos atuais:Conta pou-
pança

280.000

Despesas:Juros:Juros da hipoteca 30.000

Passivo:Empréstimos:Hipoteca 250.000

O diário da conta Passivo:Empréstimos:Hipoteca parece-se com esta imagem, após ter inserido as tran-
sações:

Diário de transações do empréstimo da casa
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Comprar ações
Uma vez que de repente se vê com muito dinheiro na conta bancária, decide visitar um consultor financeiro
e, após as suas recomendações (lembre-se que isto é ficção, NÃO são conselhos de investimento), decide
comprar telecomunicações (Ericsson na Suécia), Beijing Airport (Hong Kong), e Amazon (USA).

As contas necessárias para controlar estes investimentos são as seguintes:

Ativos:Investimentos:Corretor sueco:ERIC.ST                 (AÇÃO ERIC.ST Yahoo)
Ativos:Investimentos:Corretor sueco:Banco                    (SEK)
Ativos:Investimentos:Corretor HK:0694.HK                      (AÇÃO 0694.HK Yahoo)
Ativos:Investimentos:Corretor HK:Banco                         (HKD)
Ativos:Investimentos:Corretor EUA:AMZN                         (AÇÃO AMZN Nasdaq)
Ativos:Investimentos:Corretor EUA:Banco                         (USD)
Despesas:Investimentos:Comissões:Corretor sueco:ERIC.ST   (SEK)
Despesas:Investimentos:Comissões:Corretor HK:0694.HK        (HKD)
Despesas:Investimentos:Comissões:Corretor EUA:AMZN           (USD)
Despesas:Investimentos:Transferência de dinheiro                    (AUD)

Decide investir 100.000 AUD em cada empresa e para tal, tem de fazer uma transação de moeda para cada
uma das contas bancárias associadas à ação.

A transação que insere na sua conta Ativos:Ativos atuais:Conta poupança fica assim:

Tabela 10.5. Transferência de dinheiro para outros continentes em transação com
parcelas em diferentes moedas.

Conta Depósito Levantamento Taxa de câmbio Taxa da transação

Ativos:Investimen-
tos:Corretor sue-
co:Banco

100.000 5.5869 35

Ativos:Investimen-
tos:Corretor
HK:Banco

100.000 5.8869 30

Ativos:Investimen-
tos:Corretor EU-
A:Banco

100.000 0.7593 25

Agora que já tem dinheiro nas várias contas de corretoras de ações, pode pedir aos corretores para compra-
rem ações para o montante especificado. Lembre-se de executar a transação da conta bancária associada
com a ação e, se a janela da taxa de câmbio não aparecer, clique com o botão direito do rato e selecione-a
manualmente. Insira o número de ações compradas no último campo (Montante de destino:).

Tabela 10.6. Comprar ações estrangeiras

Símbolo da ação Número de ações Montante Comissão

ERIC.ST 15.000 270.000 400

0694.HK 70.000 280.000 300

AMZN 1.000 32.000 25

Tal como pode ver na árvore de contas, comprou ações em três moedas diferentes (HK, USD, e SEK), mas
a árvore de contas (como se vê abaixo) não indica quanto valem na sua moeda, AUD.
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Árvore de contas após a compra de ações

A secção seguinte vai garantir que obtém as várias taxas de câmbio para que o GnuCash possa mostrar o
seu valor total na moeda local (neste caso o AUD).

Obter as cotações online

Para obter as cotações e taxas de câmbio atuais, vá a Ferramentas → Base de dados de cotações e clique
em Obter cotações.

Emprestar dinheiro a um amigo
O José da Esquina está com dificuldades no continente europeu. Como é um grande amigo seu, decide
ajudá-lo com um empréstimo pessoal de 40.000€.

Ativos:Dinheiro que me devem:Euro:José da Esquina            (Euro)
Receitas:Juros Receitas:José da Esquina                  (Euro)
Despesas:Taxa bancária                      (AUD)
        

Esta é uma transação simples de moeda a partir da sua conta poupança para a conta Ativos:Dinheiro que
me devem:José da Esquina (EURO). Obteve a taxa de câmbio de 0.606161, o que significa que tem de
levantar AUD 65,989.10. Assim como tem de pagar a taxa de serviço no valor de 35 AUD.

Comprar uma propriedade na Nova Zelândia com um
empréstimo no Japão

O seu amigo japonês de longa data ofere-khe um empréstimo para compra de casa se comprar uma pro-
priedade no estrangeiro, com um depósito de apenas AUD 50.000. Após ter discutido o assunto com o seu
consultor financeiro na Austrália, decide aceitar a oferta.

147



Múltiplas moedas

Nota

Mais uma vez, isto NÃO deve ser entendido como conselho de investimento. Por favor, fale com
um consultor financeiro registado antes de investir ou especular em mercados estrangeiros, ou
mesmo locais, já agora.

Uma palavra de aviso, contrair um empréstimo no estrangeiro com uma taxa de juro baixa pode
parecer um bom negócio. Mas lembre-se que as taxas de câmbio podem mudar, por vezes dras-
ticamente. Se contraiu um empréstimo na sua moeda local, só tem de se preocupar com a taxa
de juro. Com um empréstimo no estrangeiro, tem de se preocupar com a taxa de juro e com a
taxa de câmbio.

Encontrou uma pequena vivenda numa vila costeira perto de Auckland, que seria a casa de Verão perfeita
e decide usar o dinheiro do Japão para a comprar.

Precisaria das seguintes contas para este exemplo:

Passivo:Empréstimos:Empréstimo japonês             (JPY)
Despesas:Juros:Empréstimo japonês                  (JPY)
Despesas:Taxas da hipoteca:Empréstimo japonês      (JPY)
Ativos:Ativos atuais:Banco japonês                 (JPY)
Ativos:Ativos fixos:Casa na NZ                     (NZ)

Tabela 10.7. Compra de uma casa na NZ com uma transação com parcelas

Conta Aumento Diminuição

Ativos:Ativos fixos:Casa na NZ 300.000 (NZD)

Ativos:Ativos atuais:Conta pou-
pança

50.000 (AUD) (1.18926)

Passivo:Empréstimos:Emprésti-
mo japonês

28.000.000 (JPY) (0.0137609)

Despesas:Taxas da hipoteca:Em-
préstimo japonês

300.000 (JPY) (0.0137609)

O que é que se segue?
Como viu pelos exemplos acima, só fez as compras iniciais. O resto, ou seja, as várias transações de venda
e ganhos não realizados, deixamos à sua ponderação.
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Parte III. Gerir as finanças da empresa

Os capítulos relativos a negócios ainda
não estão traduzidos. Se tiver interesse

em colaborar na tradução, consulte Gnu-
cash wiki: How to translate the GnuCash
guide and/or help files [http://wiki.gnu-

cash.org/wiki/Translation#How_to_transla-
te_the_GnuCash_guide_and.2For_help_files]

http://wiki.gnucash.org/wiki/Translation#How_to_translate_the_GnuCash_guide_and.2For_help_files
http://wiki.gnucash.org/wiki/Translation#How_to_translate_the_GnuCash_guide_and.2For_help_files
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Capítulo 11. Business Introduction
Introduction to Business Features

The accounting needs of a business are quite different from that of a person. Businesses have customers
that owe money, vendors which are owed money, employee payroll, more complex tax laws, etc. GnuCash
offers business oriented features to facilitate these needs.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately
paid. This is represented on the balance sheet as an asset, because the expectation is that you will receive
payment soon.

Accounts Payable (A/P) record bills that businesses have received, but may not pay until later. This is
represented on the balance sheet as a liability because you will have to pay for them.

A/R and A/P accounts are used primarily when you have a lot of bills and receipts flowing in and out, and
do not want to lose track of them just because you do not pay or get paid right away. For most home users,
A/R and A/P are too complicated to be worthwhile.
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Capítulo 12. Business Setup
To set up GnuCash to handle accounts receivable or accounts payable for a company, these preliminary
steps must be done.

• Build an appropriate Account Hierarchy.

• Set up Tax Tables.

• Register the company in GnuCash.

• Set Business Preferences.

• Set up Billing Terms.

Account Setup
There are many different ways to set up a business account hierarchy. You can start with the Business
Accounts setup which is available from the New Account Hierarchy assistant, or you could build one

manually. To access the prebuilt Business Accounts, start GnuCash and click on File → New File and
proceed until you see the list of available accounts, select Business Accounts.

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need make adjust-
ments for the hierarchy to function well with your particular situation. It should be close enough that it
is recommended you begin with it.

To use GnuCash’s integrated accounts receivable system, you must first set up an account (usually a sub-
account under Assets) defined with account type A/Receivable. It is within this account that the integrated
A/R system will place transactions.

To use GnuCash’s integrated accounts payable system, you must first set up an account (usually a sub-
account under Liabilities) defined with account type A/Payable. It is within this account that the integrated
A/P system will place transactions.

Basic A/R and A/P Account Hierarchy:

-Assets
   -Accounts Receivable
   -Checking
-Expenses
  ...(as required)
-Income
   -Sales
-Liabilities
  -Accounts Payable
  -Tax
      -Tax on Purchases
      -Tax on Sales
  

You need to add additional accounts to this hierarchy for it to be useful.
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Nota

You do not need to create an individual A/R account for each customer. GnuCash keeps track of
customers internally and provides per-customer reports based on the internal tracking. The same
applies to A/P and vendors.

If you deal with customers in more than one currency you will need a separate Accounts Recei-
vable account for each currency.

If you deal with vendors in more than one currency you will need a separate Accounts Payable
account for each currency.

Transactions involving an Accounts Receivable or Accounts Payable account should not be ad-
ded, changed or deleted in any way other than by using

• post/unpost bill/invoice/voucher or

• process payment

Tax Tables
Tax Tables can used to determine the tax for customer invoices (or vendor bills).

A tax table can be assigned to an invoice line or bill line.

Set up distinct tax tables for customers and vendors.

The default invoice line tax table can be assigned to each customer and the default bill line tax table can
be assigned to each vendor.

The default tax table for new customers or new vendors can be specified in the Book Options  window

which can be accessed by File → Properties → Business tab.

Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu Business → Sales
Tax Table.

Figura 12.1. Tax Tables

154



Business Setup

Figura 12.2. New Sales Tax Table

• Name This is the tax table name.

• Type Either Percent % or Value $ .

• Value This is the percentage or value depending on Type.

• Account This is the account to which tax will be posted. For tax collected from customers, this should
probably be a Liability account as it must be payed to the government. For tax paid to vendors, if tax
laws allow tax paid to vendors to offset tax collected from customers, this should probably also be
a Liability account (even though it will usually have a debit balance) so that the net tax owed to the
government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will
be rolled up and can be seen in the GnuCash Accounts tab.

If unsure about tax law requirements, get professional advise.

Company Registration
After you have built the account structure and defined your tax tables, register the GnuCash file as belon-
ging to your company. To register your company, select the Business tab in the Book Options window

accessible by selecting File → Properties.
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Figura 12.3. Company Registration

Here you can:

• Enter the name of your company along with contact information such as your phone number, fax number,
e-mail address and website URL.

• Enter your company’s tax payer id number in the Company ID field.

156



Business Setup

• Select default tax tables applicable to your most common customers and vendors.

Business Preferences
Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences

(GnuCash → Preferences on MacOS). See Help manual chapter 10.3.3 Business Book Options Tab.

Billing Terms
Billing Terms can be used to determine the payment due date and be a guide for determining discount for
early payment of invoices (or vendor bills).

Nota

As of GnuCash 2.6.7, Billing Terms are only partially supported. Date due is calculated using the
Billing Terms but discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done,
although neither is recommended, and professional advise should be used to confirm that regu-
lations are being complied with:

• After creating and posting a payment which pays the invoice in full, manually edit the payment
transaction (usually strongly discouraged) and split the payment to reduce it by the amount of
the discount and a create a compensating split in an income (discount) account.

• Alternatively, after creating and posting a payment for the discounted amount, create a credit
note for the discount using a specific negative sales income (discount) account for the transfer
account.

You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the customer
billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business →
Billing Terms Editor.

Figura 12.4. Billing Terms Editor
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Figura 12.5. New Billing Term

• Name The internal name of the billing term. For some examples of billing term names and descriptions
see http://wiki.gnucash.org/wiki/Terms.

• Description The description of the billing term, printed on invoices

• There are 2 types of billing terms, with different information to be entered

• Type Days

• Due Days The invoice or bill is due to be paid within this number of days after the post date

• Discount Days The number of days after the post date during which a discount will be applied for
early payment

• Discount % The percentage discount applied for early payment

• Type Proximo

• Due Day The day of the month bills are due

• Discount Day The last day of the month for the early payment discount

• Discount % The discount percentage applied if paid early

• Cutoff Day The cutoff day for applying bills to the next month. After the cutoff, bills are applied
to the following month. Negative values count backwards from the end of the month.
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Capítulo 13. Accounts Receivable
Accounts Receivable (or A/R) refers to products or services provided by your company for which payment
has not yet been received.

Initial Setup
Perform set up tasks listed in Capítulo 12, Business Setup.

System Components
GnuCash has an integrated accounts receivable system. The transactions generated by the A/R system are
recorded within the Accounts Receivable account. You generally do not work directly with this account.
You generally work with the four integrated GnuCash A/R application components available through the

Business → Customer sub-menu. These four components are:

• Customers are people or companies to whom you sell products or services on credit.

• Invoices represent the physical invoice you send to a customer to request payment. This invoice contains
an itemized list of things you sold.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Invoices. A credit
note is usually handed to a customer to correct items that were incorrectly invoiced or returned.

Both document types will be set up using the same menu items. Credit notes were introduced starting
with GnuCash stable release 2.6.0.

• Jobs (optional) is where you register Customer Jobs. Jobs are a mechanism by which you can group
multiple invoices to a particular customer.

• Process Payments is used to register payments you received from a customer.

Customers
Customers are people or companies to whom you sell goods or services. They must be registered within
the A/R system.

New

To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer
information, such as Company Name, Address, Phone, Fax, etc.
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New Customer Registration Window

Find and Edit

To search for an existing customer, use the Business → Customer → Find Customer window. You select
a customer to View/Edit from the results of the search. This window is also used to look up customers
when creating invoices and processing payments.
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Find Customer Window

If many customers match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the customer is not in the result of the original search, and you only search within this set, the customer
cannot be found, regardless of new search criteria.

Nota

To return a list of all registered active customers, set the search criterion to matches regex, and
place a single dot "." in the text field area. Make sure Search only active data is checked, then
click Find. The regular expression "." means to match anything.

Invoices
An invoice is the paperwork you send to a customer to request payment for products or services rendered.
GnuCash can generate and track invoices.

A credit note is the paperwork you send to a customer to correct products or services rendered that were
incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries as invoices.

Nota

This section applies to both invoices and credit notes. In order to avoid repeating everything
twice and to keep the text easier to read it will refer only to invoices. You can apply it equally to
credit notes. Only where the behaviour of credit notes differs from invoices this will be explicitly
mentioned.

New

To send an invoice to a customer you must first create the new document. To create an invoice use Business

→ Customer → New Invoice. The New Invoice window must be filled in appropriately.
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Creating a New Invoice

When you click the OK button, the Edit Invoice window opens.

Edit
From the Edit Invoice window you can enter an itemized list of goods and services you sold on this invoice
in a manner similar to how the account register works. For credit notes you enter an itemized list of goods
and services you refunded instead.

Edit Invoice Window
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When you have finished entering all the items, you can Post and print the invoice.

Post
When you finish editing an invoice and are ready to print, you must Post the invoice. The invoice does
not have to be posted immediately. In fact, you should only post an invoice when you are ready to print it.
Posting an invoice places the transactions in an accounts receivable account.

Post Invoice Window

Find

To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results
of the search, you can select an invoice to edit or view.

Nota

Before you can edit a posted invoice, you will need to Unpost it.

One of the design goals in GnuCash’s Account Receivable system was to allow different processes to get
to the same state, so you can reach an invoice from different directions based on the way you think about
the problem:

• You can search for the customer first, then list their invoices.

• You can search for invoices by number or by company name.

• You can list invoices associated with a customer job.

Print
After you post an invoice, you should print it and send it to your customer. To print an invoice use File

→ Print Invoice menu item.
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Invoice Print Output

Nota

You can modify the appearance of the invoice, IE: add a company logo, etc. To do so, see the
“Changing the Invoice Appearance”.

Invoices can also be printed from the main window by selecting Reports → Business Reports → Printable
Invoice from the main menu. The resulting report window states that no valid invoice is selected. To select
the invoice to print:

1. Use the Options Toolbar button or select Edit → Report Options from the main menu.

2. Select the General tab of the report options dialog.

3. Click the Select button next to the Invoice Number field.

4. Search for the invoice as usual.

You can also print invoices from within the Process Payment dialog. See the “Process Payment” for ins-
tructions on how to do so.

Assign Starting Invoice Number
By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an
invoice number into the text box each time you create an invoice, but this gets tiring and sooner or later
leads to duplicate numbers.

You can change the starting invoice number if it is important you. Use File → Properties, access the
Counters tab, change the Invoice number value to be one less than your desired starting invoice number
and click the OK button or the Apply button.

Customer Jobs
Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the
Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same customer,
and would like to view all the invoices and credit notes related to a single job.
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New Customer Job

To use customer jobs, you must create them using the Business → Customer → New Job menu item. You
will see the New Job window.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired
job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer → Find
Job menu item. Select the desired job in the search results and click the View Invoices button. A window
listing invoices and credit notes associated with this job appears. Select an invoice or credit note and click
the View Invoice button to open an invoice editor in the main application window.

Process Payment
Eventually, you will receive payment from your customers for outstanding invoices. To register these

payments, use the Process Payment application found in Business → Customer → Process Payment.
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Process Payment Window

Changing the Invoice Appearance
The default Invoice style, as shown in “Print”, is fairly barren. The default invoice style leaves the top
part of the form blank, so you can print on company letterhead paper. There are some things you can do
to change invoice appearance.

Use File → Properties to enter your Company informations in the Business tab of the Book Options win-
dow. Some of the entered informations are printed on the right side of invoices.

To add a customized background, heading banner or logo to invoices, modify the invoice style sheets. To

do this, go to Edit → Style Sheets and select the New button in the Select HTML Style Sheet window that
will appear. You will then see a window like this:

The New Style Sheet window.

Give a Name to the new style sheet (e.g. Custom Invoice) and select the Fancy Template. When you click
the OK button, the HTML Style Sheet Properties window is displayed. This window presents you five
sections listed in the left pane: Colors, Fonts, General, Images, and Tables. The Colors section allows
you to change the colors of various items of the invoice. The Fonts section lets you set fonts type and
dimensions. The General section allows you to set the Preparer and Prepared for information, and to Enable
Links. The Images section allows you to import graphics into the style sheet. The Tables section allows
you to adjust the spacing around the tables which make up the invoice.

To include a company logo, banner heading and background image, use your favorite graphics application
such as The Gimp or OpenOffice Draw to save the images in either GIF or PNG format. Then import them
into the style sheet using the Images section described above.
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Below is an example that imports all three types of images.

The HTML Style Sheets window with an example Background Tile, Heading Banner, and Logo.

Nota

The images are placed in the invoice as follows. The Background Tile is tiled to become the
background image, the Heading Banner goes to above the invoice text, and the Logo is placed in
the upper left corner of the invoice to the left of the Heading Banner. You will probably have to
try a few different sized images until you get the invoices to print nicely. Some sizing suggestions
are that the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm
(~6 inches) wide and 1 cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you select the style sheet to use from the
Options menu. Below is the resultant invoice after applying the style sheet demonstrated above.

The hideous invoice which results from the graphics selected in the style sheet.
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Capítulo 14. Accounts Payable
Accounts Payable (or A/P) refers to the accounting of products or services which a company has bought
and needs to pay for.

Initial Setup
Perform set up tasks listed in Capítulo 12, Business Setup.

System Components
GnuCash has an integrated accounts payable system. The transactions generated by the A/P system are
placed within the Accounts Payable account, as a record of what occurs. Generally you do not directly work
with this account but use the four integrated GnuCash A/P application components. The A/P components

are available from the Business → Vendor sub-menu. These A/P components are:

• Vendors are people or companies from which you buy products or services on credit.

• Bills represent the physical bills vendors send to request payment from you. A bill contains an itemized
list of things you purchased.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Bills. A credit
note is usually received from a vendor to correct items that were erroneously billed or returned.

Both document types will be set up using the same menu items.

• Jobs (optional) is where you register Vendor Jobs. Jobs are mechanism by which you can group multiple
bills from a particular vendor.

• Process Payments is where you register payments to a vendor to whom you owe money.

The following sections introduce the individual Accounts Payable application components.

Vendors
A vendor is a company or person from whom you purchase goods or services. Vendors must be registered
within the A/P system.

New

To register a new vendor, select the Business → Vendor →  New Vendor menu item. Fill in general
information about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of the
other options:

This is what the New Vendor registration window looks like:
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New Vendor Registration Window

Find and Edit

To search for an existing vendor, use the Business → Vendor →  Find Vendor window. You select a
vendor to View/Edit from the results of the search. This window is also used to look up a vendor when
entering bills and processing payments.
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Find Vendor Window

If many vendors match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the vendor you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the vendor is not in the result of the original search, and you only search within this set, the vendor
cannot be found, regardless of new search criteria.

Nota

To return a list of all registered active vendors, set the search criterion to matches regex, and place
a single dot “.” in the text field area. Make sure Search only active data is checked, then click
Find. The regular expression “.” means to match anything.

Bills
A bill is a request for payment you receive from a vendor. GnuCash can track bills.

A credit note is the document you receive from a vendor to correct products or services rendered that you
were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same menu
entries as bills.

Nota

This section applies to both bills and credit notes. In order to avoid repeating everything twice and
to keep the text easier to read it will refer only to bills. You can apply it equally to credit notes.
Only where the behaviour of credit notes differs from bills this will be explicitly mentioned.

New

When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill. To

create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window
appropriately.

170



Accounts Payable

New Bill Registration Window

When you click the OK the Edit Bill opens.

Edit

From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a manner
similar to how the account register works. For credit notes you enter an itemized list of goods and services
the vendor refunded instead.
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Edit Bill Window

When you have finished entering all the items, Post the bill.

Post

When you finish editing a bill, you should Post the bill. You do not have to post the bill, you can close
it and return to it later. You have to post the bill eventually. Posting a bill places its transactions into an
accounts payable account. The Post Bill window appears and asks you to enter information:

Post Bill Window

Find

To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the search,
you can select a bill to edit, or view.
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Nota

Before you can edit a posted bill, you will need to Unpost it.

Nota

There are other ways to access an existing bill. These are similar to accessing invoices for your
customers. See “Find” for more information.

Vendor Jobs
Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor jobs
feature is optional. The feature is useful when you have multiple jobs for the same vendor, and would like
to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You
will see the New Job window.

New Vendor Job

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job
in the search results, and click the View/Edit Job button.

To select from the bills associated with a given job, use Business → Vendor → Find Job menu item. Select
the desired job in the search results and click the View Invoices button. A window listing bills and credit
notes associated with this job appears. Select a bill or credit note and click the View Invoice button to
open a bill editor in the main application window.
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Process Payment
Eventually, you need to pay your bills. To do so, use the Process Payment application found in Business

→ Vendor → Process Payment.

Below is the GnuCash Accounts Receivable payment window.

Process Payment Window
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Capítulo 15. Payroll
Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. This chapter
demonstrates how to track payroll using GnuCash

Basic Concepts
Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. Basically,
anything that relates to giving money or benefits to an employee. Payroll is one of the more complex tasks
in accounting, because there are many different accounts, people, and agencies involved in paying salaries.

Payroll is typically accounted for as an expense. Sometimes accountants “store” some payroll expenses
in a short term liability account. This is useful for things such as payroll taxes, which may be paid at a
different time than the employee. The employee might get paid biweekly, while taxes are paid quarterly.
This chapter presents a methodology which expenses payroll immediately for salaries, but stores taxes in
liability accounts.

Nota

GnuCash does not have an integrated payroll system. While you can track payroll expenses in
GnuCash, the calculation of taxes and deductions has to be done outside of GnuCash.

Account Setup
Local tax law must be considered when setting up accounts. Because there are many different ways payroll
taxes are handled throughout the world, this section presents a very simple structure. From this, you should
be able to adapt your particular payroll deductions setup.

Assume that you must pay 2 taxes, Tax1 and Tax2 and that each has an employee contributed and an
employer contributed component.

The employee’s salary and these two taxes are expense accounts. The tax components are liability accounts.
The tax liability accounts are where you accumulate the taxes withheld for all of your employees. The
taxes are later paid to the appropriate government agency.

Simple Payroll Account Layout:

-Assets
   -Checking
-Liabilities
   -Tax1  (short term “storage” account)
   -Tax2  (short term “storage” account)
-Expenses
   -Salaries
   -Tax1
   -Tax2
  

Nota

Resist the temptation to create per-employee sub-accounts to track individual salaries. Creating a
sub-account for each employee leads to unmanageably large lists of accounts. Imagine the account
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structure after a few years of employees coming and going. It is much simpler to keep all of
your employees’ payroll records within a single account (Expenses:Salaries for example) and use
reports to view per-employee information.

Protocol
GnuCash does not have an integrated payroll system. GnuCash can track your payroll expenses, but you
need to develop a payroll protocol and perform the calculations outside of GnuCash, in a spreadsheet for
example. In this section, one such protocol is presented. You can use the sample protocol as a model.

Step 1: Deductions list
The first step to the payroll protocol is to create a list of all the possible taxes and deductions for each
employee. Each entry should include definitions and formulas for calculating each value. Once the protocol
is established it needs to be changed only when payroll laws or tax rates change.

In the proposed scenario, such a list would look like this:

• E_GROSS_SALARY - Employee gross salary
• E_TAX1 - Employee contribution to tax1 (X% of E_GROSS_SALARY)
• E_TAX2 - Employee contribution to tax2 (X% of E_GROSS_SALARY)
• C_TAX1 - Company contribution to tax1 (X% of E_GROSS_SALARY)
• C_TAX2 - Company contribution to tax2 (X% of E_GROSS_SALARY)

Nota

The employee’s net salary (E_NET_SALARY) is defined as E_GROSS_SALARY - E_TAX1 -
E_TAX2 and need not be placed in this list since it is composed of items that already exist.

Place the actual formulas for calculating each deduction in this list. Sometimes these formulas are quite
complex, and sometimes they simply say "look it up in table XYZ of the tax codes".

Notice that you can calculate some interesting values using the above definitions. One such value is the
total cost to the company: E_GROSS_SALARY + C_TAX1 + C_TAX2.

Step 2: Create the Transaction Map
When you record payroll in GnuCash, do so with a single split transaction. This split transaction populates
the appropriate expense and liability accounts. If you need to look the payroll details at a later time, open
the split transaction.

With the deductions list from above, an employee split transaction map can be generated. Each of the items
in the list is mapped to a GnuCash account.

Tabela 15.1. Transaction Map

Account Increase Decrease

Assets:Checking E_NET_SALARY

Expenses:Salaries E_GROSS_SALARY

Liabilities:Tax1 E_TAX1
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Account Increase Decrease

Liabilities:Tax2 E_TAX2

Expenses:Tax1 C_TAX1

Liabilities:Tax1 C_TAX1

Expenses:Tax2 C_TAX2

Liabilities:Tax2 C_TAX2

Note that the C_TAX1 and C_TAX2 components have entries in the both the liability and expense ac-
counts. The company component of each tax is expensed at the time of payroll, but remains a liability
until taxes are due.

Step 3: Pay the Employee

Go to the account from which the employee will be paid, for example your Assets:Checking account. Open
a split transaction and enter the real values using the Transaction Map above as a guide. Repeat this for
all employees.

Dica

This manual process is tedious, especially if you have a large number of employees.

One GnuCash tool you certainly want use when entering employee payroll is duplicate transaction
(use the Duplicate Toolbar button). This saves you from having to enter all the transaction splits
for each employee. You still need to change the amounts of money to match each employee’s
real payroll values, but you will not have to build the split for each employee.

If payroll transactions do not change significantly every pay period, you can also use the duplicate
transaction feature to duplicate each employee’s most recent payroll transaction for the current
pay period. If you find you are doing so all the time, read about the Schedule Transactions feature
and save even more time!

Step 4: Pay the Government

The final thing to do is to pay the taxes to the government. The liability accounts have been collecting the
taxes for various government agencies, and periodically you need to send a check to the government to
pay this charge. To do so, you simply enter a 2 account transaction in (for example) your checking account
to pay off the tax liability. The transaction is between the checking account and the liability account, no
expense account is involved. The expense accounts are charged at the time the tax liability is recorded.

Example
Using the account setup seen previously, let’s go through an example. Assume that there are 2 employees
(E1 and E2) which each earn $1000 per month gross salary. The employee contribution to Tax1 and Tax2
are 10% and 5% respectively. The company contribution to Tax1 and Tax2 are 15% and 10% each on top
of the employees gross salary.

Staring with $50k in the bank, and before doing any payroll, the account hierarchy looks like this:
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Payroll Initial Setup

Build Protocol
The deductions list for employee 1:

• E_GROSS_SALARY - Employee gross salary - $1000

• E_TAX1 - Employee contribution to tax1 - $100 (10% of E_GROSS_SALARY)

• E_TAX2 - Employee contribution to tax2 - $50 (5% of E_GROSS_SALARY)

• C_TAX1 - Company contribution to tax1 - $150 (15% of E_GROSS_SALARY)

• C_TAX2 - Company contribution to tax2 - $100 (10% of E_GROSS_SALARY)

Tabela 15.2. Transaction Map for Employee 1

Account Increase Decrease

Assets:Checking $850 (E_NET_SALARY)
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Account Increase Decrease

Expenses:Salaries $1000 (E_GROSS_SALARY)

Liabilities:Tax1 $100 (E_TAX1)

Liabilities:Tax2 $50 (E_TAX2)

Expenses:Tax1 $150 (C_TAX1)

Liabilities:Tax1 $150 (C_TAX1)

Expenses:Tax2 $100 (C_TAX2)

Liabilities:Tax2 $100 (C_TAX2)

Pay an Employee

Now, enter the first split transaction for employee 1 in the checking account. The split transaction looks
like this:

Employee 1 Split Transaction

Dica

When paying employees, enter only the employee name in the Description area. If you decide
to use GnuCash’s check printing capabilities, the check is automatically made out to the correct
employee. If you want to record other information in the transaction besides the employee name,
use the Notes area, available when viewing the Register in double-line mode.

Repeat this for the second employee, which leaves the account hierarchy looking like this:
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Account Tree After Salaries Paid

Pay the Government

The Liabilities:Tax1 and Liabilities:Tax2 accounts continue to track how much you must pay to the go-
vernment agencies responsible for each. When it is time to pay these agencies, make a transaction from
the checking account to the liability accounts. No expense accounts are involved. The main account will
then appear like this for this example:
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Accounts After Paying Government
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Capítulo 16. Budgets
This chapter explains how to create and use budgets with GnuCash.

Basic Concepts
A budget is a tool for estimating expected income and expenses. You can use it to help you plan how
you intend for your finances to change over a period of time, and to examine how your actual financial
transactions for the period compare to your planned transactions.

The budgeting concept is quite general, so GnuCash offers a budgeting tool that is both simple and flexible.
You, the user, have to decide how complex or simple you want to make your budget. This guide will help
you make some of those decisions.

Terminology
There are a few helpful terms listed below that will be used to discuss budgeting.

• Budget - A financial plan describing the expected revenues and/or disbursements for a particular time
period

• Cash Budget - A budget planning for expected cash receipts and cash disbursements. This type of budget
tracks cash flow -- where your money comes from, where it goes, and, of course, how much.

• Expense Budget - A budget chiefly for planning what you spend your money on. This type of budget
tracks your expenses. It is typically not concerned with things like appreciation or repayment of liabili-
ties. However, it would account for interest charges. For example, if you buy $100 worth of groceries
with your credit card, you incur an $100 expense for groceries, and a $100 liability to your credit card
company. When you pay the credit card bill for $110, you are incurring an additional interest expense
of $10. An expense budget plans for the transaction of buying the groceries and paying the interest, but
not the transaction of repaying the credit card company.

• Capital Budget - A budget that describes a plan for paying for a large future expense, often through a
combination of saving and borrowing money. Note: Capital budgets can sometimes get quite complex
because they can try to answer the question "Can we afford to do such-and-such?" by exploring various
hypothetical scenarios that can involve hypothetical accounts.

• Budget Period - The period of time during which the plan is expected to take place. The most common
budget periods are annual and monthly. Sometimes, you may budget for several consecutive periods
at once, for convenience or for finer-grained planning. For example, an annual budget may include 12
monthly budget periods.

Creating a Budget
Even before you begin to make a budget, it’s important to have given some thought to your account
hierarchy. For example, if you want to budget a certain amount for your electric bill and a certain amount
for your water bill, you can’t have only an Expenses:Utilities account. Your accounts must be at least as
specific as your budget.

Choose Which Accounts To Budget For
The first step in creating a budget is to decide what it is you want to plan for. This decision will affect which
accounts you include in your budget. For example, if you are only interested in tracking your expenses,
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you may create an expense budget by only entering amounts for expense accounts. On the other hand, if
you want to track all of your cash flow, you may create a cash flow budget by entering amounts for asset,
liability, income and expense accounts.

Before you begin to create your budget, you need to make two decisions: What accounts do I want to
budget for? and When do I want my budget to be for? You can always change your mind later, after you’ve
created a budget, but you need to start with something.

Dica

As a rule of thumb, if you mostly care about what you spend your money on, you may want to
make an expense report. If you’re also concerned about having enough money in the right places
at the right times, you may want to use a cash-flow budget.

Choosing a Budget Period
Before creating a budget you must also decide what period of time you want to plan for. The most common
budget periods are monthly and annual. If you want your budget to plan for changes in financial patterns
over time, then you should include multiple budget periods in your budget. For example, if you want to
plan on having higher utility expenses in the winter than in the summer, then you might break your annual
budget into 4 quarters or even 12 months, and budget a higher value for the winter periods than for the
summer periods.

Getting Started

To create your first budget click on Actions → Budget → New Budget. You will immediately see a new
budget with the default settings and no entries. Then click on the Options button. The most important
options are the budget period and the number of periods. For the budget period, choose the beginning date
and the smallest period of time that you want to plan for. Then, for the number of periods, choose how
many periods you want to plan for.

The budget page now shows a list of accounts with a column for each budget period. The date shown in
the title of each column is the beginning of that budget period.

Entering Budget Values
Now, you must enter the budget values - the amounts that you expect the account balances to change
during the budget period. There are two ways to enter budget values. The first way is to simply click on
the cell and enter an amount.

If you have past transactions recorded in GnuCash, the second way is to let GnuCash estimate the budget
values by looking at those transactions. First, select the accounts you want GnuCash to estimate. Then click
on the Estimate Toolbar button. In the Estimate Budget Values dialog, select the date past which GnuCash
should look for past transactions. GnuCash will start at that date and look forward for the duration of your
budget. For example, if you are making an annual budget, and you select Jan. 1, 2005, GnuCash will look
at all the transactions in that account from Jan. 1, 2005 through Dec. 31, 2005.

Budget Reporting
You’ve already done the hardest part - creating your budget. But now you want to know how your actual
financial transactions compare to your plan. You need to run the Budget Report.

183



Budgets

Click on Reports → Budget → Budget Report. For each account, the Budget Report will show the budgeted
and the actual amounts in two adjacent columns for each period in the budget. If you have created multiple
budgets, you can use the Budget Report Options to select which budget to use in the report.

Two other types of budget reports are commonly used in the small business setting. They are the Budgeted
Income Statement and the Budgeted Balance Sheet.

Budgeted Income Statement
The budgeted income statement is similar to the income statement. Both show the revenues and expenses
for a given period as well as the profit, which is the difference revenue - expenses. The income statement is
based on historical data, but the budgeted income statement is based on the predictions made in the budget.

Budgeted Balance Sheet
The budgeted balance sheet is similar to the balance sheet. Both show the assets, liabilities, and equity.
The difference is that the balance sheet is based on historical data, and the budgeted balance sheet is based
on the predictions made in the budget.
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Capítulo 17. Other Assets

General Concepts
This chapter presents many additional accounting treatments for frequently encountered business and less-
frequently found personal activities that need recording in accounting books. The explanations below cover
both the description and purpose of the activity, and they include also the usual accounting treatments
(bookings or recordings) for these transactions.

These concepts have evolved over centuries of experience by those keeping accounting records and will
help you maximize your record keeping’s utility and meaningfulness.

This section introduces categorization of assets in the balance sheet based on time or the asset’s useful
life (current and long-term). Sometimes assets are also considered from the standpoint of their liquidity
, which is regarded as how close or distant the asset is from being turned into cash. Near-cash assets are
relatively quickly converted to cash (e.g., accounts receivable), while assets requiring rather a long time
to convert to cash are considered to be relatively fixed  in their non-cash state (e.g., heavy equipment,
buildings, land). (Fixed does not mean they were repaired!)

You should find that current assets parallel those with more liquidity, while long-term and fixed assets are
those with much less liquidity. Finally, below you will find a few assets that could be either current or
long-term based on the nature of the facts constituting them.

Other Assets Described

Current Assets

Current Assets are those activities whose normal expected life would be one year or less. Such activities
could be tracking reimbursable expenses, travel advances, short-term loans to a friend or family member,
prepaid expenses, annual insurance premium amortization, and so on. The individual entity could have
many other kinds of short term activities that reflect what it is doing. (These asset types are explained
individually below.)

Long-term (Fixed) Assets

Long-term (Fixed) Assets are those activities whose normal expected life exceeds one or more years. This
grouping covers both tangible and intangible assets. Examples of tangible assets are land, buildings, and
vehicles (cars, trucks, construction equipment, factory presses, etc.) Intangible assets include such things
as patents, copy rights, goodwill, etc. Because the lives of some of these assets show wear and tear and
deterioration in value over time, businesses and individuals can allow for that diminution in value by
calculating depreciation on such assets. For example, land normally does not depreciate, but buildings do,
as do equipment and vehicles. (These asset types are explained individually below.)

Current Assets
This section explains short-term receivables, reimbursable expenses, travel advances, prepaid premiums,
prepaid rent, suspense or wash accounts.
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Short-term Receivables
This kind of account is useful to reflect an agreement made with someone you trust. Suppose you lent
someone $500 and he agreed to repay you $50 a month. If he paid on time, the loan you made would be
paid off within a year, which is why it is classified as a short-term receivable. So you could record that
loan initially in this account tree: OtherAssets:Current Assets:LoanToJoe. At the time you give him the
money: your entry is debit (increase) LoanToJoe $500 and credit (decrease) Bank $500. Each time you
receive Joe’s payment you record $50 debit (increase) to Bank and credit (decrease) LoanToJoe.

Dica

Don’t become confused by the use of the word “Loan”. “Loan-To” is the tipoff that you really
have a receivable, that is, you will receive from Joe, the money you previously loaned. Until he
actually pays the money owed you, you reflect his debt in your books by an account describing
your expectation–you will receive the money owed you, hence the word “receivable”.

Reimbursable Expenses
This kind of activity is one in which you spend your own money on behalf of someone else (your em-
ployer, perhaps) and later you receive repayment of what you spent. The case might be a business trip.
The employer has a policy of covering (paying for) all authorized expenses. After the trip is over, the
employee submits a report listing dates and amounts spent with receipts for all the expenditures. The em-
ployer reviews the report and pays for all items that it considers as having a valid business reason. (Nor-
mally, employees know in advance what the employer will reimburse, so only those items are recorded
as a reimbursable expense on the employee’s books.)

Because a business trip can involve different kinds of expenditures (air travel, lodging, transportation at
the destination, etc.), different kinds of expenditures would be recorded in the one account as long as the
expenditures all related to the same trip. In other words, if a second trip is made before the first is fully
settled, a second account for a different event could be set up. It would make sense to do this, if it would
help to keep separate all the details of one trip from those of another. It is up to the person making the trip
to decide how much trouble it would be to put separate trips in separate accounts or to put them all in the
same account. The trip taker should remember that the account must be reconciled in order to know with
certainty that all expenses have been reimbursed.

Recording the expenditures on the trip would be much the same. That is, if you paid trip expenses by
cash you would debit (increase) the reimburseable expense account for the money paid in cash, because
it is a receivable to you until it has been reimbursed to you. The credit offsetting your expenditure would
decrease the account that shows the cash in your pocket or the account from which you drew the cash for
the payment made. If you paid by credit card, the debit side would be the same as just described, but the
credit would be an increase to the credit card company account on your books.

When you received your reimbursement, then the journal entry (or transaction) to record receipt of the
funds from the employer would be: debit (increase) Bank for the check amount and credit (decrease) the
reimbursable expense account for the check amount.

If it turns out that the reimbursable expense account is not zero balance after processing the employer’s
payment, then it means that there is a difference between you and the employer in handling the expense,
which needs to be investigated. If the balance is a debit (a positive balance), your account has some money
that was not reimbursed. If the balance is a credit (a negative balance), you were paid for more than what
you recorded as due you. In both of those situations you should reconcile the difference between what you
recorded and what was paid. That effort should disclose exactly what is causing the discrepancy. You will
need to contact the employer’s bookkeeper to know what was paid, if the reimbursement check was not
accompanied by a detailed list of the items being paid you.

186



Other Assets

In the event the employer refused to reimburse you for an expenditure, that effectively makes it your
expense. In that case, you would make this entry: debit (increase) your own Expense (appropriately named)
and credit (decrease) the Reimbursable Expense account. That entry should result in a zero balance in the
Reimbursable Expense account. If not, reconcile until you identify the difference.

Dica

Sometimes there are small differences that don’t match an individual entry. In those cases divide
the amount by 2 or by 9. If the unresolved amount is divisible by two, it suggests that both you
and the employer entered the item in the same manner: both as debits or both as credits. If it is
divisible by 9, then likely one of you transposed adjoining numbers; e.g., one entered 69 and the
other entered 96. If the difference is divisible neither by 2 or by 9, then it could be that more
than one error is present.

Travel Advances
These are very similar to Reimbursable Expenses. The difference is that someone gives you money first;
you spend it, and then you give a report accounting for what you spent it on. The report is supported by
invoices establishing who, what, where, when, and how much for each expenditure. In the Reimbursable
Expense case, you spent your money first and later recovered it.

In the Travel Advance case when you receive the advance, you record on your books this entry: debit
(increase) Bank for the travel advance amount received (say, $500); credit (increase) the short-term liability
Travel Advance ($500). This is a liability, because you are not gifted with the money, but only loaned it
for the purpose of having funds to spend when doing the employer’s business.

Frequently, the way these monetary arrangements work is that at the beginning of for example a salesper-
son’s employment, he or she receives the advance and monthly (or more frequently) turns in a report about
who, what, where, when, and how much he spent. The money in the report is reimbursed if approved.

During the period after receiving the advance and before filing a request for reimbursement report, the
salesperson can record his or her expenditures into the advance liability account. In that case, the balance
in the account will show how much of the advance has not yet been spent (assuming the Travel Advance
balance is a credit). If no mistakes have been made and all expenses are approved, then the sum of the
unspent account balance and the reimbursing check amount will equal the original travel advance amount.

It makes sense for the salesperson to record the travel expenses to this advance account (and not to his or
her own expense accounts), because the money is being spent on behalf of the employer, for the employer’s
authorized expenses. It is not the employee’s own money, and therefore not his or her own expense.

When the salesperson receives the report reimbursement (say, $350), he or she debits (increases) Bank,
and credits (increases) again the Travel Advance liability account, assuming that previously he or she had
been recording expenditures to the travel advance account. Tracking activity in this manner causes the
account to always show the amount that is owed the employer.

See “Reimbursable Expenses” above for what to do if the employer does not accept an item the employee
put on the travel advance reimbursement request report. The difference resolution effort is essentially the
same for both types of accounts.

Prepaid Premiums or Prepaid Rent
Some types of expenses are usually billed as semi-annual or annual amounts. For example, the insurance
industry will bill home insurance annually, while car insurance premiums can be annual or semi-annual.
For those that pay an amount that covers several months or a full year, the proper accounting treatment is
to reflect in each accounting period the amount that expresses the benefit applying to that period.
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In the case of someone who pays a full-year’s insurance premium at the beginning of the insurance period,
the entry to record this is debit (increase) Prepaid Insurance Premium for say, $1,200, and credit (decrease)
Bank for $1,200.

Then a monthly recurring journal entry (scheduled transaction) is created that debits (increases) Insurance
Expense $100 and credits (decreases) Prepaid Insurance Premium $100. This technique spreads the cost
over the periods that receive the insurance coverage benefit. Businesses following generally accepted ac-
counting practices would normally use this technique, especially if they had to present financial statements
to banks or other lenders. Whether individuals do depends on the person and how concerned they are to
match cost with benefit across time periods. Another factor influencing use of this technique would be
the number of such situations the person encounters. It is relatively easy to remember one or two, but
more difficult if having to manage 10 to 20. You would set up as many or as few as proved useful and
important to you.

Suspense or Wash Accounts
The purpose of these accounts is to provide a device to track “change of mind” situations. The objective of
these accounts is to provide a temporary location to record charges and credits that are not to be included
permanently in your books of record. When the transactions reflected in these accounts have been fully
completed, Wash/Suspense accounts will normally carry a zero balance.

For example, say in the grocery store you see canned vegetables on sale, so you buy 6 cans at $1 per
can. Say that the total purchases were $50. When you come home and are putting things in the cupboard
you discover you already had 12 cans. You decide to return the 6 you just bought. Some persons in this
situation would charge (increase) the whole bill to Grocery Expense; and when they returned the cans,
they would credit (decrease) Grocery Expense. That is one way of handling that. The effect of this method
is to leave recorded on your books the cost of items that you really did not purchase from a permanent
standpoint. It is only when the items have actually been returned and the vendor’s return receipt has also
been recorded that the distortion this method generates will then be removed.

Actually, there are several treatments, depending on when and how the original transaction was booked/re-
corded and when you decided to return the items purchased. Basically, did you change your mind before
you recorded the transaction or after doing so?

If you decided to return the items after recording the purchase transaction, you may originally have charged
Grocery Expense for the full amount ($50) of all items. In that scenario, what you kept and the amount of
the items to be returned were grouped into one account. You could edit the original transaction and restate
the amount charged to the Grocery Expense account to be the difference ($44) between the total paid ($50)
for groceries and the value of the items to be returned. That leaves the returned-item value as the amount
($6) you should record to the Suspense account.

Obviously, if you decided to return items before you recorded your purchase, then you would book the
original entry as a charge to Grocery Expense for the amount kept ($44) and as a charge to Suspense for the
amount returned ($6). The off-setting credit ($50) to cash or credit card is not affected by these treatments.

When there are several persons shopping and at different vendors, there can be a case where there are
several returns happening at once and in overlapping time frames. In that case the Wash Account is charged
(increased) at time of changing the mind, and either Bank or Credit Card is credited. When the return
occurs, the reverse happens: Bank or Credit Card is debited for the cash value of the returned items and
the Wash/Suspense Account is credited in the same amount.

If the wash account has a non-zero balance, scanning the debit and credit entries in the account will show
the non-matched items. That is, debits not matched by offsetting credits indicate items intended to be
returned but not actually returned yet. The reverse (credits not matched by offsetting debits) indicates that
returns were made but the original charge was not recorded in the Wash Account.
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These differences can be cleared up by returning unreturned items or recording charges (debits) for items
already returned. The mechanics of doing that likely will be finding the original expense account the item
was charged to and making an entry like: debit Wash Account, credit original expense. It also could be as
described above where the original recording is adjusted by adding a charge to Wash/Suspense account
and decreasing the amount charged to the original account.

Short or Long-term Assets
This section explains why some types of assets may be short or long-term and presents an example.

An example is deposits (e.g., utility, rental, security). If the deposit agreement contains a provision to
recover the deposit at the end of a year, the treatment could be that of a short-term asset. However, when
the agreement is that the deposit holder returns the funds only upon successful inspection at the end of the
relationship, then at the start of the relationship or agreement, the person paying the deposit has to decide
whether to write it off as a current expense or to track it for eventual recovery at the end of the agreement
(not infrequently, moving to a new location).

Whichever decision is made, the accounting treatment is to debit (increase) expense (assuming the wri-
te-off decision) or debit (increase) Deposits Receivable (assuming the intent is to recover the deposit in
the future) and credit (decrease) Bank for the amount of the deposit (if paid by cash) or credit (increase)
credit card if paid using that payment method.

Long-term (Fixed) Assets
This section illustrates long-term assets (those whose useful lives exceed a year) and discusses these types:
land, buildings, leasehold improvements, intangibles, vehicles and other equipment.

Land
Land is not a wasting asset. That is, it does not get used up over time and rarely suffers damage such that it
loses value. For that reason, it usually is recorded at cost at the time of purchase. Appreciation in its value
over decades is not recorded and is not recognized in any way on the books of the owner. It is only after
land has been sold that sale price and purchase cost are compared to calculate gain or loss on sale.

Land is frequently sold/purchased in combination with structures upon it. That means that the cost has
to become separated from the cost of structures on it. Land valuation is usually part of the transfer of
ownership process and its value is shown on the purchase documents separately from that of any structures
it supports.

Land values shown on purchase documents frequently arise from the process of value determination ma-
naged by assessors whose job it is to assign values to land for tax purposes. Local and regional areas of a
state or province use the values determined by assessors in their tax formulas, which provide revenues for
local and regional governing authorities to finance their required community services.

Should land be acquired in a situation not subject to a history of land valuation by a formal valuation
system, then the purchaser can appeal to real estate agents and an examination of recent sale transactions
for information that would allow calculating a reasonable amount to express the value of the land.

Buildings
Buildings are the man-made “caves” in which much of life’s human interaction occurs. These structures
are wasting assets, because in their use they or their components gradually wear. Over time they begin to
lose some of their function and they can suffer damage due to planetary elements or human action.
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Accepted accounting practice is to record the cost of the building determined at time of ownership transfer
(purchase) or at conclusion of all costs of construction. Because buildings are frequently used for decades,
and due to the need to be able to calculate gain or loss on sale, accounting practice preserves the original
cost by not recording declines in value in the account containing the original purchase or construction cost.

Instead, the depreciation technique is used to show (in the balance sheet) the structure’s net book value
(original cost reduced by accumulated depreciation). Depreciation is a separate topic treated elsewhere
in this Guide.

Leasehold Improvements
When a business does not own the building where it operates, and instead has a long-term lease, it is not
uncommon for the business tenant to make improvements to the premises so that the structure obtains both
function and appearance that enhances conducting its business activities.

In these cases, the expenditures that the business incurs are recorded in a Leasehold Improvements account:
increase (debit) Leasehold Improvements, decrease (credit) Bank or increase (credit) a suitable liability
account (which could be a liability to a contractor or a bank or a credit card, etc.).

Vehicles or Equipment
Vehicles or Equipment of all kinds usually last for several years, but their useful lives are much shorter
than that of assets that have little movement in their functioning. Because they do wear out over time,
common accounting practice in business is to record depreciation using life spans and depreciation methods
appropriate to the nature and use of the asset. Frequently, the life and depreciation methods chosen are
influenced by what is permitted per national tax regulations for the kind of asset being depreciated.

Usually, businesses depreciate their assets. Individuals can do so as well to the degree that taxing authorities
permit. Very wealthy persons employ accountants and attorneys to track and manage their investments
and assets holdings to take advantage of all tax benefits permitted by law.

Intangibles
The mechanics of accounting (debiting and crediting appropriate accounts) for these assets are relatively
simple, much the same as for any of the above assets. Where the difficulty lies is in their valuation, which is
an advanced topic and not something that individual persons and small businesses would likely encounter.
For that reason further discussion of items such as patents, copyrights, goodwill, etc. are left out of this
Guide.
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Capítulo 18. Depreciation
This chapter will introduce the concept of depreciation in accounting and give some real life examples
for using it.

Basic Concepts
Depreciation is the accounting method for expensing capital purchases over time. There are two reasons
that you may want to record depreciation; you are doing bookkeeping for your own personal finances and
would like to keep track of your net worth, or you are doing bookkeeping for a small busines and need to
produce a financial statement from which you will prepare your tax return.

The method of recording depreciation is the same in either case. but the end goal is different. This section
will discuss the differences between the two. But first, some terminology.

• Accumulated depreciation - the accumulated total of book depreciation taken over the life of the asset.
This is accumulated in the depreciation account in the asset section.

• Book depreciation - this is the amount of depreciation that you record in your financial statements per
accounting period.

• Fair market value - the amount for which an asset could be sold at a given time.

• Net book value - this is the difference between the original cost and the depreciation taken to date.

• Original cost - this is the amount that the asset cost you to purchase. It includes any cost to get the asset
into a condition in which you can use it. For example - shipping, installation costs, special training.

• Salvage value - this is the value that you estimate the asset can be sold for at the end of it’s useful life
(to you).

• Tax depreciation - this is the amount of depreciation that you take for income tax purposes.

Personal Finances
Depreciation is used in personal finances to periodically lower an asset’s value to give you an accurate
estimation of your current net worth. For example, if you owned a car you could keep track of its current
value by recording depreciation every year. To accomplish this, you record the original purchase as an
asset, and then record a depreciation expense each year (See “Example” for an example). This would result
in the net book value being approximately equal to the fair market value of the asset at the end of the year.

Depreciation for personal finance has no tax implications, it is simply used to help you estimate your net
worth. Because of this, there are no rules for how you estimate depreciation, use your best judgement.

For which assets should you estimate depreciation? Since the idea of depreciation for personal finances is
to give you an estimate of your personal net worth, you need only track depreciation on assets of notable
worth that you could potentially sell, such as a car or boat.

Business
As opposed to personal finance where the goal is tracking personal worth, business is concerned with
matching the expense of purchasing capital assets with the revenue generated by them. This is done through
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book depreciation. Businesses must also be concerned with local tax laws covering depreciation of assets.
This is known as tax depreciation. The business is free to choose whatever scheme it wants to record
book depreciation, but the scheme used for tax depreciation is fixed. More often than not this results in
differences between book and tax depreciation, but steps can be taken to reduce these differences.

Now, what purchases should be capitalized? If you expect something that you purchase to help you earn
income for more than just the current year, then it should be capitalized. This includes things like land,
buildings, equipment, automobiles, and computers - as long as they are used for business purposes. It does
not include items that would be considered inventory. So if you made a purchase with the intent to resell
the item, it should not be capitalized.

In addition to the purchase of the asset itself, any costs associated with getting the asset into a condition
so that you can use it should be capitalized. For example, if you buy a piece of equipment and it needs to
be shipped from out of town, and then some electrical work needs to be done so you can plug the machine
in, and some specialized training is needed so you know how to use the machine, all these costs would
be included in the cost of the equipment.

You also need to know the estimated salvage value of the asset. Generally, this is assumed to be zero. The
idea behind knowing the salvage value is that the asset will be depreciated untill the net book value (cost
less depreciation) equals the salvage value. Then, when the asset is written off, you will not have a gain
or loss resulting from the disposal of the asset.

The last step is to determine the method of depreciation that you want to use. This will be discussed on
the next few pages.

Nota

Warning: Be aware that different countries can have substantially different tax policies for de-
preciation; all that this document can really provide is some of the underlying ideas to help you
apply your “favorite” tax/depreciation policies.

Estimating Valuation
A central issue with depreciation is to determine how you will estimate the future value of the asset.
Compared to the often uncertain estimates one has to do where appreciation of assets is concerned, we
are on somewhat firmer ground here. Using sources listed below should make it fairly straight forward to
estimate the future value of your depreciating assets.

• Tax Codes: For businesses that want to use depreciation for tax purposes, governments tend to set up
precise rules as to how you are required to calculate depreciation. Consult your local tax codes, which
should explicitly state how to estimate depreciation.

• Car Blue Book: For automobiles, it is easy to look up in references such as “Blue Books” estimates of
what an automobile should be worth after some period of time in the future. From this you will be able
to develop a model of the depreciation.

Depreciation Schemes
A depreciation scheme is a mathematical model of how an asset will be expensed over time. For every
asset which undergoes depreciation, you will need to decide on a depreciation scheme. An important point
to keep in mind is that, for tax purposes, you will need to depreciate your assets at a certain rate. This is
called tax depreciation. For financial statement purposes you are free to choose whatever method you want.
This is book depreciation. Most small businesses use the same rate for tax and book depreciation. This way
there is less of a difference between your net income on the financial statements and your taxable income.
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This section will present 3 of the more popular depreciation schemes: linear, geometric, and sum of digits.
To simplify the examples, we will assume the salvage value of the asset being depreciated is zero. If you
choose to use a salvage value, you would stop depreciating the asset once the net book value equals the
salvage value.

1. Linear depreciation diminishes the value of an asset by a fixed amount each period until the net value
is zero. This is the simplest calculation, as you estimate a useful lifetime, and simply divide the cost
equally across that lifetime.

Example: You have bought a computer for $1500 and wish to depreciate it over a period of 5 years.
Each year the amount of depreciation is $300, leading to the following calculations:

Tabela 18.1. Linear Depreciation Scheme Example

Year Depreciation Remaining Value

0 - 1500

1 300 1200

2 300 900

3 300 600

4 300 300

5 300 0

2. Geometric depreciation is depreciated by a fixed percentage of the asset value in the previous period.
This is a front-weighted depreciation scheme, more depreciation being applied early in the period. In
this scheme the value of an asset decreases exponentially leaving a value at the end that is larger than
zero (i.e.: a resale value).

Example: We take the same example as above, with an annual depreciation of 30%.

Tabela 18.2. Geometric Depreciation Scheme Example

Year Depreciation Remaining Value

0 - 1500

1 450 1050

2 315 735

3 220.50 514.50

4 154.35 360.15

5 108.05 252.10

Nota

Beware: Tax authorities may require (or allow) a larger percentage in the first period. On
the other hand, in Canada, this is reversed, as they permit only a half share of “Capital Cost
Allowance” in the first year. The result of this approach is that asset value decreases more
rapidly at the beginning than at the end which is probably more realistic for most assets than
a linear scheme. This is certainly true for automobiles.

3. Sum of digits is a front-weighted depreciation scheme similar to the geometric depreciation, except
that the value of the asset reaches zero at the end of the period. This is a front-weighted depreciation
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scheme, more depreciation being applied early in the period. This method is most often employed in
Anglo/Saxon countries. Here is an illustration:

Example: First you divide the asset value by the sum of the years of use, e.g. for our example from above
with an asset worth $1500 that is used over a period of five years you get 1500/(1+2+3+4+5)=100.
Depreciation and asset value are then calculated as follows:

Tabela 18.3. Sum of Digits Depreciation Scheme Example

Year Depreciation Remaining Value

0 - 1500

1 100*5=500 1000

2 100*4=400 600

3 100*3=300 300

4 100*2=200 100

5 100*1=100 0

Account Setup
As with most accounting practices, there are a number of different ways to setup depreciation accounts.
We will present here a general method which should be flexible enough to handle most situations. The
first account you will need is an Asset Cost account (GnuCash account type Asset), which is simply a place
where you record the original purchase of the asset. Usually this purchase is accomplished by a transaction
from your bank account.

In order to keep track of the depreciation of the asset, you will need two depreciation accounts. The first is
an Accumulated Depreciation account in which to collect the sum of all of the depreciation amounts, and
will contain negative values. In GnuCash, this is an account type asset. The Accumulated Depreciation
account is balanced by a Depreciation Expense account, in which all periodic depreciation expenses are
recorded. In GnuCash, this is an account type expense.

Below is a generic account hierarchy for tracking the depreciation of 2 assets, ITEM1 and ITEM2. The
Asset Cost accounts are balanced by the Bank account, the Accumulated Depreciation account is balanced
by the Expenses:Depreciation account.

-Assets
   -Fixed Assets
      -ITEM1
         -Cost                (Asset Cost account)
         -Depreciation     (Accumulated Depreciation account)
      -ITEM2
         -Cost                (Asset Cost account)
         -Depreciation     (Accumulated Depreciation account)
   -Current Assets
      -Bank
-Expense
   -Depreciation        (Depreciation Expense account)
  

One of the features of the account hierarchy shown above is that you can readily see some important
summary values about your depreciating asset. The Assets:Fixed Assets:ITEM1 account total shows you
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the current estimated value for item1, the Assets:Fixed Assets:ITEM1:Cost shows you what you originally
paid for item1, Assets:Fixed Assets:ITEM1:Depreciation shows you your accrued depreciation for item1,
and finally, Expenses:Depreciation demonstrates the total accrued depreciation of all your assets.

It is certainly possible to use a different account hierarchy. One popular account setup is to combine the
Asset Cost and Accrued Depreciation asset accounts. This has the advantage of having fewer accounts
cluttering your account hierarchy, but with the disadvantage that to determine some of the summary details
mentioned in the paragraph above you will have to open the account register windows. As with most
things, there are many ways to do it, find a way that works best for you.

The actual input of the depreciation amounts is done by hand every accounting period. There is no way in
GnuCash (as of yet) to perform the depreciation scheme calculations automatically, or to input the values
automatically into the appropriate accounts. However, since an accounting period is typically one year,
this really is not much work to do by hand.

Example
Let’s go ahead and step through an example. Imagine you are a photographer and you use a car and an
expensive camera for your personal business. You will want to track the depreciation on these items,
because you can probably deduct the depreciation from your business taxes.

The first step is to build the account hierarchy (as shown in the previous section, replace ITEM1 and ITEM2
with “car” and “camera”). Now, record the purchase of your assets by transferring the money from your
bank account to the appropriate Asset Cost accounts for each item (eg: the Assets:Fixed Assets:Car:Cost
account for the car). In this example, you start with $30k in the bank, the car cost $20k and the camera
cost $10k and were both purchased on January 1, 2000.
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The asset depreciation example main window, before depreciation

Looking at the tax codes, we realize that we must report depreciation on these items using the “sum of
digits” scheme, over a 5 year period. So, the yearly depreciation amounts for the car come to $6667, $5333,
$4000, $2667, $1333 for years 1 to 5 respectively, rounded to the nearest dollar. The yearly depreciation
amounts for the camera are $3333, $2667, $2000, $1333, $667. Consult the previous section on Depreci-
ation Schemes for the formula for calculating these values.

For each accounting period (IE: fiscal year) you record the depreciation as an expense in the appropriate
Accrued Depreciation account (eg: the Assets:Fixed Assets:Car:Depreciation account for the car). The
two windows below show your car’s accrued depreciation account and the main window after the third
year (IE: three periods) of depreciation using this sum of digits scheme.
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The asset depreciation register window

The asset depreciation main window

Nota

A Word of Caution: Since depreciation and tax issues are closely related, you may not always be
free in choosing your preferred method. Fixing wrong calculations will cost a whole lot more time
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and trouble than getting the calculations right the first time, so if you plan to depreciate assets, it
is wise to make sure of the schemes you will be permitted or required to use.
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Capítulo 19. Python Bindings
GnuCash historically has always been a traditional application in the sense that you open it, use it to
manipulate your financial data via the windows it presents, save your data and close the windows again.
This has the inherent limitation that you can only do whatever the windows, menus and toolbars allow
you to do.

Sometimes you might need a little more flexibility. For example, you need a report with just a little different
information than what the built-in reports provide, or you want to automate a frequently recurring action.
Such custom manipulations are ideal candidates to write in one or the other scripting language.

Starting with GnuCash version 2.4 you can write Python scripts to manipulate your financial data.

Nota

The Python extensions are an optional feature in the source code. To be able to use Python scripts,
GnuCash must have been compiled with this option enabled, otherwise all what follows won’t
work. At present this option is not enabled by default, so if you need this, you may have to compile
GnuCash from source yourself.

The Python extensions come with a couple of ready to use scripts. This chapter will show you how to
use some of these.

Nota

This chapter is not about how to write your own Python scripts. Refer to the developer documen-
tation for that instead.
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Capítulo 20. Importing Business Data
Import Bills or Invoices

This functionality is only available by default for versions greater than 2.6

For 2.4.13 the Customers and Vendors importer is an optional module and needs to enabled by editing the
file $HOME/.gnucash/config.user, adding the line:

(gnc:module-load "gnucash/plugins/bi_import" 0)

On Linux systems this file is found at $HOME/.gnucash/config.user and on Mac OSX it is ~/
Library/Application Support/Gnucash/config.user. If the file doesn’t already exist you
will have to create it. After restarting GnuCash, the item will appear at the bottom of the business menu.

In order for the importer to work the data must be in a fixed field length, comma separated line format. A
example Python script to convert a downloaded order is shown below.

import sys
import csv

VENDOR_ID="000013"
INFILE=sys.argv[1]
INV_ID=sys.argv[2]
try:
  ACCOUNT=sys.argv[3]
except:
  ACCOUNT="Expenses:Materials General"

Reader = csv.reader(open(INFILE), delimiter=',')

# Need to ignore 1st and last rows

for row in Reader:
  if row[0].isdigit(): # We only use numbered lines
    outline=(INV_ID + ",," + VENDOR_ID + ",,,," + row[1] + " > " + row[4] + ",ea," +
      ACCOUNT + "," + row[2] + "," + row[5].replace("GBP", "") + ",,,,no,,,,,,,")
  print outline
      

Example of a downloaded vendor order from Rapid Electronics (UK).

line number,product code,quantity,availability,product description,unit price,discounts,line total,delivery,sub total,vat,grand total
1,47-3524,100,100 Available,BC848C SOT-23 NPN TRANSISTOR (INF) (RC),GBP0.03,GBP0.00,GBP0.03
2,47-3278,30,30 Available,L78L05ACZ 0.1A +5V VOLTAGE REG (ST) (RC),GBP0.18,GBP0.00,GBP0.18
3,22-0120,1,1 Available,Tube 34 14pin DIL socket, narrow7.62mm, without central support,GBP1.05,GBP0.00,GBP1.05
4,22-0127,1,0 Available<br />1 on Back Order,Tube 17 28pin DIL socket, wide15.24mm, without central support,GBP1.22,GBP0.00,GBP1.22
5,62-0368,1,1 Available,820R CR25 0.25W CF Resistor Pk 100,GBP0.50,GBP0.00,GBP0.50
6,47-3130,100,100 Available,1N4001 1A 50V SILICON RECTIFIER DIODE RC,GBP0.01,GBP0.00,GBP0.01
7,17-0310,1,1 Available,PROFESSIONAL MINATURE PROBE HOOK RED RC,GBP0.90,GBP0.00,GBP0.90
8,17-0312,1,1 Available,PROFESSIONAL MINATURE PROBE HOOK BLACKRC,GBP0.90,GBP0.00,GBP0.90
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9,34-0655,1,1 Available,PROTOBLOC 2 BREADBOARD,GBP4.39,GBP0.00,GBP4.39
10,18-0200,1,1 Available,PP3 9V ALKALINE BATTERY "Not For Retail Sale",GBP1.37,GBP0.00,GBP1.37
,,,,,,,,GBP4.95,GBP24.93,GBP4.35,GBP29.28
      

A similar file after processing with the Python script.

MEC-0071,,000013,,,,34-0655 > PROTOBLOC 2 BREADBOARD,ea,Expenses:Materials General,1,4.39,,,,no,,,,,,,
MEC-0071,,000013,,,,18-0105 > PP3 / PP6 BATTERY CLIP 150MM (RC),ea,Expenses:Materials General,10,0.06,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0370 > 1k CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0354 > 220R CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,34-5548 > PLAIN DOCUMENT WALLET ASSORTED PK 50 RE,ea,Expenses:Materials General,1,6.95,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0386 > 4k7 CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,34-0860 > COPPER CLAD SRBP SS 100 X 160 (RC),ea,Expenses:Materials General,5,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,18-0163 > PP3 BATTERY HOLDER WITH FLYING LEADS RC,ea,Expenses:Materials General,5,0.23,,,,no,,,,,,,
MEC-0071,,000013,,,,73-4290 > ATMEGA8-16PU 8-BIT MICRO 8K DIL-28 (RC),ea,Expenses:Materials General,3,1.99,,,,no,,,,,,,
MEC-0071,,000013,,,,81-0014 > BC108 NPN GP TRANSISTOR RC,ea,Expenses:Materials General,20,0.16,,,,no,,,,,,,
MEC-0071,,000013,,,,DELIVERY,ea,Expenses:Postage,1,4.95,,,,no,,,,,,,
MEC-0071,,000013,,,,VAT,tax,Expenses:VAT,1,4.35,,,,no,,,,,,,
        

As can be seen there are some fields that are absent and some that are not required for import. The first line
is not required and the last line is superfluous as GnuCash will total the order for us. All that is required
is to take what we want and produce an output file with the correct format to import into GnuCash. In this
case we join the part number and description fields and these become description in GnuCash invoice/bill.
We need the qty and part price fields. Contrary to the header line VAT is not included by line and is always
zero, the VAT is calculated on the last line as VAT on the order total.

Nota

This will cause problems later.
In this example I have assigned the Expenses:Materials General account to be the target account. This
can be changed after import in the usual way, along with any other data. If there is no such account as
Expenses:Materials General then that field will be left blank on import and will have to be set manually.
Lines beginning with a “#” are regarded as comment lines and ignored.

The script is called with the following command:

python importer.py file_to_import, invoice_id > file_to_save_as.csv

This short script can easily be changed to suit any downloaded format. The only restriction is that the final
number of field is fixed, at least at the moment. The importer will ignore lines with the wrong number of
fields. (This may be fixed in future version). Vendor ID is simply the ID assigned to the specific vendor,
or client. The row[N] items refer to the position in the line where the correct data lies. Note that the first
field is row[0] NOT row[1].

Once you have converted the file navigate to Business → Invoice & Bill Import to open a new import
window. Select the file you have just created, select Bill or Invoice and Comma separated format. At this
point the data should show up in the preview window. Check that the field data are in the correct columns
before selecting OK. Once imported the invoice can be opened for editing and posting in the usual way.

A note on VAT, or any purchase tax. As previously mentioned Rapid Electronics calculate the VAT on
the bill total not line by line. GnuCash calculated the VAT per line then totals the VAT. This can lead to
inaccuracies in the VAT of the region of a few pennies and is enough to cause problems when reconciling
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the purchase with your bank or credit card account used to make the purchase. As to how you overcome
that, for the moment, is a problem for you to use whatever method suits your conscience or accountant
best. Personally I add the VAT as a separate line along with delivery charges manually. So some work is
left to the user but the tedium of entering each item eliminated.

Future: Currently the import format is quite strict and many users may have problems with the conver-
sion process. Adding a template for every possible vendor CSV format would be mammoth and likely
impossible task notwithstanding the fact the vendors are likely to change the format without informing the
GnuCash team. Future import enhancements will be based on user feedback and hopefully the process can
be made simpler or more flexible. Note that often “simple” is incompatible with “flexible”.

Nota

If Python (other languages are avaialble) is not your thing then post a request to GnuCash user list
[https://lists.gnucash.org/mailman/listinfo/gnucash-user], with an example of your downloaded
CSV, and someone may write you a Python script to do the translation.

Notes for Python authors
In order for the import to succeed the number of fields must be adhered to, so the trailing commas are
important.

A complete list of the required fields is:

id, date_opened, owner_id, billingid, notes, date, desc, action, account, quantity, price, disc_type,
disc_how, discount, taxable, taxincluded, tax_table, date_posted, due_date, account_posted, memo_pos-
ted, accu_splits,

Nota

Mind the trailing comma.

A brief description of each field
• id - The invoice number. All lines must contain this or the line will be rejected.

• date_opened - Use the same date format as setup in Preferences. Today's date is inserted if this is blank.

• owner_id - ID number of the vendor or customer. All lines must contain this or the line will be rejected.

• billingid - Billing ID.

• notes - Invoice notes.

• date - The date of the item line. Can be left blank for todays date.

• desc - Description as per normal invoice or bill.

• action - For bills usually “ea”.

• account - Account to which the item is attributed.

• quantity - Quantity of each item. Must contain a value or the line will be rejected.

• price - Price of each item. Must contain a value or the line will be rejected.
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• disc_type - Type of discount, either “%” or “TODO”, only applies to invoices. Some experimentation
may be required here as may be currency dependent.

• disc_how - Only applies to invoices.

• discount - Amount of discount to be applied. only applies to invoices.

• taxable - Will tax be applied to the item? “yes” or blank.

• taxincluded - Is tax included in the item price? “yes” or blank.

• tax_table - Tax table to apply to item.

• date_posted - If posted, what date. Normally left blank for manual posting after editing the invoice. Use
the same date format as setup in Preferences.

• due_date - Date payment is due. Use the same date format as setup in Preferences.

• account_posted - Posted to what account.

• memo_posted  - If posted insert memo here.

• accu_splits - Accumulate splits? “yes” or blank.

Importing Customers and Vendors
This functionality is only available in the 2.6 versions of GnuCash and is only loaded by default for versions
greater than 2.6.

For versions lower than 2.6 the Customers and Vendors importer is an optional module and needs to
enabled by editing the file $HOME/.gnucash/config.user, adding the line:

(gnc:module-load "gnucash/plugins/customer_import" 0)

On Linux systems this file is found at $HOME/.gnucash/config.user and on Mac OSX it is ~/
Library/Application Support/Gnucash/config.user. If the file doesn’t already exist you
will have to create it. After restarting GnuCash the item will appear at the bottom of the business menu.

In order for the importer to work each line in the input file must have the following structure.

id, company, name, addr1, addr2, addr3, addr4, phone, fax, email, notes,
shipname, shipaddr1, shipaddr2, shipaddr3, shipaddr4, shiphone, shipfax,
shipmail

Fields can be separated with commas or semicolons and each field can be in quotes. These options are
selectable in the import dialog. Vendors don’t have shipping information so even though the fields have
to exist, leave them empty. The id field is optional and if it is empty a new id will be chosen. If the id field
has a value this will UPDATE any vendor/customer with the same id. This may not be what you want.
Note that in your input file the data must be a single line for each customer/vendor.

The importer does not currently import billing information for customers or vendors, these will have to
be edited individually after importing.
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Apêndice A. Guia de migração
Este apêndice serve para ajudar utilizadores de outros programas de gestão financeira na sua migração
para o GnuCash. Abordamos as diferenças conceptuais entre a disposição das contas do GnuCash versus
outros programas.

Contas vs. Categorias
Se está familiarizado com outros programas de finanças pessoais, já está habituado a controlar as suas
receitas e despesas como categorias. Dado que o GnuCash é um sistema de dupla entrada (veja a secção
“Conceitos contabilísticos”), as receitas e despesas são controladas em contas. O conceito básico é o mes-
mo, mas a estrutura de contas permite maior consistência com práticas empresariais comuns. Assim, se
é um utilizador empresarial assim como privado, o GnuCash torna fácil o controlo dos seus negócios e
das sua contas privadas.

Contas de receita e despesa dão-lhe a mesma informação que obteria com categorias, mas também lhe dão
mais flexibilidade na introdução de transações. No GnuCash, tem a opção de inserir transações diretamente
nas contas de receita e despesa através dos seus próprios diários. Outros programas que usam categorias,
não oferecem esta opção, porque não existem “diários de conta” para uma categoria.

No GnuCash também tem a opção de tratar contas de receita e despesa tal como trataria as categorias, se se
sentir mais confortável com esse método. No Quicken® e programas semelhantes, as transações requerem
uma conta e uma categoria. No GnuCash, use um nome de conta de receita ou despesa onde normalmente
usaria uma categoria noutros programas e o resultado deve ser o mesmo. Discute-se a introdução de tran-
sações com maior detalhe no capítulo Capítulo 4, Transações .

Organização de ficheiros QIF (em discussão)

Problemas comuns de duplicação (em discus-
são)

Verificar dados QIF (em discussão)

Converter ficheiro XML do GnuCash
O ficheiro de dados XML do GnuCash pode ser transformado em praticamente qualquer formato (por
exemplo, QIF, CSV...) com bastante facilidade se se estiver familiarizado com XSLT. O ficheiro de dados
do GnuCash é um XML bem formado e pode ser lido por um processador XSLT com uma folha de estilos
associada. Isto permite transformar o ficheiro em qualquer formato que possa ser desenhado, dispondo da
folha de estilo apropriada.

Têm de se seguir alguns passos. Escrever uma folha de estilos é tarefa para outra altura, mas se conseguir
obter uma, eis o que tem de fazer:

1. Copie o ficheiro XML do GnuCash para um ficheiro de trabalho.
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Nota

Se o ficheiro foi modificado pela última vez com uma versão do GnuCash anterior à 2.0,
antes de continuar para o próximo passo tem de modificar a etiqueta <gnc-v2> do ficheiro de
trabalho para algo como isto:

<gnc-v2 xmlns:cd="http://www.gnucash.org/XML/cd"
        xmlns:book="http://www.gnucash.org/XML/book"
        xmlns:gnc="http://www.gnucash.org/XML/gnc"
        xmlns:cmdty="http://www.gnucash.org/XML/cmdty"
        xmlns:trn="http://www.gnucash.org/XML/trn"
        xmlns:split="http://www.gnucash.org/XML/split"
        xmlns:act="http://www.gnucash.org/XML/act"
        xmlns:price="http://www.gnucash.org/XML/price"
        xmlns:ts="http://www.gnucash.org/XML/ts"
        xmlns:slot="http://www.gnucash.org/XML/kvpslot"
        xmlns:cust="http://www.gnucash.org/XML/cust"
        xmlns:entry="http://www.gnucash.org/XML/entry"
        xmlns:lot="http://www.gnucash.org/XML/lot"
        xmlns:invoice="http://www.gnucash.org/XML/invoice"
        xmlns:owner="http://www.gnucash.org/XML/owner"
        xmlns:job="http://www.gnucash.org/XML/job"
        xmlns:billterm="http://www.gnucash.org/XML/billterm"
        xmlns:bt-days="http://www.gnucash.org/XML/bt-days"
        xmlns:sx="http://www.gnucash.org/XML/sx"
        xmlns:fs="http://www.gnucash.org/XML/fs"
        xmlns:addr="http://www.gnucash.org/XML/custaddr">
    

Pode pôr praticamente tudo o que quiser dentro dos sinais de igual, mas um URL é o que
costuma ser usado.

2. Crie uma folha de estilo XSLT contendo a transformação desejada, ou obtenha uma já escrita (tanto
quanto sabemos, não há nenhuma, mas estamos a trabalhar numa para CSV).

3. Instale um processador XSLT tal como o Saxon [http://saxon.sourceforge.net/] ou o Xalan-J [http://
xml.apache.org/]. Qualquer processador normalizado serve, realmente...

4. Passe o ficheiro de trabalho e a folha de estilo pelo processador, seguindo as suas instruções específicas.

5. Terá agora um ficheiro no formato de saída desejado. Uma pessoa empreendedora pode mesmo chegar a
escrever uma folha de estilo para transformar o ficheiro de dados do GnuCash numa folha de cálculo do
OpenOffice (ou vice-versa, já agora). Coisas como QIF deviam dar um bocadinho menos de trabalho.

Os benefícios são não ter de escrever um módulo Scheme ou uma nova rotina em C para fazer esta trans-
formação. Qualquer pessoa que saiba ou possa aprender XML e XSLT pode realizar esta tarefa. Não é
muito mais difícil do que escrever uma página web...

De qualquer forma, isto é só para deixar esta informação gravada em qualquer lado. O processo funciona
em ficheiros de dados 2.6.20 e também deve funcionar em versões anteriores.
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Apêndice B. Questões frequentes
Esta é uma lista de perguntas feitas nas listas de correio para as quais não há realmente uma secção na
documentação que lhes dê resposta.

Fontes de informação

P: Onde estão as FAQ?
R: Está a olhar para elas. Pode encontrar a cópia mais atualizada na wiki do GnuCash [http://wiki.gnu-
cash.org/wiki/FAQ].

P: Há listas de correio para o GnuCash?
R: Sim. Vá a  http://lists.gnucash.org/mailman/listinfo/gnucash-user [http://lists.gnucash.org/mail-
man/listinfo/gnucash-user] e a  http://lists.gnucash.org/mailman/listinfo/gnucash-devel [http://lists.gnu-
cash.org/mailman/listinfo/gnucash-devel] para as subscrever.

P: Há algum arquivo onde se possa fazer procuras?
R: Sim, pode procurar nos arquivos de correio em http://news.gmane.org/gmane.comp.gnome.apps.g-
nucash.devel e http://news.gmane.org/gmane.comp.gnome.apps.gnucash.user (e em http://news.gma-
ne.org/gmane.comp.gnome.apps.gnucash.german se fala Alemão).

P: Há outros meios para obter assistência ao GnuCash?
R: Sim. Muitos dos programadores estão no icq, discussão #gnucash em irc.gnome.org. Há ainda uma wiki
online em  http://wiki.gnucash.org/wiki/GnuCash [http://wiki.gnucash.org/wiki/GnuCash].

Informação geral

P: Posso executar o GnuCash em Windows?
R: Sim. A partir da versão 2.2.0, o GnuCash também está disponível para Windows.

Outras opções disponíveis serão o colinux, VMWare e windows-based X-server hospedando uma sessão
remota do GnuCash.

P: Ouvi dizer que era muito díficl compilar o GnuCash!
R: Isto foi provavelmente verdade quando a versão 1.6.0 foi lançada. Hoje em dia já não é verdade, dado
que a maioria das ditribuições Linux já têm todas as bibliotecas necessárias (exceto a g-wrap, ou seja,
há realmente “uma” biblioteca extra a instalar antes de compilar o GnuCash). Contudo, por predefinição,
as distribuições não instalam pacotes de desenvolvimento das bibliotecas requeridas, pelo que poderá ter
que iniciar o programa de instalação da sua distribuição e dizer-lhe que instale também as bibliotecas
de desenvolvimento (-devel). Em geral, notou-se que este problema afeta muitas aplicações no domínio
Gnome, o que se reduz ao fato de que não há efetivamente algo como “um pacote gnome monolítico”.
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Questões frequentes

P: Há algum modo de o GnuCash construir relatórios em
lote, de forma não interativa?

R: Não, por agora o GnuCash tem de usar interatividade.

P: Pode o mesmo ficheiro de dados do GnuCash ser
acedido por múltiplas pessoas?

R: Pode ter múltiplas pessoas com acesso ao mesmo ficheiro de dados, mas não em simultâneo.

Para configurar o acesso multiutilizador, todos terão de ter direitos de leitura/escrita na pasta que contém
o ficheiro (para ler os ficheiros criados por outros e para criar novos ficheiros). Uma forma de o fazer é
criar um grupo de utilizadores e definir a pasta de dados como propriedade partilhada do grupo, definida
para modo 2775. O “2” torna a pasta setgid, o que copia as permissões para todos os ficheiros.

P: Porque é que o GnuCash está escrito em C?
R: A funcionalidade central do GnuCash é escrita em C, mas não se esqueça que muito do núcleo pode ser
acedido pelo Guile (scheme). Há um sem número de razões para o GnuCash ser escrito em C. A primeira
é histórica, o GnuCash começou em 1996 (ou talvez antes!) e muitos dos compiladores OOP (C++, Java,
Python) ainda não tinham amadurecido e estabilizado o suficiente nas várias plataformas consideradas
na altura, portanto C era a única opção nessa época. Uma segunda razão seria por o GUI (ambiente de
trabalho) padrão do GnuCash usar GTK, que é escrito em C.

P: Porque é que não reescrevem o GnuCash na lingua-
gem xyz para que eu possa contribuir facilmente?

R: A resposta rápida é “Não o faremos”. A resposta mais longa é complexa mas é a mesma. O GnuCash é
um enorme corpo de código mantido por um pequeno grupo de programadores que se sentem confotáveis
com C e Scheme (Guile). De fato, 80% é em C e aproximadamente 13% é em Scheme/Lisp. Não há ne-
nhuma razão válida que justifique reescrever a quantidade de código existente numa linguagem diferen-
te. Além disso, criar associações de linguagem a linguagens recentes como Python ou Ruby ou qualquer
outra da sua preferência é trabalho intenso e já temos trabalho que chegue mantendo e desenvolvendo o
código existente.

Dito isto, este é um projeto de código aberto e é livre de fazer o que quiser ou de contribuir com aquilo
que quiser. Mas não espere assistência se o motivo das suas alterações for não estar disposto a aprender
C ou Scheme. Além disto, o GnuCash costumava ter associações SWIG (http://www.swig.org) que foram
usadas por algum código programado em perl. De acordo com uma discussão na lista, estas associações
SWIG podem ainda ser uma forma de incluir outras linguagens no GnuCash, embora atualmente não sejam
usadas nem mantidas.

P: Gostava realmente de ter a funcionalidade XYZ mas o
GnuCash não a tem. Como é que a posso adicionar?

R: Peça com educação. :-) Pode fazer um pedido de melhoria em http://bugzilla.gnome.org/enter_bug.c-
gi?product=GnuCash. Por favor, lembre-se de descrever a sua melhoria proposta de forma bastante com-
pleta. O truque aqui é aprender a dar a melhor informação aos programadores sobre o que a sua melhoria
proposta vai fazer. Se quer acelerar o processo de desenvolvimento, considere doar algum dinheiro, con-
forme descrito em GnuCashDevelopment.
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Questões frequentes

P: Há alguma interface web disponível para o GnuCash?
R: Não

P: Como é que posso garantir a segurança dos dados
do GnuCash usando CFS, etc.)

R: Sem resposta

P: Como é que posso contribuir para o projeto do Gnu-
Cash?

R: Estamos a trabalhar num processo mais formal, mas para já, pode subscrever as listas de correio
em  http://lists.gnucash.org/mailman/listinfo/gnucash-user [http://lists.gnucash.org/mailman/listinfo/gnu-
cash-user] e em  http://lists.gnucash.org/mailman/listinfo/gnucash-devel [http://lists.gnucash.org/mail-
man/listinfo/gnucash-devel] e discutir como pode contribuir com os participantes da lista. Note que o Gnu-
Cash está escrito em C e Scheme (veja acima , “Porque é que o GnuCash está escrito em C?” se quiser saber
porquê). Se não está disposto a trabalhar com estas linguagens, considere outros tipos de contribuição.

P: Penso que encontrei um erro. Como é que o reporto?
R: Primeiro, tente verificar se é realmente um erro e se ainda não foi reportado. Procure nos arquivos de
correio (veja a FAQ acima). Depois procure na base de dados do Bugzilla do Gnome [http://bugzilla.g-
nome.org].

Se achar que realmente encontrou um novo erro, pode reportá-lo em http://bugzilla.gnome.org/en-
ter_bug.cgi?product=GnuCash. Lembre-se de ser eloquente e claro. Tente aprender como deve informar
os programadores a reproduzir o erro. Um programador só consegue reparar um erro que consiga ver, se
não o conseguir ver, o erro não será reparado.!

Usando o GnuCash

P: Como é que posso mover transações da conta “A”
para a conta “B”, ou seja, combinando-as?

R: De momento, o GnuCash não oferece uma forma de mover grupos de parcelas entre contas. Terá de as

mover uma a uma. Abra o diário da conta “A” e selecione Ver → Diário de transações para ver todas as
parcelas. Para cada parcela onde o campo “Conta” mostrar conta “A” altere para conta “B”. Para o fazer
rapidamente e com segurança, primeiro use Ctrl+C para copiar o nome da conta destino (“conta B”) para
a área de transferência. Em seguida, realce cada referência à conta “A” com um duplo clique e use Ctrl+V
para colar o nome da conta destino. Premindo Enter após cada colagem, move a transação para fora do
diário silenciosamente.

Tenha cuidado! Se definir o campo “Conta” para uma localização errada inadvertidamente, terá de procurar
em todas as contas para localizar a transação perdida para corrigir o erro.

P: É possível unir dois ficheiro do GnuCash?
R: De momento não.
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Questões frequentes

P: Como é que posso gravar um modelo do meu plano
de contas?

R: Isto está disponível no menu: Ficheiro → Exportar → Exportar contas

P: Quando procuro clientes (ou qualquer outra coisa),
como é que posso obter uma lista de tudo?

R: Insira um critério de procura satizfaz expreg e ponha um único ponto “.” na área do texto. Depois, clique
em Procurar. A expressão regular “.” significa procurar tudo.

P: Como posso registar uma transação em datas dife-
rentes (data real e data do banco)?

R: Regista a transação no dia em que passa o cheque ou inicia a transação. Quando “chegar” ao banco,
pode clicar no campo “R” para “confirmar” a transação (altera “nc” para “c”).

Contabilidade

P: Como é que trato os impostos? Como uma conta a
pagar ou como despesa?

R: Esta é uma pergunta com rasteira e devia realmente falar com o seu contabilista. A forma como trata
dos impostos depende do tipo de imposto e de como o QUER tratar. Nalguns casos são despesas, noutros
são passivo.
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Apêndice C. Planos de contas
contribuídos

IVA da Grã-Bretanha
Dado que é um plano de contas específico para a Grã-Bretanha, não vemos necessidade de
traduzir este apêndice. Muito pelo contrário, seria prejudicial à intenção com que foi criado.

Account types (only shown if different to parent type)

• [E] Expense

• [I] Income

• [A] Asset

• [L] Liability

• [Q] Equity

• [B] Bank accounts

• [C] Credit Cards

• [R] Accounts Receivable

• [P] Accounts Payable

(Box n) refers to VAT form box number (I actually have these as descriptions to the account to remind me)

Add all the (Box n -part) together to get the whole (Box n) The VAT shows you liability - if its negative
they owe you.

Capital Equipment (Box 7 - part) and (Box 6 - part) is the value of all *additions* (purchases) made over
the VAT return period - not the absolute value, nor the difference in value unless that difference is wholly
due to new purchases. Depreciation, losses (e.g a write off of faulty item) and other reductions in capital
value are not included. If you sell a capital item then that sale and its VAT is recorded under Income.
The asset is “converted to cash”, so the “net of VAT” increase in your bank account, when the invoice is
payed, is matched by a decrease in capital.

Bank Accounts [B]
  |___ Main Account
  |___  Reserve Account

Cash [A]

Assets [A]
  |___ Capital Equipment    (Box 7 - Part) - additions only, not absolute value
  |           |___ Computers      Can be depreciated to zero this year
  |           |___ EEC reverse VAT purchase  (Box 6 - Part) create sub-accounts if needed
  |___  Other
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Receivable [R] Customers to whom you give credit - (business section)

Cards [C]
  |___  Card 1

Liabilities [L]
  |___  Owed Corp Tax
  |___  Owed Fees
  |___  Owed Tax / NI
  |___  Other

VAT [L]   Net (Box 5)
  |___ i/p [A]   purchases (Box4)
  |___  o/p [L]     (Box3)
             |___EEC   on reverse VAT purchases (Box 2)
             |___Sales   all including zero rate UK/ EEC  and World (Box1)

Payable [P]   Suppliers who give you credit (business section)

Equity [Q]
  |___  Corp Tax
  |___  Director’s Loan
  |___  Dividends
  |             |___  Director1
  |             |___  Director2
  |             |___  Shareholder 1
  |___ Grants (and stuff that does not count as income)
  |___Opening Balances

Income [I]   (Box 6 - part)
   |___ Interest
   |___ Misc
   | ___ Sales
                |___ EEC
                |     |____ goods  (Box 8) (sub accounts as needed)
                |     |____ services includes software (sub accounts as needed)
                | ___ UK
                |____ World

Expenses [E]
        |__Depreciation
        |__ Emoluments
        |            |___ Directors Fees
        |            |___ NI Employer
        |            |___ Employee 1
        |                     |___NI
        |                     |___Net Salary
        |                     |___Stakeholder
        |                     |___Tax
        |___ Other Non VAT Expenses
        |___ VAT Purchases    (Box 7 - part)
                    |___  Accountancy
                    |___  Bank Charges
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                    |___  Consumables
                    |___  EEC  reverse VAT purchases  (Box 6 - Part)
                    |         |___ goods (Box 9) (sub accounts as needed)
                    |         |___ services   includes software (sub accounts as needed)
                    |___  Office
                    |___  Phone and Internet
                    |___  Software
                    |___  Subscriptions
                    |___  Sundry
                    |___  Travel / Accom 
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Apêndice D. Formatos de ficheiros
auxiliares

Estes são formatos de alguns ficheiros auxiliares usados pelo GnuCash.

Os formatos disponíveis destinam-se à impressão de cheques e não se encontram traduzidos. Se tiver
interesse em colaborar na tradução, consulte

Gnucash wiki: How to translate the GnuCash guide and/or help files [http://wiki.gnucash.org/wiki/Trans-
lation#How_to_translate_the_GnuCash_guide_and.2For_help_files]
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Apêndice E. GNU Free Documentation
License (Licença da documentação
livre GNU)

Versão 1.1, Março de 2000
Copyright © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, 
        Suite 330, Boston, MA  
        02111-1307  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

00. AVISO
Para mais informação sobre a licença do programa, consulte  GNU Free Documentation License [https://
pt.wikipedia.org/wiki/Wikip%C3%A9dia:GNU_Free_Documentation_Licenses]

Naquela página poderá encontrar uma  tradução não oficial da licença [https://pt.wikipedia.org/wiki/Wi-
kip%C3%A9dia:Tradu%C3%A7%C3%A3o_n%C3%A3o-oficial_da_GFDL]

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other written document “free” in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
either commercially or noncommercially. Secondarily, this License preserves for the author and publisher
a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves
be free in the same sense. It complements the GNU General Public License, which is a copyleft license
designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual work,
regardless of subject matter or whether it is published as a printed book. We recommend this License
principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. The “Document”, below, refers to any such
manual or work. Any member of the public is a licensee, and is addressed as “you”.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document [216] that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’s overall
subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For
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example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain  Secondary Sections [216] whose titles are designated, as being
those of Invariant Sections, in the notice that says that the Document [216] is released under this License.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document [216] is released under this License.

A “Transparent” copy of the  Document [216] means a machine-readable copy, represented in a format
whose specification is available to the general public, whose contents can be viewed and edited directly
and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs
or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent
modification by readers is not Transparent. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which the
DTD and/or processing tools are not generally available, and the machine-generated HTML produced by
some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats which
do not have any title page as such, “Title Page” means the text near the most prominent appearance of the
work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING
You may copy and distribute the Document [216] in any medium, either commercially or noncommer-
cially, provided that this License, the copyright notices, and the license notice saying this License applies
to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of
this License. You may not use technical measures to obstruct or control the reading or further copying of
the copies you make or distribute. However, you may accept compensation in exchange for copies. If you
distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY
If you publish printed copies of the Document [216] numbering more than 100, and the Document’s
license notice requires Cover Texts [217], you must enclose the copies in covers that carry, clearly
and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the
back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may
add other material on the covers in addition. Copying with changes limited to the covers, as long as they
preserve the title of the Document [216] and satisfy these conditions, can be treated as verbatim copying
in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.
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If you publish or distribute Opaque [217] copies of the Document [216] numbering more than 100,
you must either include a machine-readable Transparent [217] copy along with each Opaque copy, or
state in or with each Opaque copy a publicly-accessible computer-network location containing a complete
Transparent copy of the Document, free of added material, which the general network-using public has
access to download anonymously at no charge using public-standard network protocols. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in
quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least
one year after the last time you distribute an Opaque copy (directly or through your agents or retailers)
of that edition to the public.

It is requested, but not required, that you contact the authors of the Document [216] well before redis-
tributing any large number of copies, to give them a chance to provide you with an updated version of
the Document.

4. MODIFICATIONS
You may copy and distribute a Modified Version [216] of the Document [216] under the conditions
of sections 2 and 3 above, provided that you release the Modified Version under precisely this License,
with the Modified Version filling the role of the Document, thus licensing distribution and modification
of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the
Modified Version:

• A.  Use in the Title Page [217] (and on the covers, if any) a title distinct from that of the Docu-
ment [216], and from those of previous versions (which should, if there were any, be listed in the
History section of the Document). You may use the same title as a previous version if the original pu-
blisher of that version gives permission.

• B.  List on the Title Page [217], as authors, one or more persons or entities responsible for
authorship of the modifications in the Modified Version [216], together with at least five of the prin-
cipal authors of the Document [216] (all of its principal authors, if it has less than five).

• C.  State on the Title Page [217] the name of the publisher of the Modified Version [216], as
the publisher.

• D.  Preserve all the copyright notices of the Document [216].

• E.  Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

• F.  Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version [216] under the terms of this License, in the form shown in the Addendum
below.

• G.  Preserve in that license notice the full lists of  Invariant Sections [217] and required Cover
Texts [217] given in the Document’s [216] license notice.

• H.  Include an unaltered copy of this License.

• I.  Preserve the section entitled “History”, and its title, and add to it an item stating at least the title,
year, new authors, and publisher of the Modified Version  [216]as given on the Title Page [217]. If
there is no section entitled “History” in the Document [216], create one stating the title, year, authors,
and publisher of the Document as given on its Title Page, then add an item describing the Modified
Version as stated in the previous sentence.

• J.  Preserve the network location, if any, given in the Document [216] for public access to a
Transparent [217] copy of the Document, and likewise the network locations given in the Document
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for previous versions it was based on. These may be placed in the “History” section. You may omit a
network location for a work that was published at least four years before the Document itself, or if the
original publisher of the version it refers to gives permission.

• K.  In any section entitled “Acknowledgements” or “Dedications”, preserve the section’s title, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

• L.  Preserve all the Invariant Sections [217] of the Document [216], unaltered in their text and
in their titles. Section numbers or the equivalent are not considered part of the section titles.

• M.  Delete any section entitled “Endorsements”. Such a section may not be included in the Modified
Version [216].

• N.  Do not retitle any existing section as “Endorsements” or to conflict in title with any Invariant
Section [217].

If the Modified Version [216] includes new front-matter sections or appendices that qualify as Secon-
dary Sections [216] and contain no material copied from the Document, you may at your option de-
signate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Secti-
ons [217] in the Modified Version’s license notice. These titles must be distinct from any other section
titles.

You may add a section entitled “Endorsements”, provided it contains nothing but endorsements of your
Modified Version [216] by various parties--for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text [217], and a passage of up to 25
words as a Back-Cover Text [217], to the end of the list of Cover Texts [217] in the Modified Ver-
sion [216]. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or
through arrangements made by) any one entity. If the Document [216] already includes a cover text
for the same cover, previously added by you or by arrangement made by the same entity you are acting
on behalf of, you may not add another; but you may replace the old one, on explicit permission from the
previous publisher that added the old one.

The author(s) and publisher(s) of the Document [216] do not by this License give permission to use
their names for publicity for or to assert or imply endorsement of any Modified Version  [216].

5. COMBINING DOCUMENTS
You may combine the Document [216] with other documents released under this License, under the
terms defined in section 4 above for modified versions, provided that you include in the combination all of
the Invariant Sections [217] of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Secti-
ons [217] may be replaced with a single copy. If there are multiple Invariant Sections with the same
name but different contents, make the title of each such section unique by adding at the end of it, in pa-
rentheses, the name of the original author or publisher of that section if known, or else a unique number.
Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the
combined work.

In the combination, you must combine any sections entitled “History” in the various original documents,
forming one section entitled “History”; likewise combine any sections entitled “Acknowledgements”, and
any sections entitled “Dedications”. You must delete all sections entitled “Endorsements.”
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6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document [216] and other documents released under this
License, and replace the individual copies of this License in the various documents with a single copy that
is included in the collection, provided that you follow the rules of this License for verbatim copying of
each of the documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this Li-
cense, provided you insert a copy of this License into the extracted document, and follow this License in
all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT
WORKS

A compilation of the Document [216] or its derivatives with other separate and independent documents
or works, in or on a volume of a storage or distribution medium, does not as a whole count as a Modified
Version [216] of the Document, provided no compilation copyright is claimed for the compilation. Such
a compilation is called an “aggregate”, and this License does not apply to the other self-contained works
thus compiled with the Document , on account of their being thus compiled, if they are not themselves
derivative works of the Document. If the Cover Text [217] requirement of section 3 is applicable to
these copies of the Document, then if the Document is less than one quarter of the entire aggregate, the
Document’s Cover Texts may be placed on covers that surround only the Document within the aggregate.
Otherwise they must appear on covers around the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Docu-
ment [216] under the terms of section 4. Replacing  Invariant Sections [217] with translations requi-
res special permission from their copyright holders, but you may include translations of some or all Inva-
riant Sections in addition to the original versions of these Invariant Sections. You may include a translation
of this License provided that you also include the original English version of this License. In case of a
disagreement between the translation and the original English version of this License, the original English
version will prevail.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document [216] except as expressly provided
for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void,
and will automatically terminate your rights under this License. However, parties who have received co-
pies, or rights, from you under this License will not have their licenses terminated so long as such parties
remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions of the
GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the pre-
sent version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copy-
left/ [http://www.gnu.org/copyleft].
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Each version of the License is given a distinguishing version number. If the Document [216] specifies
that a particular numbered version of this License “or any later version” applies to it, you have the option
of following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

Addendum
To use this License in a document you have written, include a copy of the License in the document and
put the following copyright and license notices just after the title page:

Copyright YEAR YOUR NAME.

Permission is granted to copy, distribute and/or modify this document under the terms
of the GNU Free Documentation License, Version 1.1 or any later version published by
the Free Software Foundation; with the Invariant Sections [217] being LIST THEIR
TITLES, with the Front-Cover Texts [217] being LIST, and with the Back-Cover
Texts [217] being LIST. A copy of the license is included in the section entitled “GNU
Free Documentation License”.

If you have no Invariant Sections [217], write “with no Invariant Sections” instead of saying which
ones are invariant. If you have no Front-Cover Texts [217], write “no Front-Cover Texts” instead of
“Front-Cover Texts being LIST”; likewise for Back-Cover Texts [217].

If your document contains nontrivial examples of program code, we recommend releasing these examples
in parallel under your choice of free software license, such as the  GNU General Public License [http://
www.gnu.org/copyleft/gpl.html], to permit their use in free software.
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